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About This Release
This release of the Livescribe Platform includes new features and enhancements, corrected issues, and usability
improvements.

For detailed information about this release, including known issues, read the Release Notes located here:  
www.livescribe.com/releasenotes.

Version numbers for this release are:

• Smartpen Firmware, Version 2.8

• Livescribe Connect, Version 1.1

• Livescribe Desktop for Windows, Version 2.8

• Livescribe Desktop for Mac, Version 2.8
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Copyrights and Trademarks

LIVESCRIBE, ECHO, PULSE, CONNECT, and NEVER MISS A WORD are trademarks of Livescribe Inc. 
All other trademarks are properties of their respective owners.  Copyright © 2007-2011.  All rights reserved. 
http://www.livescribe.com/

Important:

Read the End User License Agreement that comes with Livescribe products before using them. You accept
the terms of the End User License Agreement by using any part of the product or software. Using any
non-authorized charging accessories or ink cartridges may damage the smartpen and voids the smartpen
warranty.
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Getting Help
Livescribe provides several ways for you to learn more about the Livescribe Platform and get expert help when
you need it.

Livescribe Online Support
On the Livescribe Support page, you can find several ways to get answers to any questions you might have about
your smartpen or other Livescribe products.

To open the Livescribe Support page:

• From a web browser, go to www.livescribe.com/support, or

• Within Livescribe Desktop, go to Livescribe Online and locate the Support tab.

You can view release notes for all Livescribe products here: www.livescribe.com/releasenotes.

From the Livescribe Support site, you can search and browse the Livescribe Knowledge Base. There you can
find answers to many of your questions. Livescribe updates the knowledge base frequently, so check it each time
you need help.

Other Livescribe smartpen users may have found an answer to your question. Check the Livescribe forums to
post a question or browse similar questions and find responses that may help you.

Contacting Customer Service
If you cannot find the answers to your questions using the Support page, please contact Customer Service directly.
You can reach Customer Service in the following ways:

• Go to www.livescribe.com/support, complete a Customer Service ticket and submit it.

• Email Customer Service at: CS@livescribe.com

• Telephone Customer Service. For telephone numbers, go to Customer Service Contact Information at:
www.livescribe.com/contact
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Saving Data for Customer Service

If you are experiencing problems with a Livescribe Desktop product, you should gather data from your installation
for Customer Service.

1. For Livescribe Desktop for Windows, choose Help > Save Data for Customer Service. On a Mac, hold the
keyboard control key down, and in Livescribe Desktop, go to Tools > Customer Support > Gather Debug
Logs

2. Save the data to your computer so you can send it to Customer Service if requested.

Returning Livescribe Products
If you need to return the Livescribe smartpen or other Livescribe product, follow the instructions below.

Items Purchased Directly from Livescribe

Items purchased directly from Livescribe have the following return time-frame to qualify for a refund. Items
returned after this timeframe are not accepted or credited:

• Hardware: 30 days.

• Accessories: 30 days

Livescribe refunds the full amount paid minus shipping on any item(s) returned within the allowable time. The
customer must contact Customer Service for a Returned Material Authorization (RMA) number and is responsible
for the original shipping and the return shipping fees.

A returned item must be returned in like-new condition with all the original components and packaging. Credits
are issued once the item(s) have been received and verified.

Items Purchased from a Third Party

If you discover what you believe is a software or product defect for any third-party item, please contact the
manufacturer of such third-party item directly for information regarding that manufacturer's warranty. Products
sold through the Livescribe website that do not bear the Livescribe brand name are serviced and supported
exclusively by their manufacturers in accordance with the terms and conditions packaged with the products.
Third-party software or products are not covered by Livescribe’s Limited Warranty.
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Glossary

3-D recording headset
Earphones with embedded microphones that capture multi-directional, far-field audio and place objects in the sound
landscape surrounding you.

active ink
Notes, drawings, or other markings made by a Livescribe smartpen on Livescribe Dot paper that are linked to recorded
audio. By default, active ink is displayed as green in Livescribe Desktop. See inactive ink.

archiving
The process of moving your notes and audio for a Livescribe Dot Paper product into an Archived Notebooks folder in
the Navigation Pane. This process also deletes your notes (ink data) and audio from the Livescribe smartpen. Because
of this, the Livescribe smartpen no longer interacts with the physical Livescribe Dot Paper product that you archived.

audio
Sound of any kind that is captured by the Livescribe smartpen microphone.

Audio (or Sessions) view
Sessions presented as a list of files with details about each.

docking
Connecting a Livescribe smartpen to a personal computer by inserting the smartpen into its charging cradle (for Pulse
smartpens) or Micro-USB cable (for Echo smartpens).

downloading
Receiving content from a remote location, such as the internet.
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firmware
Software that manages the internal operations of a smartpen.

flash storage
Non-volatile storage of computer files, not dependent on electric charge. Sometimes referred to as memory.

Flick and Scrub
Flick and Scrub is a feature that enables fast scrolling through menu items and other displayed text on the Livescribe
smartpen. This feature is useful when text presented by an App is longer than the display can show horizontally or
when multiple menus, options, or items are available vertically.

Home
A smartpen state in which no apps are running and the smartpen screen shows the current time and battery status. From
Home, you can capture notes and invoke Launch Line. At any time, you can return your smartpen to the Home state
by tapping on a Home button. This quits all currently-running apps and returns the smartpen to the Home screen.

Home button
At any time, you can return your smartpen to the Home state by tapping on a Home button. This quits all
currently-running apps and returns the smartpen to the Home screen. Home buttons are printed in most Livescribe Dot
Paper products. In older paper products, the Home button is a light circle just above and to the right of the Nav Plus.
In newer paper products, the Home button is a icon in the shape of a house.

inactive ink
Notes, drawings, or other markings made by a Livescribe smartpen on Livescribe Dot Paper that are not linked to
recorded audio. By default, inactive ink is displayed as black in Livescribe Desktop. See active ink

ink
The markings of the Livescribe smartpen ballpoint on Livescribe Dot Paper. See active ink and inactive ink.
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Launch Line
You can use Launch Line to quickly launch any Open Paper App installed on your smartpen. Open Paper Apps are
Apps that do not require pre-printed paper controls to function. See tap around.

linking
Associating a Livescribe smartpen to an instance of Livescribe Desktop.

Livescribe Connect Desktop app
Software that runs on your computer in tandem with Livescribe Desktop to send selected notes and audio recordings
to a variety of destinations, including Facebook, GoogleDocs, Email, your MyLivescribe space, and more.

Livescribe Connect Smartpen app
Software that runs on your smartpen that enables you to tap-select pages on your notebook to send them to target
destinations when you dock your smartpen to your computer.

Livescribe Desktop
Software that runs on your computer to view and listen to the content you capture using a smartpen. View your notes,
listen to recorded audio, manage apps, and more.

Livescribe Dot Paper
Plain paper printed with microdots that enable interactivity with Livescribe smartpens.The microdots enable Livescribe
smartpens to recognize and respond to areas on a page, and link handwritten notes to recorded audio.

Livescribe Echo and Pulse smartpens
Pen-based computers with advanced processing power, audio and visual feedback, and substantial storage. Smartpens
digitally-capture written notes and can record audio using the Paper Replay smartpen app.

Livescribe Online
LThe Livescribe website where you can upload and share content to your own MyLivescribe space, and purchase new
apps, smartpens, paper products, and accessories. Users can store up to 500 MB of notes and audio.
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Livescribe Platform SDK and Livescribe Desktop SDK
Software Developer Kits for app developers to create, publish, and sell smartpen apps and create desktop apps that can
interact with smartpen content.

microdot
The basic unit of Livescribe Dot Paper: a small, light-gray circular marking that is arranged with others like it into
millions of patterns. These are printed on Livescribe paper products for use with the Livescribe smartpen.

MyLivescribe
500 MB of personal space on Livescribe Online for smartpen users to store and share notes.

Nav Plus
A pre-printed or hand-drawn plus sign that lets you navigate the Livescribe smartpen Apps and files.

notebook status label
An elliptical paper seal that prevents a Livescribe paper product from being opened until detached by the owner. This
label defines the product status (paper type and series number), so you can be aware of potential conflict with paper
products of the same status that are already in use.

notes
Anything written or drawn on Livescribe Dot Paper.

OLED display
18pixel x 98pixel Organic Light Emitting Diode display screen of the Livescribe smartpen.

Open Paper Apps
Smartpen Apps that do not require pre-printed paper controls to function. Examples of these Apps are Piano, Translator
Demo, and many Apps on the Livescribe Online Store.
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Pages View
A view in Livescribe Desktop that displays notebook pages. Notes are shown as active ink if they are linked audio.

Paper Replay
An App that associates what you write on paper to audio you record.

Paper Replay Password
Paper Replay Password sets a password for your Paper Replay sessions. Setting a password can prevent others from
listening to your recorded audio on your smartpen.

pencast
Pencasting is a general term for exporting smartpen content. Pencasting and is how you share your smartpen content
with others. You can pencast smartpen content to your computer or to Livescribe Online.

playback latency.
when you tap your notes to play back audio, it plays from a moment five seconds before the note was actually written.
This feature allows you to more accurately replay the audio because there is natural delay between the time when you
hear an important point and the time when you begin writing notes.

preferences
Settings of Livescribe Desktop that conform to your way of working.

session
A single, complete audio recording. A session always contains audio and optionally can contain linked written notes
(pages).

Shortcut buttons
Buttons on some paper products represented as numbers inside circles. Each number corresponds to a different Shortcut
Button. You can assign each button to launch an app or a shortcut.
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Shortcuts
Shortcuts are words you can write to launch an app and invoke a particular feature of that app. For example, writing
the word play as a shortcut launches Paper Replay and invokes the play session command. Connect Desktop provides
built-in shortcuts as well, like email, pdf, Evernote. Writing these words shortcuts launches the corresponding commands
on your smartpen. You can also create custom shortcuts for Connect commands.

Status
A shortcut for battery, version, date, and other information about the smartpen.

tap around
Tap around is a feature of Launch Line that is an alternate to using the Nav Plus to navigate menus of an App.

Thumbnail View
A view in Livescribe Desktop that shows thumbnail representations of pages.

transfer
Copying notes and audio from a Livescribe smartpen to a computer using Livescribe Desktop.

updating
Installing a new version of software or firmware via Livescribe Desktop to your computer or smartpen.

uploading
Sending data to a remote location, such as the web.

USB
Universal Serial Bus, a standard for wired connection between personal computers and peripheral devices like printers
and the Livescribe smartpen.
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USB mobile charging cradle
A cradle that charges and connects a Livescribe smartpen to your computer.

zooming
The process or magnifying or reducing pages in Livescribe Desktop.
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Livescribe Smartpen User Guide

About Your Livescribe Smartpen
The Livescribe smartpen is an advanced paper-based computer in the form of a pen that can capture everything
you hear and write.

Introducing the Livescribe Smartpen
Your Livescribe smartpen synchronizes the audio you hear to what you write, so you never miss a word. Just
tap on your notes and the smartpen plays back what you recorded from that exact moment in time.

The smartpen provides both audio and visual feedback, powerful processing capabilities, and substantial built-in
storage. The smartpen integrates several components and technologies. It also uses firmware and software to
support the interaction of all of its components and to enable built-in handwriting recogni-tion, and apps such
as Paper Replay, among many others.

When you start your smartpen and begin writing on Livescribe Dot Paper, the smartpen captures and stores the
notes you write. To capture your writing, the smartpen uses its built-in infrared camera to take digital snapshots
of a special dot pattern on the paper as the tip moves over the paper while you write.

When recording audio with the Paper Replay app, the smartpen links your notes to the recorded audio. When
you tap on your notes, your smartpen locates the tapped position and plays back the audio linked to that location.

About Livescribe Dot Paper
To perform its many operations, your smartpen requires Livescribe Dot Paper.

This paper is standard paper with printed microdots on its surface. These dots are nearly invisible to the human
eye. However, the smartpen can easily see these dots and uses them to know which page you are writing on and
the exact location on that page. The smartpen can even see these dots through the ink you write on your pages.

The microdot pattern on each page is based on technology from Anoto AB. This dot pattern consists of small
dots (100 micrometers in diameter) arranged with a spacing of approximately 0.3 mm. The dot pattern overlays
an imaginary square grid. The dots are slightly displaced from the grid, with each dot in one of four possible
positions, forming the proprietary Anoto dot pattern.

The dot pattern identifies the specific page and locations on the page of the notes you write. Your smartpen uses
the dot pattern in a way similar to a geographical positioning system (GPS). But, instead of identifying locations
on land, it finds locations on paper and stores your writing as digital ink using those locations. Using this patented
dot-positioning system (DPS), the smartpen precisely tracks its own movement on paper. As a result, anything
you write – words, numbers or drawings – can be stored, recognized, and intelligently responded to by the
smartpen.

The area of the entire Anoto dot pattern is huge, and represents a piece of paper the combined size of Europe
and Asia. Livescribe Dot Paper is based on a portion of this dot pattern.
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About the Livescribe Platform
The Livescribe Platform is a paper-based mobile computing solution that bridges the gap between paper and
digital worlds.

The platform enables a broad range of new apps for personal productivity, education, communication, and self
expression. The Livescribe Platform includes:

Pen-based computers with advanced processing power, audio and visual feedback, and substantial
storage. Smartpens digitally-capture written notes and can record audio using the Paper Replay smartpen
app.

Livescribe Echo and Pulse
smartpens

Software that runs on your computer in tandem with Livescribe Desktop to send selected notes and
audio recordings to a variety of destinations, including Facebook, GoogleDocs, Email, your
MyLivescribe space, and more.

Livescribe Connect Desktop app

Software that runs on your smartpen that enables you to tap-select pages on your notebook to send
them to target destinations when you dock your smartpen to your computer.

Livescribe Connect Smartpen app

Software that runs on your computer to view and listen to the content you capture using a smartpen.
View your notes, listen to recorded audio, manage apps, and more.

Livescribe Desktop

Plain paper printed with microdots that enable interactivity with Livescribe smartpens.The microdots
enable Livescribe smartpens to recognize and respond to areas on a page, and link handwritten notes
to recorded audio.

Livescribe Dot Paper

LThe Livescribe website where you can upload and share content to your own MyLivescribe space,
and purchase new apps, smartpens, paper products, and accessories. Users can store up to 500 MB of
notes and audio.

Livescribe Online

Software Developer Kits for app developers to create, publish, and sell smartpen apps and create
desktop apps that can interact with smartpen content.

Livescribe Platform SDK and
Livescribe Desktop SDK

What is in the Box?

Included are your:

• Smartpen

• Starter Livescribe Dot Paper notebook

• Interactive Getting Started Guide

• Ink cartridges

• Micro-USB cable (Echo smartpen only)

• Smartpen cap (Echo smartpen only)

• 3-D Recording Headset (Pulse smartpen only)

• USB mobile charging cradle (Pulse smartpen only)

• Protective soft case (Pulse smartpen only)

Other things you get:

• A Warranty

• Free downloads of Livescribe Desktop for Windows and Mac OS X.

• Free sign-up for a Livescribe Online account with 500 MB of online space to store and share your smartpen
content.
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Identifying Your Smartpen Model

There are two smartpen models: the Echo smartpen and the Pulse smartpen. Use the information below to identify
your model.

Plastic body. Black with printed power symbol .
Echo smartpen

Aluminum body. Titanium or Black with printed power symbol

.

Pulse smartpen - Pro Pack

Aluminum body. Charcoal-Blue with no printed power symbol.Pulse smartpen - Standard

Smartpen Features
Echo and Pulse smartpens have similar features, as shown in the image below.

Starting Your Smartpen

To use your smartpen, first power it on. It must be running to capture written notes or enable its audio recording
or playback features.

1. Press the Power button to start your smartpen.

If you have given your smartpenste a name using Livescribe Desktop, your smartpen shows its name when
you power it on.
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As the smartpen starts up, the display shows the words Livescribe and then Starting... After startup completes,
the display shows the time.

2. The first time you use the smartpen, you must set it to the current time and date.

3. When you are finished using your smartpen, press the Power button again to turn it off.

Charging an Echo Smartpen
The USB connector for an Echo smartpen is located on the top next to the headset jack. This is a standard micro
USB connector that is compatible with any standard USB charging cable. Follow these steps to charge your
smartpen

The plug and blinking battery indicator means your smartpen needs to be charged.

1. Before charging your Echo smartpen, download and install the Livescribe Desktop software from
http://www.livescribe.com/install.

2. Plug your Micro-USB cable into the USB port on your computer and plug the other end of the cable into
your smartpen.

You can also charge the Echo smartpen directly from an electrical outlet with the Universal USB AC Wall
Adapter.

A battery and lightning bolt symbol is displayed on your smartpen when it is charging.
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A full charge can take up to 2.5 hours.

Charging a Pulse Smartpen
The USB connector for a Pulse smartpen is located on its side. The connector is designed to fit into a compatible
Livescribe USB charging cradle. Follow these steps to charge your smartpen.

Tip:

The plug and blinking battery indicator means your Pulse smartpen needs to be charged.

1. Before charging your Pulse smartpen, download and install the Livescribe Desktop software from
http://www.livescribe.com/install.

2. Plug your USB mobile charging cradle into the USB port on your computer. The smartpen charges directly
from your computer’s USB port when the computer is on. The USB connection (located on the side of the
Pulse smartpen) is designed to dock into the compatible Livescribe USB mobile charging cradle.

You can also charge the Pulse smartpen directly from an electrical outlet with the Pro Charging Cradle or
the Universal USB AC Wall Adapter.

3. Place the Pulse smartpen in your USB mobile charging cradle.

A battery and lightning bolt symbol is displayed on your smartpen when it is charging.

A full charge can take up to 2.5 hours.
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Replacing the Ink Cartridge or Stylus
To replace an ink cartridge, just use your fingers to grasp and pull out the old cartridge and insert a new one. If
you own a Pulse smartpen and have a USB mobile charging cradle, you can instead use the cradle to help replace
the cartridge as follows.

1. Insert the smartpen ink tip into the ink cartridge removal ring.

2. Tilt the smartpen so that it firmly rests against the removal ring and lift the smartpen away from the ring.

3. Lifting the smartpen away from the cradle safely separates the ink cartridge from the magnet inside the
smartpen that holds the cartridge in place.

4. Place your new ink cartridge in the smartpen.

Before using the smartpen, be sure to remove the protective plastic coating from your ink cartridge tip. All
new ink cartridges have this coating in place to prevent the ink from drying up.

If you want to use the smartpen but do not want to make ink marks on your paper, purchase a stylus from
the Livescribe web store. To insert the stylus, follow the steps above, but substitute the stylus for the
replacement ink cartridge.

Using a 3-D Recording Headset
With your smartpen, you can record audio with either the built-in micro-phone or a 3-D Recording Headset.

Livescribe designed the built-in micro-phone for monaural recordings in smaller recording environments, such
as a conference room. When recording in larger spaces, we recommend using a 3-D Recording Headset, which
contains a microphone in each earbud. The dual microphones enable binaural recordings, which accurately
recreate the spatial audio environment.

1. Left and right speakers

2. Left and right microphones

Binaural recording is a special type of stereo recording that uses two microphones, one placed in each ear. This
type of recording provides the most accurate spatial sound quality because the microphones effectively mimic
your ears - when you play a binaural recording back, it sounds like you are actually in the location where you
recorded.

Once you record audio, you can play back the binaural effect using stereo earphones. You can also play back
the binaural effect as a regular stereo recording over any type of headphones or speakers.

The 3-D Recording Headset included with each Pulse smartpen has a custom jack. This is required for binaural
recordings. However, if you want to use a 3.5mm stereo headset just for playback, connect your 3.5mm headset
to your smartpen using a standard 2.5mm to 3.5mm adaptor.
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If you own an Echo smartpen, you can use any standard 3.5mm stereo headset for playback. For binaural recording,
you need to use a Livescribe 3.5mm 3-D Recording Premium Headset. You can purchase this separately from
the Livescribe Online Store.

Tip:

You can record binaural audio with the earbuds in your ears or around your neck as shown below. Make
sure the “L” earbud is in your left ear and the “R” earbud is in your right ear.

Note:

Keep the earbuds about 6-8 inches apart to mimic the position of your ears.

Renaming Your Smartpen in Livescribe Desktop

Your smartpen has a default name. You can rename your smartpen to identify it from other smartpens in Livescribe
Desktop.

1. Install and Launch Livescribe Desktop.

2. Dock the smartpen to be renamed.

3. If it is not already selected, use the smartpen selector drop down to choose the smartpen you want to rename.

4. Choose Tools > Smartpen > Rename.

5. At the prompt, type the smartpen name and click OK.

Rebooting an Unresponsive Smartpen
If your smartpen is unresponsive, you can reboot it.

1. Charge your smartpen using its cradle (for Pulse smartpens) or Micro-USB cable (for Echo smartpens) for
at least five minutes.

2. If your smartpen is still nonresponsive after five minutes of charging, press and hold the power button for
10 seconds to reboot it.

About Paper Replay
When you start your smartpen, it is ready to capture anything you write on Livescribe Dot Paper.

Your smartpen captures and stores your notes as digital ink. You can then send your notes to your computer or
other destinations using Livescribe Connect or Livescribe Desktop. When you are taking notes without the need
to record audio at the same time, simply start your smartpen and begin writing.

To record audio as you take notes, use the Paper Replay smartpen app. Using Paper Replay, your smartpen
records audio and links it to what you write. Later, you can tap on any of your notes and hear the audio recorded
from that moment. Each time you use Paper Replay, it stores the information it captures as a Paper Replay
session.
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You also can use Paper Replay to record audio only. The resulting audio is a standalone recording not linked to
your notes. This kind of recording is called a paperless session.

You can add notes to any audio recording (even paperless sessions) by playing back pre-recorded audio and
writing as you listen. This process is called annotating and is useful when you need to clarify or expand your
notes by reviewing the audio.

To start and stop a Paper Replay session and control session playback,  use the Paper Replay controls printed
on all Livescribe Dot Paper.

Note:

The Paper Replay printed controls are not page-specific. For example, you can tap the Record button on
one page to start recording, and then tap the Stop button on a different page to stop recording.

About Paper Replay Sessions

When you begin recording with the smartpen, your smartpen automatically links the audio to anything you write
on Livescribe Dot Paper. The recorded audio (and any linked written notes) is called a Paper Replay session.

Important facts about sessions:

• Notes not linked to audio are just notes. They are not part of a session.

• A session always contains audio.

• A session can optionally include written notes (pages) linked to the audio. However, you can record audio
only, known as paperless sessions.

• A session begins when you start recording audio and ends when you stop recording audio.

• Pausing and unpausing a recording does create separate sessions. The paused and unpaused session remains
as one. Starting and stopping recordings creates separate sessions.

• You can have one session that spans multiple pages, such as when taking many notes while recording a long
lecture or meeting.

• Starting and stopping recording multiple times per page creates multiple sessions on that page.

• By default, sessions are named on your smartpen and Livescribe Desktop based on the time and date they are
created. For example, if a session is started on June 03, 2011, at 12:22PM, it is named and displayed as 06.03.11
12:22p.

Viewing Notes and Playing Back Audio In Livescribe Desktop

In Livescribe Desktop, you can view your notes and play back audio recordings made with Paper Replay. In
Livescribe Desktop, notes that have linked audio appear as green ink. Livescribe calls this ink active ink.

To listen to audio recordings that are linked to your notes, click on the active ink using your mouse or other
pointing device. Clicking active ink is similar to tapping your paper notes to begin audio playback on your

smartpen. When you mouse over ink that is active, the mouse cursor changes to a pointing hand cursor to help
you identify where you can click to begin audio playback.

If you annotated your notes (added notes while playing back an audio recording), Livescribe Desktop shows this
ink as blue. This ink is also active. You can click on it to play back the audio at the point where you added the
notes.

Livescribe User Guides26



Note:

You can change the color of active and inactive ink by setting a user preference.

Writing, Recording, and Playback Basics
Your smartpen has many features and uses. One of the main uses is capturing notes your write and recording
audio.

Writing Notes and Recording Audio with Your Smartpen
When you start your smartpen, it is ready to capture anything you write on Livescribe Dot Paper.

Your smartpen captures and stores your notes as digital ink. You can then send your notes to your computer or
other destinations using Livescribe Connect or Livescribe Desktop. When you are taking notes without the need
to record audio at the same time, simply start your smartpen and begin writing.

To record audio as you take notes, use the Paper Replay smartpen app. Using Paper Replay, your smartpen
records audio and links it to what you write. Later, you can tap on any of your notes and hear the audio recorded
from that moment.

Important:

It is critical that you set the correct time and date on your smartpen because your smartpen names audio
recordings based on their creation time and date.

Writing Notes Only (Without Recording Audio)

1. Press the power button to start your smartpen.

2. If needed, remove the smartpen cap. If you are using a new ink cartridge, you may need to remove possibly
the small protective plastic coating from your ink cartridge tip. All new ink cartridges have this coating to
prevent the ink from drying up.

3. Begin writing on any Livescribe Dot Paper product, such as a Livescribe notebook, journal, or flip notepad.
As long as the smartpen is on, it captures your handwritten notes and drawings. When you dock your smartpen
to your computer, your notes transfer to Livescribe Desktop.

Writing Notes And Recording Audio

1. Press the power button to start your smartpen.

2. If needed, remove the smartpen cap.

If you are using a new ink cartridge, you may need to remove possibly the small protective plastic coating
from your ink cartridge tip. All new ink cartridges have this coating to prevent the ink from drying up.

3. Tap on a Record button  printed on Livescribe Dot Paper to start Paper Replay.

Paper Replay starts recording audio.

4. Begin writing on any Livescribe Dot Paper product.

5. When you finish taking notes and recording audio, tap on one of the Stop buttons  printed on your
Livescribe Dot Paper.
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6. To play back your recording audio, tap on your handwritten notes.

Recording Audio Only (Without Writing Notes)

You can use your smartpen like a digital recorder to record audio only, without capturing notes. This kind of
recording is also known as a paperless session.

Using Quick Record

1. Use the Quick Record feature. Press and hold the power button for approximately five (5) seconds until the
screen shows that recording is started.

The smartpen may appear to power off until it shows the recording started indicator.

2. When you have finished recording audio, tap on the Stop button  in any Livescribe Dot Paper.

Using the Record Button

1. Tap on the Record button  in any Livescribe Dot Paper product. This starts recording audio. You can
continue to record without writing notes.

2. When you have finished recording audio, tap on the Stop button  in any Livescribe Dot Paper.

Annotating Your Notes After Recording Audio

You can write new notes and link them to any previously-recorded audio by writing on Livescribe Dot Paper as
you play back the audio recording.

Annotation is very useful when you need to clarify or expand on your notes at a later time. For example, you
may need to go back to your notes to correct or clarify a point made in a meeting or lecture. The annotations
you write are linked to your original recorded audio, so you can later tap on the annotations and hear the audio
that was playing when you wrote them.

1. Start audio playback. You can tap on notes linked to the audio you are annotating, or locate the and play back
the audio recording using the Nav Plus or other method.

2. After you start audio playback, begin writing with the smartpen. Your smartpen automatically links your
annotations to the previously recorded audio.

3. When you are finished annotating, stop the audio playback.

Your smartpen links the audio to the annotations at the time you write them.

Checking the Battery Level

It is important to check the remaining battery level of your smartpen before beginning an audio recording. This
can avoid the problem of the smartpen running out of battery power in the middle of a recording.

Checking the Battery Level with the Battery Button

1. Start your smartpen.

2. Open the inside cover of your Livescribe Dot Paper product and locate the Settings area.

3.

Tap the Battery button  to see the current battery charge.
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This image shows a full battery.

Checking the Battery Level with a Shortcut

1.
Double-tap  on the center of a Nav Plus.

Your smartpen shows the Shortcut indicator (asterisk) in the Main Menu. It is waiting for you to write a
Shortcut.

2. Within three (3) seconds, write the word “battery.”

Using its predictive text feature, your smartpen shows the first command that matches your written input In
this case, battery is displayed as soon as you write a “b”. As soon as you see the command you want on the
display, you can stop writing.

3.
Tap right  on the Nav Plus, or double-tap on any Livescribe Dot Paper.

Your smartpen shows the remaining battery power.

When you create a Shortcut, it becomes an active button that you can tap to repeat the application or command.
The same is true for Launch Line Shortcuts you create.

Installing Smartpen Software Updates

Livescribe periodically updates smartpen apps (such as Paper Replay) and underlying smartpen firmware.
Livescribe also updates this software to support new kinds of Livescribe Dot Paper. When you dock your smartpen
and launch Livescribe Desktop, it checks for available updates. You can also manually check for updates using
Livescribe Desktop.

Note:

If you try to use a new Livescribe Dot Paper product, and get an error message that it is “not supported”,
you need to update your smartpen software.

1. Dock your smartpen.
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2. Launch Livescribe Desktop.

Livescribe Desktop automatically checks for recent updates.

3. Accept the updates.

If you choose to postpone transferring updates to your smartpen, you can re-initiate the transfer process by
undocking and re-docking your smartpen. Livescribe Desktop prompts you to transfer available items.

Livescribe Desktop downloads and installs them to your smartpen.

Using Smartpen Apps
Smartpen apps are small programs that run on your smartpen. There are two basic kinds of smartpen apps: System
and Store.

About Smartpen Apps
All smartpen apps have similar user interfaces and follow the same navigation rules.

System apps are those that are pre-installed as part of the smartpen system software. Examples of System apps
include Paper Replay, Piano, and Translator Demo.

Store apps are those you can download and install from the Livescribe Online Store. Examples include Spanish
Dictionary, Paper Tablet, and many others.

Launching Apps with Launch Line
You can use Launch Line to quickly launch many apps installed on your smartpen.

Launch Line can start any Open Paper apps. These are apps that do not require pre-printed paper controls to
function. Examples of these apps are Connect, Piano, Translator Demo, and many apps on the Livescribe Online
Store.

Tap Around is a feature of Launch Line that is an alternative to using the Nav Plus to navigate menus of an
app. The areas immediately surrounding a Launch Line function as the Nav Plus controls: tap up, tap down, tap
left, tap right, and tap center. The Tap Around regions correspond to the features and regions of the Nav Plus,
except that:

• Tap Around controls menus and navigation within its corresponding app only.

• You cannot use Tap Around controls to launch other apps.

1. Draw a horizontal line on your Livescribe Dot Paper (starting from right or left) and without removing your
smartpen tip from the page, immediately double back on the line ending close to where you started.

2. Immediately write the name of the target app above the line.

Using its predictive text feature, your smartpen shows the first command that matches your written input.

3. To launch the app, tap on the center of the app name.
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If the name is a unique match to an app, the app launches automatically.

4. You can use the Tap Around feature to navigate the app: Tap just above, below, left, or right of the name to
perform the corresponding functions of the Nav Plus.

5. After creating a Launch Line, it remains as an active area. You can tap it at any time to launch the
corresponding app.

Launching an App with a Nav Plus

A Nav Plus is a printed navigation control available in all Livescribe Dot Paper products.

1.

Double-tap  on the center of a Nav Plus go to the Main Menu.

2.
Tap down  on the Nav Plus to scroll through a list of System apps on the smartpen, such as Paper Replay.

3.
Tap right  and tap down  to locate the app.

4. If you download and install apps from the Livescribe Store, your smartpen places them under the Main Menu
> Applications menu.

This menu is available after you install your first Store app.

5.
To locate an installed Store app, tap down  to locate the Applications menu.

6.
Tap right  to view the first of your Store apps.

7.
Tap down  to scroll through other apps and locate the one you want to launch.

8.
When smartpen shows the app name you want, tap right  to select and launch that app.

9.
If the app has additional options, tap down  to scroll through the selected app’s menu. Tap right  to
select an item or option in the app’s menu list.

Finding a Menu Item by Writing Its Name

When navigating an app’s menu, you can use your smartpen’s handwriting recognition feature to locate a menu
item by its name.

1. When navigating an app’s menu, write the name of a menu item on Livescribe Dot Paper.

2.
When the display shows the item you want, tap right  on the Nav Plus or double-tap on the page to select
the item.
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Using the Home Button to Quit Currently-Running Apps
When you power on your smartpen, it starts up in a Home state. In this state, the smartpen screen shows the
current time and battery status.  From the Home state, you can capture notes, but no apps are running.

At any time, you can return your smartpen to the Home state by tapping on a Home button. This quits all
currently-running apps and returns the smartpen to the Home screen. Livescribe recommends using the Home
button whenever you want to quit and app and start another.

Home buttons are printed in most Livescribe Dot Paper products. In older paper products, the Home button is a
light circle just above and to the right of the Nav Plus.

In newer paper products, the Home button is a icon in the shape of a house.

1. Locate and single-tap on the Home button on any Livescribe Dot Paper.

Your smartpen quits all currently-running apps. The smartpen screen shows the Home state: current time
and battery level.

2. Use Launch Line or other method to launch another application.

About Shortcuts
Shortcuts are words you can write to quickly launch an app and invoke a particular feature of that app.

Double-tapping on the center of a Nav Plus notifies your smartpen that you are about to write a Shortcut. After
writing the word, tapping right on the Nav Plus, or double-tap on any Livescribe Dot Paper launches the Shortcut.

Your smartpen has default shortcuts for several applications and their commands. For example, double-tapping
on the center of the Nav Plus and quickly writing the word "play" launches Paper Replay and invokes its "Play
Session" command.

Connect also provides default shortcuts, like "email", "pdf". Writing these words shortcuts launches the
corresponding Connect commands on your smartpen. You can also create custom shortcuts for Connect commands.

Using Shortcuts

1.
Double-tap  on the center of a Nav Plus.

Your smartpen shows the Shortcut indicator (*) in the Main Menu. It is waiting for you to write a Shortcut.

2. Within three (3) seconds, write the Shortcut word.
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For example, write the word “play.”

Using its predictive text feature, your smartpen shows the first command that matches your written input. In
this case, “play” is displayed as soon as you write “p”. As soon as you see the command you want on the
display, you can stop writing.

3.
Tap right  on the Nav Plus, or double-tap on any Livescribe Dot Paper.

Your smartpen launches Paper Replay and its Play Session command. The smartpen screen shows the top
item in the Play session list.

4.
Tap down  using the Nav Plus to scroll through sessions

5.
Tap right  to start playing back the session.

When you create a Shortcut, it becomes an active button that you can tap to repeat the application or command.
The same is true for Launch Line Shortcuts you create.

About Smartpen Screen Indicators
When navigating apps, use the screen indicators to know which navigation directions are available.

A bar at the top of the screen indicates the top of a menu or list.

Arrows indicate there are items to view in the direction of the arrows.

A bar at the bottom of the screen indicates the bottom of a menu or list.
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Tips for Handwriting Recognition

Some apps use handwriting recognition. Examples include translators, dictionaries, games, and music apps.
Follow these guidelines:

• Write all text horizontally and neatly. The smartpen cannot interpret vertical handwriting. Handwriting
recognition also yields better results with lower case lettering.

• Tap on what you wrote to jump back to that position in the app at any time.

Tips for Quizzes and Tests

Some apps include quizzes or tests. Examples include U.S. State Facts, Guitar Chords for Beginners, and U.S.
Presidents. Follow these guidelines:

•
To get a question, navigate to the app’s Quiz menu and tap right .

•
To view an answer, tap right  again.

•
To get another question, tap left  to return to the Quiz menu, then from the prompt, tap down  for a new
random question.

Tips for Reading Text

Some apps provide text to read. Navigate these apps using the basic Nav Plus navigation described above. Also,
follow these guidelines:

•
Tap down  and tap up  to scroll through menu items and lists. For faster scrolling, use Flick and Scrub.

•
To view lines of text, tap right  to see the first line of text. Allow it to scroll to read the entire line. Tap

down  for next line. Also use Flick and Scrub when viewing text.

•
To view a new subject, story, or item, tap left  to return to menu, then tap down  and tap up  through

menu items and lists. Tap right  to select an item.

About the Nav Plus

The Nav Plus is a paper-based, five-way navigator that you can use to navigate the Main Menu on your smartpen.
You can use the Main Menu to locate commands, settings, and apps of your smartpen. There are two basic kinds
of Nav Pluses: pre-printed and hand-drawn.

The table below summarizes the commands available for the Nav Plus:
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After starting your smartpen or when you are writing notes without recording, Single-tap  on the
center of the Nav Plus to go to the Main Menu.

Single-Tap Center

If you are running an app, single-tapping returns you to the app’s menu.

If you are using an app other than Paper Replay, double-tap  on the center of a Nav Plus quits the
current app and returns your smartpen to the Main Menu. This also activates the Shortcut mode so
you can write an app name to launch it.

Double-Tap Center

If you are navigating app’s menu, double-tapping on the center of the Nav Plus returns to the Main
Menu. The one exception is if you are recording using Paper Replay, double-tapping the center returns
to the Main Menu but background recording continues.

Tap down  on the Nav Plus to scroll through a menu or a list of commands or options.
Tap Down

Tap up  on the Nav Plus to scroll through a menu or a list of commands or options.
Tap Up

Tap right  to select an item in the app menu list and possibly browse another level of a list. Tap
right to play audio or view items (such as a translation, description, or a chord).

Tap Right

Tap left  to return to a previous list or menu level. Tapping left eventually quits the app and returns
you to the Main Menu.

Tap Left

More About Tap Left

You can tap left  on the Nav Plus to quit a smartpen app or a Shortcut. You can also quit by tapping left
around any Launch Lines you drew. In general, tapping left lets you go back the way you came in. This means
that tapping left leads you back toward your starting place:

• If you started by tapping Nav Plus and navigating the Main Menu, tapping left leads you back to the Main
Menu.

• If you started by drawing a Launch Line or Shortcut on your Livescribe Dot Paper, then your smartpen shows
the current time.

• In either case, you end up in the same state: no app is running and the smartpen is ready to store the next thing
you write on your Livescribe Dot Paper.

Note:

Tapping left from the submenu of a smartpen app or Shortcut backtracks up the menu hierarchy toward
the root level. Tapping left from the root level jumps to Main Menu or the current time display, as described
above.

The root level of a launched app is the initial menu displayed when you launch the app. The root level of
a running Shortcut is the list displayed when you execute the Shortcut. In the case of Paper Replay when
launched explicitly, the root level is the initial menu containing items such as Record New Session, Play
Session, and so on. The root level of the play Shortcut is the Play Session list of Paper Replay.

Drawing a Nav Plus
If a pre-printed Nav Plus is not easily accessible, create your own by drawing one on your Livescribe Dot Paper.
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1. Using any Livescribe Dot Paper product, such as the included Starter notebook, draw intersecting vertical
and horizontal lines.

You can draw the intersecting lines in either order. The lines should be fairly straight and approximately the
same length. The lines must intersect near their centers.

Examples of Nav Pluses drawn incorrectly:

• Lines are not straight.

• Lines do not intersect in the center of each line.

2.
WIthin one second of drawing the lines, double-tap  on the center of the Nav Plus. This completed the
process of creating a Nav Plus.

After you draw a Nav Plus, it is always usable for future use.

Your smartpen shows the Main Menu if you successfully created a Nav Plus.

About Flick and Scrub
Flick and Scrub is a way for you to quickly scroll through menu items and other displayed text on your smartpen.
This feature is useful when text presented by an app is longer than the display can show horizontally or when
multiple menus or options are available vertically.

Flicking refers to quickly dragging your smartpen across paper and then lifting your smartpen off the paper. The
contents of the display scrolls rapidly, based on the speed of your smartpen when it was lifted.
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Scrubbing refers to dragging your smartpen across the paper. The contents on the display moves and scrolls in
the same direction and at the same relative speed as the movement of your smartpen.

When using Flick and Scrub, the display shows indicators based on the direction of additional text and the relative
position of the displayed text to the contents.

For vertical Flick and Scrub, the scroll indicator is on the right side of the display. In this example, the text shown
is close to the top of the current menu list. Therefore, the vertical scroll indicator is near the top.

For horizontal Flick and Scrub, the scroll indicator is at the bottom. In the examples below, the display scrolls
through the phrase “there were two small children”. The scroll bar along the bottom shows how far through the
phrase the current display is. The first display shows the position near the beginning of the phrase.

The second display shows the scroll bar position near the middle of the phrase after scrolling the display
horizontally.

Using Flick and Scrub

1. Navigate to a list of vertical menu items, such as Main Menu or one of its submenus, such as Applications
or Settings.

2. On any unused paper region, press the tip of your smartpen down for one-half (1/2) second.

3. Wait until you hear a short beep, then without lifting your smartpen tip off the paper, draw a horizontal or
vertical line.

Instead of drawing a line, you can draw a rectangular box as the Flick and Scrub control area. You may find
the box easier to use because it provides a wider area than a straight line.

Your smartpen assigns the area you draw as a Flick and Scrub control area for any app.
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4. Move your smartpen on the flick and scrub control area you drew to scroll through the app’s display text.

You can use both flicking and scrubbing motions on the same control area. You do not need to draw a separate
area for flicking and another for scrubbing. However, you need separate control areas for vertical and horizontal
scrolling.

After you have created a Flick and Scrub control region, you can use it at any time for scrolling. This is
similar to the way you can re-use a hand-drawn Nav Plus after creating it. To return to use the Flick and
Scrub region you do not need to press down the smartpen tip again for 1/2 a second. This is only needed
when first creating the region.

The display text scrolls either up and down (for vertical controls) or left and right (for horizontal controls),
depending on the direction in which you drew the control.

Assigning Commands to Home Button Double-Tap
By default, single-tapping and double-tapping on the home button do the same thing. However, you can assign
different functionality to double-tapping.

You can assign any open paper smartpen app (apps that do not require pre-printed controls) or Quick Command.
For instance, if you do a lot of calculations, you could assign the Calc Quick Command to launch with a double-tap
on the Home button.

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  on the directional arrow of the Nav Plus to scroll through a list of apps on the smartpen.

3.
When Shortcuts is displayed, Tap right  to select it.

4.
Tap right  to select it.

The smartpen prompts you for a command.

5. Write any Open Paper smartpen app name or write a Quick Command. For instance, write calc.
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Do not double-tap the center of the Nav Plus or write a doubled-back horizontal line. Write only the letters
that make up the Quick Command.

The smartpen shows the smartpen app name or Quick Command, then confirms the new assignment.

Using Shortcut Buttons
Shortcut buttons appear on some of the newer Livescribe Dot Paper, such as Livescribe Sticky Notes. They are
labeled with successive numbers: 1, 2, 3, etc.

You can assign functionality to the Shortcut button, just as you can assign functionality to double-tapping the
Home button. Assign any open paper smartpen app or Quick Command to a Shortcut Button.

1. Double-tap on the center of a Nav Plus to go to the Main Menu.

2. Tap down on the directional arrow of the Nav Plus to scroll through a list of apps on the smartpen.

3. When Shortcuts is displayed, tap right to select it.

The smartpen prompts you to assign a shortcut.

4. Tap down to display Assign Shortcut 1.

5. Tap down again to display Assign Shortcut 2, and so on.

6. When you see the number of the shortcut you wish to set, tap right .

The smartpen prompts you for a command.

7. Write any Open Paper smartpen app name or write a Quick Command. For instance, write calc.

Do not double-tap the center of the Nav Plus or write a doubled-back horizontal line. Write only the letters
that make up the Quick Command.

For example, it shows the Calc Quick Command, then starts scrolling: Shortcut  1 is Now Assigned To
[calc]

The display shows the smartpen app name or Quick Command, then it confirms the new assignment.

Tapping on an Unassigned Shortcut Button

Unlike the Home button, the Shortcut buttons have no default assignments. If you tap on an unassigned Shortcut
button, the smartpen prompts you to assign a command to the shortcut.

Tip:

If you accidentally tap on an unassigned Shortcut button and you do not wish to set it at this time, tap on
any Livescribe Dot Paper.
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Recording Audio on a Smartpen
Recording audio as you write notes is a key feature of your Livescribe smartpen. You can also record audio
without writing notes.

Starting a Recording with the Record Button

Important:

Do not record without permission. By using Livescribe products and services, you agree to comply with
all laws regarding recording.

1.
Tap the Record button .

2. The smartpen starts recording and shows an incrementing timer on the screen.

After you initiate a recording, you can use other apps on the smartpen, such as the Calculator. A blinking
Record icon appears in the bottom right corner of your display to indicate that recording is still in progress.

Starting a Recording with the Smartpen Power Button

Important:

Do not record without permission. By using Livescribe products and services, you agree to comply with
all laws regarding recording.

1. Press the Power button to start your smartpen.

2. Press and hold the Power button for approximately five seconds until the display indicates that the recording
started.

If your smartpen is off, press and hold the Power button until the start sequence and the word “REC…”
appear on the display.  Also, if you write on Livescribe Dot Paper after starting recording with Quick Record,
your smartpen links your notes and audio.
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Starting a Recording with a Nav Plus

1.

Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  until Paper Replay is displayed.

3.
Tap right  to launch the Paper Replay app.

You see the Record new session option.

4.
Tap right  to select Record new session.

The display indicates that recording has been initiated.

While you are recording with Paper Replay, you can use the Nav Plus to perform any normal set of functions,
such as scrolling through the menus and launching apps.

Stopping a Recording

You can stop recording audio or audio playback in several ways.

•
Tap the Stop button  on Livescribe Dot Paper.

• Power off your smartpen.

• Use the Nav Plus.

1.
During a recording, single-tap  on the center of the Nav Plus.

Your smartpen shows Stop Session. The recording continues and the background recording indicator (flashing
large dot) shows on the display.

2.
Tap right  to stop recording.
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Pausing and Resuming a Recording

1.
Tap the Pause button  to pause a recording.

Your smartpen shows a pause icon on the screen.

2. Tap the Pause button again to resume recording.

When recording is paused, your smartpen continues to capture notes that you write. Any notes that you write
after pausing and before resuming recording are linked to the audio that occurred the moment before you tapped
the Pause button.

Pausing and unpausing a recording does create separate sessions. The paused and unpaused session remains as
one. Starting and stopping recordings creates separate sessions.

Continuing Recording When Using Other Apps

You can launch and run another smartpen app (such as a calculator) while continuing to record audio with Paper
Replay. However, your smartpen does not link your notes to the audio while the other app is running. This is
because the new app receives your smartpen input (ink and strokes). The newly-launched app has the focus of
the smartpen, and has control of your display and audio output.

If you want to stop or pause recording, or add new index points to your recording, you must reactivate Paper
Replay as the dominant app. There are several ways to make the Paper Replay app reactivate:

• Tap on any of the printed Paper Replay controls, or on any Paper Replay notes you have written.

• Do anything that would normally launch Paper Replay, such as tap in a session region or launch the Paper
Replay app using the Nav Plus.

• Do not write or tap anything with your smartpen for five seconds.

Your smartpen screen indicates background recording is in effect with a blinking recording dot in the lower
right-hand corner of your display.

Caution:

Turning off or docking your smartpen stops recording.

Recording a Paperless Session

If you want to record audio but cannot or do not want to write on Livescribe Dot Paper, you can create paperless
audio. This method uses your smartpen as an audio recorder only.

Note:

When recording a paperless session, you can at any time, link the recording to written notes by writing
on Livescribe Dot Paper. At that point, the paperless session is linked to your notes and is no longer
paperless.
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Similarly, if you have previously recorded a paperless session, you can play it back and begin writing on
Livescribe Dot Paper. The paperless session is linked to your notes and is no longer paperless.

To create a paperless session, begin recording audio but do not take any notes. You can start a paperless session
in various ways:

• Tapping the Record button on any Livescribe Dot Paper

• Using the Quick Record feature

• Using the Nav Plus

The new paperless session appears in the Paper Replay session list.

To play back a paperless session, use the Nav Plus to browse Paper Replay sessions. Your smartpen indicates a
paperless session with an asterisk (*) next to the filename in the Select Session list.

Note:

If recording the paperless session was the last action you took with the smartpen, you can also access the
session by tapping on the 0% point of the paper control position bar.

Adding Audio Bookmarks When Recording

Bookmarks allow you to flag a section of audio and later go to it quickly and easily. You can add bookmarks as
you record, or add them later when listening to your recording.

•
Tap the Bookmark button  during either recording or playback. A bookmark is placed at that point in the
audio file.

Deleting Audio Recordings from a Smartpen

If you wish to delete sessions from your smartpen for any reason, such as managing storage, we recommend that
you transfer your notes to Livescribe Desktop and then delete Paper Replay sessions from your smartpen.

When you delete a session from the smartpen, your paper notes linked to that file no longer plays back the Paper
Replay audio that was previously linked to that ink. However, as long as you have transferred your notes to
Livescribe Desktop, you can continue to replay your notes from your computer.

Note:

You cannot retrieve a session after you delete it from both the smartpen and Livescribe Desktop. Deleting
sessions does not affect the notes on the smartpen - they remain on the smartpen until you archive the
notebook.

There are various ways to delete Paper Replay sessions from the smartpen:

• Use a Livescribe Desktop to remove the smartpen session.
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• Archive your paper product. This removes all Paper Replay sessions from your smartpen for that paper product.

• Using the Main Menu on the smartpen.

• Using the Delete Current Session shortcut to delete the most-recently accessed session.

Deleting Audio Recordings with the Nav Plus

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  to scroll through the apps on your smartpen until Paper Replayis displayed.

3.
Tap right  to launch Paper Replay.

4.
Tap down  to locate Delete session from the menu.

5.
Tap right  to browse sessions.

6.
Tap down  to scroll through a list of sessions.

7.
Locate the session to delete and Tap right  to select it.

8.
Tap right  to confirm deletion.

Your smartpen indicates that the session is deleted.
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Deleting the Current Audio Recording with a Shortcut

You can use a shortcut to delete the current session. In this context, the current session is the most recently
accessed session. This is the last session that was either played or recorded.

1. On any Paper Replay Stop button, tap and hold for three seconds. Your smartpen instructs you to tap again
to delete the current session.

2. Tap Stop again to confirm the deletion.

Configuring Audio Recording Settings

Setting Audio Recording Quality with the Settings Menu

Use the Audio Quality setting to configure the quality of your audio recordings.

• High: Records at the highest audio quality. This setting requires the largest amount of storage space and is best
for very large environments or when the highest-quality recording is required.

• Medium: The default audio quality setting.

• Low: Records at lowest audio quality. This is a storage-saving setting that utilizes the least amount of storage
and is optimal for dictations or smaller, quieter environments.

1. From the Settings menu, select the Audio Quality option.

2. Select High, Medium, or Low.

You cannot change Audio Quality during a recording. Always select the appropriate audio quality before
beginning a recording.

Viewing Audio Recording Quality with the Audio Settings Button

Tap on the Audio Settings button  on the inside cover of a Livescribe Dot Paper product.

The smartpen shows its audio settings, including audio quality.

Setting Microphone Sensitivity with the Settings Menu

You can set your smartpen Microphone Sensitivity for different recording situations.

• Conference Room: Sets the microphone sensitivity for quieter environments where the person speaking is
closer to the microphone. This setting is best for dictations, offices, or small conference rooms.
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• Lecture Hall: Sets the microphone to pick up sounds in a wider open area. This setting is best for large rooms
where the speaker’s voice is distant from your smartpen microphone. You should also use of the 3-D Recording
Headset when recording in this type of environment.

• Automatic: The default setting, sets your microphone sensitivity automatically based on the noise level of
your environment.

Note:

You cannot change Microphone Sensitivity while your smartpen is recording. Always select the
appropriate setting before beginning a recording. The microphone uses the last setting you set.

1. From the Settings menu, select the Microphone Sensitivity option.

2. Select Conference Room, Lecture Hall, or Automatic.

Viewing Microphone Sensitivity with the Audio Settings Button

You can view your smartpen Microphone Sensitivity.

Tap on the Audio Settings button  on the inside cover of a Livescribe Dot Paper product.

The smartpen shows its audio settings, including microphone sensitivity.

Viewing Audio Settings with the Audio Shortcut

You can view the status of all audio settings on a smartpen with the Audio Shortcut:

1.

Double-tap  on the center of a Nav Plus.

Your smartpen shows the Shortcut indicator in the Main Menu. It is waiting for you to write a Shortcut.

2. Within three (3) seconds, write the word “audio.”

Using its predictive text feature, your smartpen shows the first command that matches your written input. In
this case, audio is displayed as soon as you write “a”. As soon as you see the command you want on the
display, you can stop writing.

3.
Tap right  on the Nav Plus, or double-tap on any Livescribe Dot Paper.
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When you create a Shortcut, it becomes an active button that you can tap to repeat the application or command.
The same is true for Launch Line Shortcuts you create.

Your smartpen shows its audio settings.

Playing Back Audio on a Smartpen
After recording audio with your smartpen, you can play it back in several ways.

Playing Back a Session by Tapping on Your Notes
When recording a Paper Replay session, your notes and audio are linked and synchronized.

Tap on your notes to play back audio linked to them. The audio plays back from the point in your notes where
the audio was recorded.

During playback, your smartpen screen indicates the current position in the recording and the time remaining in
your recording.

Tip:

As you record, remember to write something down on your notepad so that you can begin playback by
tapping on it. If you do not do this, you create a paperless session.

Playing Back a Session with Playback Buttons

Tap on any of the playback buttons in your Livescribe Dot Paper to access the most recently recorded or
played-back session.

• Jump forward/back

• Position bar

• Bookmark

The Paper Replay playback controls such as jump, position bar, and bookmark, function within a single Paper
Replay session. You can jump forward or back or speed listen to only one Paper Replay session at a time.

Tip:

Tapping on the playback controls before tapping on any of the written notes on a page, plays back your
most recently accessed audio recording regardless of whether that recording or those notes are on the
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current page. This feature allows you to quickly replay your last recording even if you have forgotten to
write notes on paper.

Playing Back a Session with the Play Shortcut

Use the Play Shortcut to quickly show the top item in the session list.

1.
Double-tap  on the center of a Nav Plus.

Your smartpen shows the Shortcut indicator (*) in the Main Menu. It is waiting for you to write a Shortcut.

2. Within three (3) seconds, write the word “play.”

Using its predictive text feature, your smartpen shows the first command that matches your written input. In
this case, “play” is displayed as soon as you write “p”. As soon as you see the command you want on the
display, you can stop writing.

3.
Tap right  on the Nav Plus, or double-tap on any Livescribe Dot Paper.

4.
Your smartpen shows the top item in the Play session list. You can tap down  using the Nav Plus to scroll

through sessions and then tap right  to begin playback.

When you create a Shortcut, it becomes an active button that you can tap to repeat the application or command.
The same is true for Launch Line Shortcuts you create.

Playing Back a Session using the Nav Plus

Use the Nav Plus to browse a list of audio sessions and select the audio file by timestamp.

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  until you see Paper Replay.
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3.
Tap right  to select the Paper Replay app menu. The first item in the list is Record new session.

4.
Tap down  to locate Play Session.

5.
Tap right  to view a list of sessions listed using their timestamp.

6.
Tap down  to scroll through the list of sessions.

7.
Tap right  to select the audio session that you want to open.

Playback begins.

Stopping Audio Playback

You can stop audio playback in several ways.

•
Tap the Stop button  on Livescribe Dot Paper.

• Power off your smartpen.

• Use the Nav Plus.

1.
During audio playback, single-tap  on the center of the Nav Plus.

Your smartpen shows Stop Session.

2.
Tap right  to stop playback.
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Pausing and Resuming Audio Playback

1.
Tap the Pause button  to pause audio playback.

Your smartpen shows a pause icon on the screen.

2. Tap the Pause button again to resume playback.

When playback is paused, your smartpen continues to capture notes that you write. Any notes that you write
after pausing and before resuming playback are linked to the audio that occurred the moment before you tapped
the Pause button. Adding and linking notes as you play back audio is called annotating.

Controlling Audio Playback

There are various ways that you can control the playback of an audio file on your smartpen and quickly locate
any section of the audio file. All of the controls mentioned below are available on the bottom of each page of
your notebook.

Changing Playback Volume

Use the Volume controls  to raise or lower the playback volume or mute playback entirely. After
muting the playback, you can un-mute it by tapping the mute button a second time.

Jumping Forward and Backward

You can jump back or forward 10 seconds in an audio file by tapping on the Jump controls .

Speed Jumping

Tap and hold down the Jump Back or Jump Forward button  to continuously jump through an audio
file. As you continue to speed jump, the length you jump increases.

Jumping to a Position

If you want to quickly go to the beginning, end, or any position within an audio session, use the Jump to Position
bar.

1. Tap anywhere on the position bar to go to the corresponding position in the audio file.

2. Tap the 0% button to jump directly to the beginning of the current audio session.

Livescribe User Guides50



Changing Playback Speed

If you want to speed listen to the audio file or slow the audio session to replay a specific moment, use the Playback
Speed controls .

•
To slow down the audio from normal speed, tap the Slow Down Audio  button. Tap repeatedly to keep
slowing down audio speed.

•
To speed up the audio from normal speed, tap the Speed Up Audio  button. Tap repeat-edly to keep
increasing the playback speed.

•
To return to normal speed—the speed at which the audio was recorded—tap the Normal Audio Speed 
button.

Audio that is played back either sped up or slowed down is no longer in stereo. Audio plays in mono until it is
returned to normal speed.

Setting Audio Bookmarks During Audio Playback

Bookmarks allow you to flag a section of audio and later go to it quickly and easily. You can add bookmarks as
you record, or add them later when listening to your recording.

•
Tap the Bookmark button  during either recording or playback. A bookmark is placed at that point in
the audio file.

Reviewing Bookmarks

• After you have added bookmarks to an audio session, you can scan through the bookmarks using the Previous

 and Next   bookmark buttons.
• During playback, your smartpen screen shows the bookmarks in the audio timeline.

Playing Back Audio with the Nav Plus

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  to scroll through the apps on your smartpen until Paper Replay is displayed.
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3.
Tap right  to launch the Paper Replay app menu. Record new session is the first item.

4.
Tap down  until you reach Play session.

5.
Tap right  to browse sessions.

6.
Tap down  to scroll through a list of sessions.

Your smartpen shows Paper Replay sessions in the order of the most recent with paperless sessions coming
before regular sessions.

7.
Tap right  to select the session you want to play.

Protecting Audio Recordings with a Paper Replay Password
You can use the Paper Replay Password feature to set a password for audio recordings on your smartpen.
Setting a password can prevent other people from listening to your recorded audio. Audio play back is prevented
until the password is entered. The password is a four-digit number.

1.
From the Main Menu, tap down  to locate Paper Replay.

2.
Tap right  to launch Paper Replay.

3.
Tap down  to Password protection.

4.
Tap right  to set your password.

5. On your notepad, write four digits as your password.
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To disguise your written password, Livescribe recommends using one of these methods:

• Write the numbers in a different order, for example backwards.
• Write the numbers in various places on the page.
• After writing and confirming your password, go back and write other numbers over your password to

disguise it.

6.
When you are finished entering your password, tap right  on the Nav Plus. Your smartpen confirms the
password is set.

After setting your password, your smartpen prompts you each time you try to play back a session.

7. To listen to your sessions, write your password on your Livescribe Dot Paper when prompted by your
smartpen. You smartpen confirms if your password is correct.

Canceling Paper Replay Password

1. Use the Nav Plus to navigate to the Paper Replay > Password protection > Remove password.

2.
Tap right  on the Nav Plus to remove the password and cancel password protection.

3. At the prompt, write the current password to be removed.

Passwords are not saved when password protection is turned off. The previous password is permanently
erased. When you reactivate password protection, you need to set a new password. You can re-use passwords.
They are not tracked across uses.
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4. Your smartpen confirms the password is removed.

You can also cancel password protection and remove your Paper Replay password using Livescribe Desktop.
This is useful if you forget your password and need to regain access to your Paper Replay sessions. The
Livescribe Desktop you use to cancel the password must be registered to the same account as your smartpen.
You must dock your smartpen as well to remove the password.

Configuring Audio Playback Settings

Enabling or Disabling Playback Latency with the Settings Menu

There is natural delay (or latency) between the time you hear an important point and the time when you begin
writing notes about it. To address this natural delay, your smartpen plays back audio from a moment five (5)
seconds before you wrote the notes. This feature is called Playback Latency. You can enable or disable this
feature.

1. From the Settings menu, select the Playback Latency option.

2. Select On or Off.

Viewing Playback Latency with the Audio Settings Button

Playback Latency is a feature that plays back audio from a moment five (5) seconds before you wrote notes
based on the audio. You can view if this setting is enabled (default) or disabled.

1.

To view the current playback latency, tap on the Audio Settings button  on the inside cover of your
notebook.

2. The smartpen shows its audio settings, including whether playback latency is On or Off.

Sending and Sharing Notes and Audio from a Smartpen
Using Livescribe Connect, you can send and optionally share notes and audio directly from your smartpen when
you dock it to your computer. See the Livescribe Connect User Guide.
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Doing Math Calculations
You can use your smartpen to perform math calculations.

Using the Calc Shortcut
Calc Shortcut to perform basic mathematical calcula-tions.

When using Calc, follow these guidelines:

• Numbers can contain up to 12 characters, including a decimal point.

• Operators can include +, -, ×, *, /, and ÷.

• You can double-tap instead of writing the equals sign. For example, 52 - 14 followed by a double-tap is like
writing =.

Note:

If the length of the math problem exceeds the display size, the beginning of the problem scrolls off the
left of the display as new characters are added to the right.

1.
Double-tap  the center of a Nav Plus. A double-tap is two taps in quick succes-sion.

Your smartpen shows the Shortcut indicator (*) in the Main Menu. The smartpen is waiting for you to write
a Shortcut.

2. Within three (3) seconds, write the word “calc.”

Using its predictive text feature, your smartpen shows the first command that matches your written input In
this case, calc is displayed as soon as you write a “c”. As soon as you see the command you want on the
display, you can stop writing.

3.
Tap right  on the Nav Plus, or double-tap on any Livescribe Dot paper.

Your smartpen prompts you to write a problem.

4. Write a basic math problem, such as 51 x 3 =
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Your smartpen shows the result.

When you create a Shortcut, it becomes an active button that you can tap to repeat the application or command.
The same is true for Launch Line Shortcuts you create.

Using the Calculator

The calculator located on the inside covers of your Livescribe Dot Paper performs basic math functions, as well
as many useful scientific functions. There is also a card version of the calculator you can purchase separately
from the Livescribe Online Store and Livescribe retailers.

To use the calculator, tap on the printed keys with the tip of the smartpen.

Note:

A stylus is available for purchase from the Livescribe web store. Use the stylus instead of an ink cartridge
to keep your calculator free and clear of ink marks.

Using Basic Math Functions

The calculator shows results and accepts input of numbers up to a length of 11 characters. If a result is longer

than 11 digits, the calculator shows it in exponential notation. You can tap on the  key to toggle between
positive and negative numbers. Basic math operators function like a typical desk calculator. Tap a number, an
operator, another number, and an equal sign to show the answer.

If you tap the equal sign directly after the operator, the calculator performs the operation on the initial number
that you tapped. For example, tap ‘6 x =’. The displayed result is 36.

If you tap more than one operator in a row, only the last operator is kept. For example, tap ‘6 x + 4 =’. The result
is 10. The ‘+’ replaces the ‘x’.

If you tap the equal sign repeatedly in succession, it repeats the previous calculation. For example, tap ’3 + 4 =
=’ The initial result is 7. Then, 4 is added to 7 equaling 11.
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Using Parentheses in Expressions

Normally the calculator respects the standard order of operations in an extended expression. However, you can

use parentheses  in an expression to control the sequence of execution. You can nest
parentheses to further control of the calculation sequence.

Note:

Each time you tap a close parenthesis, the calculator calculates and shows the result of the enclosed
expression.

Using Clear Entry (CE) and Clear (C) Keys

• Tap the  key to clear the current entry.
•

Tap the  key to clear an entire expression, including any pending operator.

Neither key clears values in memory.

Using Memory Keys

You can store numbers in the memory register. When a value is present in memory, the smartpen screen shows
an M indicator.

When the value in memory changes, the indicator on your smartpen screen blinks. When the value in memory
is zero, the memory indicator disappears.

Adds the currently displayed value to the value in the memory register.

Subtracts the currently displayed value from the value in the memory register.

Shows the value currently in the memory register.

Sets the memory value to “0”.

Using Scientific Functions

The Scientific section of the calculator includes several specialized operators and functions, including special
math operators and trigonometry functions.

For some scientific calculations, you only need to enter one number followed by an operator to obtain a result.
When you enter a number followed by one of these keys, the result shows immediately. Other operators take

two values. For example, to square 7, tap ‘7 ’. The result is 49. To raise 2 to the power of 3, tap ‘2  3 =’.
The result is 8.
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Calculator Keypad Reference

Returns the percentage value of the number.

Returns the factorial of number n.

Returns the square of the number.

Returns the square root of the number.

Returns the inverse of the number.

Raise a number y to the power of a number x.

Returns Pi.

Returns 10 to the x power.

Returns e to the x power (the natural exponential. e is approximately 2.71828...

Returns the base 10 logarithm of the number.

Returns the natural logarithm of the number.

Generates a random number between 0 and 1.

Cosine of the number.

Arc-Cosine of the number.

Tangent of the number.

Arc-Tangent of the number.
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Sine of the number.

Arc-Sine of the number.

Trigonometric calculations such as sine, cosine, and tangent must be made in degree, radian, or gradian mode. The

calculator is in degree mode by default, and returns to degree each time you power off your smartpen. The DRG 
button toggles between Degree, Radian and Gradian mode. If you use a trigonometry function, or use the DRG key to
change modes, the smartpen screen shows the indicator of the current mode.

Note:

You cannot use the DRG key to convert a completed calculation. Use it to set the mode before beginning the
calculation.

Using the Piano
With Piano, you can draw a piano on your dotted paper and play music with the smartpen. You can change the
sound of your piano, add rhythm tracks, and add sharp and flat notes.

Launching Piano from the Nav Plus

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  to scroll through the smartpen menu until Piano is displayed.

3.
Tap right  to select Piano.

You can also launch Piano using Launch Line.

Drawing a Piano

1. From left to right, draw 9 parallel vertical lines.

The smartpen screen shows a blinking line to indicate which line you should draw next.
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2. Connect the 9 parallel lines with horizontal lines at the top and bottom.

3. Write the letter “i” and double-tap near it. This is your instrument button.

4. Tap the “i” button repeatedly to select one of the seven instruments: Grand Piano, Vibraphone, Kalimba,
Steel Drum, Fiddle, Flute, or Celeste.

5. Tap on your keyboard when the first letter of the instrument you want to play is displayed on the smartpen
screen.

6. Write the letter “r” and double-tap near it. This is your rhythm tracks button.

7. Tap the “r” button repeatedly to scroll through the five rhythm track options.

8. Next, add sharps and flats to your piano keyboard.

9.
After setting the instrument and rhythm buttons, tap left  on the Nav Plus.

The smartpen shows Rhythms OFF.
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10.
Tap down  to reach Add Sharps & Flats.

11.
Tap right  to activate Add Sharps & Flats.

12. The smartpen shows blinking rectangles on your piano. Draw rectangles after the 2nd, 3rd, 5th, 6th, and 7th
piano key lines, as in the display.

13. Play your piano by tapping its keys on the paper. Tap the instrument and rhythm buttons to change their
values.

A stylus is available for purchase from the Livescribe web store.  You can use the stylus on your piano, rather
than the ink cartridge. This keeps the paper free and clear of ink marks.

Choosing an Instrument (Piano Sound)

1. Tap your “i” instrument button repeatedly to scroll through the instrument sounds your piano can play.

Available sounds are:

• Grand Piano

• Vibraphone

• Kalimba

• Steel Drum

• Fiddle, Flute

• Celeste

2. Tap on your piano keyboard to select a sound.

The first letter of the instrument you want to play shows on the smartpen screen.
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Choosing a Background Rhythm Track

• Tap the “r” rhythm track button repeatedly to scroll through the available background rhythm tracks.

Turning Off the Rhythm Track
You can turn off or turn on the rhythm track.

•

Tap left  on the Nav Plus.

The smartpen shows “Rhythms OFF.” Tap right  on the Nav Plus to stop the rhythm track

• Tap the “r” button to scroll through the rhythm tracks until no track plays.

Using the Translator Demo
With the Translator Demo, you can translate a small set of words and the numbers zero to nine from English
into Spanish, Swedish, Arabic, or Mandarin. By writing a word in English in your notebook, you can see and
hear correct translation from the smartpen.

Translator Demo Word List

Here are the words currently defined for the Translator Demo:
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• Zero, One, Two, Three, Four, Five, Six, Seven, Eight, Nine, Ten

• Hello, Goodbye

• Please, Thanks, Thank you

• Chocolate, Banana

• Water, Coffee, Beer

Getting More Apps

Livescribe and other companies offer new apps for your smartpen. You can download these from the Livescribe
Online Store. Just go to www.livescribe.com/store and browse the apps available.

Some apps are free and others are available for purchase. All apps are designed to work like the built-in apps
that come with your smartpen. Visit the store regularly to check for new updates.

After you download a new app, you can use Livescribe Desktop and add it to any smartpen registered to your
Livescribe account.

Livescribe Desktop installs all apps. You can find Store apps under the Applications menu. This menu is the
first menu item underneath the Main Menu and is available after you install your first Store app.

Getting More Apps

Livescribe and other companies offer new apps for your smartpen. You can download these from the Livescribe
Online Store. Just go to www.livescribe.com/store and browse the apps available.

Some apps are free and others are available for purchase. All apps are designed to work like the built-in apps
that come with your smartpen. Visit the store regularly to check for new updates.

After you download a new app, you can use Livescribe Desktop and add it to any smartpen registered to your
Livescribe account.

Livescribe Desktop installs all apps. You can find Store apps under the Applications menu. This menu is the
first menu item underneath the Main Menu and is available after you install your first Store app.

Using the Settings Menu
With the Settings menu, you can change and view many smartpen settings.

1.
Double-tap  on the center of a Nav Plus to go the Main Menu.

2.
Tap down  until Settings is shown.

3.
Tap right  to select Settings.

4.
Tap down  and tap up  to scroll through the setting types list.
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Tap right  to select a setting type.

5.
Tap down  and tap up  to scroll through the setting options list.

6.
Tap right  to select an option. After activating an option, a confirmation message scrolls across your
smartpen screen and the active option has a checkmark beside it in the display.

7.
Tap left  to return to the option setting list to make a different selection.

8.
Tap left  again to return to the option list to select a different option.

Settings Menu Summary
Many smartpen settings are configurable through the Settings menu.

ValuesSetting

High, Medium, LowAudio Quality

Conference room, Lecture hall, AutomaticMicrophone Sensitivity

On, OffPlayback Latency

On, OffMenu Voice

100%, 90%, 75%, 50%, 10%Screen Brightness

right-handed, left-handedScreen Orientation

1-10 (1 is slowest, 10 is fastest)Scroll Speed

mm.dd.yy, dd.mm.yy, yy.mm.ddDate Format

12-hour, 24-hourTime Format

30 minutes, 1 hour (default), 2 hours, 4 hoursAuto-Off Time

English, French, Italian, German, Spanish,

Korean, Simplified Chinese, Malay, Arabic,

Japanese, Portuguese, Turkish, Dutch

Locale

Use the following table as a reference when configuring smartpen settings using the Settings menu.
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Setting the Smartpen Auto-Off Time with the Settings Menu
By default, your smartpen powers off automatically when it is not used for an hour. If you are recording (even
if the smartpen is stationary), playing back audio, or if you are writing, the smartpen does not turn off
automatically. Your smartpen must be inactive (no recording or writing) before the Auto-Off feature activates.

Once activated, Auto-Off waits for a preset time before powering off your smartpen. You can set the length of
time before your smartpen automatically powers off to be 30 minutes, 1 hour (the default), 2 hours, and 4 hours.

1. From the Settings menu, choose the Auto-off Time option.

2.
Select the desired time and tap right .

The auto-off time setting persists until you change it or the smartpen is completely reset.

Viewing the Smartpen Name with the Settings Menu

If you use Livescribe Desktop to name your smartpen, you can view its name when the smartpen powers on.
You can also view the smartpen name using the Settings menu.

From the Settings menu, choose the Smartpen Name option.

The smartpen shows the name.

Enabling or Disabling Menu Voice with the Settings Menu

Your smartpen announces items in the Main Menu and in the Applications menu using the Menu Voice.

1. To enable or disable the menu voice, use the Settings menu and select the Menu Voice option.

2. Select Off or On.

Turning off the Menu Voice does not affect Paper Replay audio or other smartpen sounds.

Setting the Date and Time
You can set the date and time on your smartpen.

Important:

It is very important that you set the correct date and time on your smartpen. Paper Replay names audio
recordings using the date and time that they are created.

Setting the Date

1. Open the inside cover of your Livescribe Dot Paper product and locate the Settings area.

2. Tap the Set Date button  with the smartpen.

3. Tap the printed keypad and type the current date.

Tapping 101809 sets the date to Sunday, October 18, 2009 for the date format of mm/dd/yy.

If you make a mistake while entering the date, tap on the Set Date buttons again to start over.
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Your smartpen shows the date you entered.

Setting the Date Format

The smartpen presents the date format as mm/dd/yy by default. You can change this format either before or any
time after you set the date.

1. Use the Settings menu and navigate to the Date Format option.

2. Select either mm/dd/yy, dd/mm/yy, or yy/mm/dd.

Viewing the Date with the Date Button

1. Open the inside cover of your Livescribe Dot Paper product and locate the Settings area.

2.

Tap the Date button .

The smartpen shows the current date.

Viewing the Date with a Shortcut

1.
Double-tap  on the center of a Nav Plus.

Your smartpen shows the Shortcut indicator in the Main Menu. It is waiting for you to write a Shortcut.

2. Within three (3) seconds, write the word “date”

Using its predictive text feature, your smartpen shows the first command that matches your written input. In
this case, date is displayed as soon as you write a “d”. As soon as you see the command you want on the
display, you can stop writing.

3.
Tap right  on the Nav Plus, or double-tap on any Livescribe Dot Paper.

Your smartpen shows the date.
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When you create a Shortcut, it becomes an active button that you can tap to repeat the application or command.
The same is true for Launch Line Shortcuts you create.

Setting the Time

1. Start your smartpen.

2. Open the inside cover of your Livescribe Dot Paper product and locate the Settings area.

3. In your notebook, tap the Set Time button  with the smartpen.

4. Tap the printed Settings keypad and enter the time as “hh:mm” format. Tap the “AM” or “PM” button to
select AM or PM. For example, to enter 12:01PM, tap “1,” “2,” “0,” “1,” and the “PM” button.

If you make a mistake, entering the time, simply tap on the Set Time buttons again to start over.

Your smartpen shows the time you entered.

Setting the Time Format

1. Use the Settings menu and navigate to the Time Format option.

2. Select either 12 hour or 24 hour.

Viewing the Time with the Time Button

1. Open the inside cover of your Livescribe Dot Paper product and locate the Settings area.

2.

Tap the Time button .

The smartpen shows the current time.

Viewing the Time with a Shortcut

You can use Shortcuts to check the time.

1.

Double-tap  on the center of a Nav Plus. A double-tap is two taps in quick succession.

Your smartpen shows the Shortcut indicator in the Main Menu. It is waiting for you to write a Shortcut.

2. Within three (3) seconds, write the word “time”.

Using its predictive text feature, your smartpen shows the first command that matches your written input. In
this case, time is displayed as soon as you write a “t”. As soon as you see the command you want on the
display, you can stop writing.

3.
Tap right  on the Nav Plus, or double-tap on any Livescribe Dot Paper.
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Your smartpen shows the time.

When you create a Shortcut, it becomes an active button that you can tap to repeat the application or command.
The same is true for Launch Line Shortcuts you create.

Configuring the Smartpen Screen
There are several settings you can apply to your smartpen screen.

Setting Screen Brightness

Setting Screen Brightness with the Brightness Button

1. Open the inside cover of your Livescribe Dot Paper product and locate the Settings area.

2.
Tap the Brightness button .

3. Tap multiple times to scroll through the screen brightness settings. Values are 100%, 90%, 75%, 50%, and
10%. The lowest brightness setting is optimal for dark room environments, such as when a speaker may be
presenting a slideshow.

Setting Screen Brightness with the Settings Menu

1. Use the Settings menu and navigate to the Display Brightness option.

2. Select the brightness.

Values are 100%, 90%, 75%, 50%, and 10%. The lowest brightness setting is optimal for dark room
environments, such as when a speaker may be presenting a slideshow.

Setting Screen Orientation

Setting Screen Orientation with the Left or Right Buttons

You can configure your smartpen screen for either left- or right-handed use.  Tap the appropriate button to
configure your display orientation.

1. Start your smartpen.

2. Open the inside cover of your Livescribe Dot Paper product and locate the Settings area.

3.
Under Settings, tap on the Left or Right buttons  to orient your display for left- or right-handed use.

Setting Screen Orientation with the Settings Menu

1. Use the Settings menu and navigate to the Display Orientation option.

2. Select either right-handed and left-handed.

Livescribe User Guides68



Setting Scroll Speed

Setting Scroll Speed with the Plus and Minus Buttons

Text that is too long to fit on your smartpen screen scrolls across it. You can increase or decrease the rate at
which text scrolls using the Scroll Speed settings.

• To increase the scroll speed, tap the  button.
• To decrease the scroll speed, tap the printed  button.
• Tap until you reach the desired speed, between 1 and 10. 1 is slowest and 10 is fastest.

Setting the Scroll Speed with the Settings Menu

1. Use the Settings menu and navigate to the Scroll Speed option.

2. Select the desired speed, between 1 and 10.

Changing Smartpen Locales
You can use the Locale command in the Settings menu to change your smartpen screen and audio instructions
from one language to another.

Changing Locales with the Settings Menu

When you switch to another language, your smartpen changes the following things based on the locale:

• Language of text resources (such as menus and other on-screen prompts)

• Language of audio resources (such as app names and instructions)

• Date format

• Time format

• Number format

1. Use the Settings menu and navigate to the Locale option.

2. Select one of the available locales.

This list includes: English, French, Italian, German, Spanish, Korean, Simplified Chinese, Malay, Arabic,
Japanese, Portuguese, Turkish, and Dutch.

3.
When prompted, tap right  again to restart your smartpen.

After your smartpen restarts, it runs with the selected language as the default.

Livescribe also provides printed controls on certain Livescribe Dot Paper you can use to switch between languages.

Switching Between Chinese and Korean Locales with the Language Switch Card

You can use the Language Switch Card to switch your smartpen from English to Chinese or Korean.
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The following example switches from English to Korean.

1.
Tap the Korean button .

2. Tap the button again to restart your smartpen.

After your smartpen restarts, it runs with Korean as the default locale.

Changing Locales with the Getting Started Guide Controls
The printed Getting Started Guide that ships with your smartpen may have printed controls to switch your
smartpen from English to other languages. If it does, you can use these controls as follows. Otherwise, use the
Settings menu to switch locales:

The following example switches from English to German.

1.
Tap the Deutsch button .

2. Tap the button again to restart your smartpen.

After your smartpen restarts, it runs with German as the default locale.

Managing Livescribe Dot Paper
Livescribe sells notebooks, journals, flip notepads, and other paper products for your smartpen. These products
are all Livescribe Dot Paper.

About Livescribe Dot Paper
To perform its many operations, your smartpen requires Livescribe Dot Paper.

This paper is standard paper with printed microdots on its surface. These dots are nearly invisible to the human
eye. However, the smartpen can easily see these dots and uses them to know which page you are writing on and
the exact location on that page. The smartpen can even see these dots through the ink you write on your pages.

The microdot pattern on each page is based on technology from Anoto AB. This dot pattern consists of small
dots (100 micrometers in diameter) arranged with a spacing of approximately 0.3 mm. The dot pattern overlays
an imaginary square grid. The dots are slightly displaced from the grid, with each dot in one of four possible
positions, forming the proprietary Anoto dot pattern.

The dot pattern identifies the specific page and locations on the page of the notes you write. Your smartpen uses
the dot pattern in a way similar to a geographical positioning system (GPS). But, instead of identifying locations
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on land, it finds locations on paper and stores your writing as digital ink using those locations. Using this patented
dot-positioning system (DPS), the smartpen precisely tracks its own movement on paper. As a result, anything
you write – words, numbers or drawings – can be stored, recognized, and intelligently responded to by the
smartpen.

The area of the entire Anoto dot pattern is huge, and represents a piece of paper the combined size of Europe
and Asia. Livescribe Dot Paper is based on a portion of this dot pattern.

Usage Guidelines for Livescribe Dot Paper

Understanding how your smartpen interacts with Livescribe Dot Paper can be challenging. Fortunately, you do
not need to know how it all works. All you need to do is follow these guidelines:

• Before using the new paper product, tap on the Status Label. If it says you are already using a notebook with
the same number, be sure to archive your old notebooks on Livescribe Desktop first.

• If you own paper products that have the same naming and numbering, use them sequentially.

• Archive your Livescribe Dot Paper products after you have finished with them.

• When purchasing Livescribe Dot Paper, buy paper products that have different numbers than the ones you are
currently using.

Checking Livescribe Dot Paper Usage

Each Livescribe Dot Paper product has a Status Label. Using the Status Label is the best way to tell if you are
currently using a Livescribe Dot Paper product that has the same dot pattern.

1. When you open a new Livescribe Dot Paper product, tap on its Status Label with your smartpen.

2. Your smartpen screen shows whether you are using another Livescribe Dot Paper product with the same dot
pattern. If you are, archive the older Livescribe Dot Paper product before using the new one.

3. In some cases, your smartpen needs to be updated to use a new paper product. If this occurs, your smartpen
screen indicates this when you tap the Status Label. If you see this message, update your smartpen software.

Archiving Paper Products

When you have finished using a Livescribe Dot Paper product, you should archive it in Livescribe Desktop.

Archiving a Livescribe Dot Paper product does the following:

• Frees up storage space on your smartpen

• Enables you to use another Livescribe Dot Paper product that has the same dot pattern as the one you archived.
Livescribe Dot Paper with the same dot pattern have the same name.

• Moves your notes and audio for a Livescribe Dot Paper product into an Archived Notebooks folder in the
Library Pane of Livescribe Desktop. Your notes and audio remain interactive in Livescribe Desktop, just like
non-archived Livescribe Dot Paper.

• Deletes your notes (ink data) and audio from your smartpen. Because of this, your smartpen no longer interacts
with the physical Livescribe Dot Paper product that you archived. That is, when you tap the notes in your
archived physical notebook, they do not play back any audio.
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Important:

Do not archive a notebook unless you are finished using the physical note-book and are ready to set it
aside. After you have archived a notebook, do not go back to its physical notebook and start writing on it
again, unless you have unused pages and want to treat them as a part of a new notebook. For example,
you could archive a notebook that is partially completed, and then use the remaining pages as a second
notebook. If you are using multiple computers to manage your smartpen data, be sure to archive your
notebooks on all of these computers.

About Livescribe Dot Paper Naming

Livescribe identifies a Livescribe Dot Paper product by a group (such as Lined Note-book) and a number (from
1 to 8). Any two Livescribe Dot Paper labeled with the same group and number have the same dot pattern.

Each Livescribe Dot Paper product belongs to a group based on its format (lined, unlined, grid...) and form factor
(notebook, journal, notepad …).

Livescribe further identifies each paper product with a number.  Within a group, Livescribe Dot Paper labeled
with the same number have the same dot pattern. Livescribe Dot Paper labeled with different numbers have
different dot patterns. Currently, numbers in a group run from 1 to 8.

Using Paper Products with Same Names and Numbers

If you own two Livescribe Dot Paper products with the same Group and Number (such as two Lined Notebook
3s), follow these guidelines:

• Use only one of the Livescribe Dot Paper products at a time. Do not use the two paper products at the same
time.

• Before starting on the second paper product, archive the first one with Livescribe Desktop.

For example, do not use two Lined Notebook 1 paper products at the same time. Instead, use another lined
notebook with a different Number, such as a Lined Note-book 2 or Lined Notebook 3.

If you have used all the Numbers in the Lined Notebook group, you may wish to start a second, unused Lined
Notebook 1. To do so, archive the first Lined Notebook 1. Then you can use your smartpen on the second Lined
Notebook 1.

Livescribe Dot Paper products sold in a pack are from same group.  For example, Lined Notebooks come in
packs of four (Notebooks 1-4 and 5-8).

When you buy two or more packs of Lined Notebooks, verify that the Numbers on the Notebook covers are
different. For example, buy and use Notebooks 1-4 and Notebooks 5-8 before buying another pack of 1-4 or 5-8.

If you have purchased two packs with the same numbering, the packs have the same dot pattern. In this case,
follow these guidelines:

• Use all the Livescribe Dot Paper in the first pack before starting on the second pack.

• When you have finished with the first pack, archive each Notebook from the first pack and then start using the
second pack.

Using Special Paper Products
In addition to standard notebooks and journals, Livescribe sells special Livescribe Dot Paper products, including
Sticky Notes, Sound Stickers, and others.
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About Livescribe Sticky Notes
Livescribe Sticky Notes take the familiarity and convenience of sticky notes—small pieces of paper with a strip
of repositionable adhesive on the back—and add the power of Livescribe Dots.

You can quickly capture short notes, lists, and reminders while adding audio to them. Attach Livescribe Sticky
Notes to any printout, magazine, or book page to add personalized interactive notes. As with other Livescribe
Dot Paper, transfer your Sticky Notes to your desktop computer to organize, search, or share them with others.

Livescribe Sticky Notes come with the familiar Nav Plus and Paper Replay buttons printed along the bottom
edge. Along the top edge, Sticky Notes have additional buttons: Home and Shortcuts.

The Home button stops the current smartpen app and returns you to the default Home display.

The three Shortcut buttons have functionality that you assign to them.

Using Packs and Pads of Sticky Notes

Each pad of Livescribe Sticky Notes contains 75 sheets. Pads are sold in packs of six: three pads of 3”x3” and
three pads of 3”x5”. Use only one Livescribe pack at a time.

Your smartpen can manage up to 6 pads (Sticky Notes 3”x3” Pads 1, 2, 3 and Sticky Notes 3”x5” Pads 1, 2, 3)
at the same time. When you are done with all six pads, archive them with Livescribe Desktop before starting a
new 6-pack. Do not use identical pads from different 6-packs at the same time, because your smartpen recognizes
them as the same pad.

1. Use up all the pads in one pack.

2. Archive the pads.

3. Open a new pack.

Sound Stickers
Sound Stickers are small Livescribe Dot Paper stickers for recording and playing back audio notes.
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There are many uses for sound stickers, particularly in education. Some uses include:

Teacher recordings:

• Books (parent to child, teacher to student, student to student, or celebrity “Read-To-Me” programs)

• Interactive flash cards and flip cards

• Word walls

• Talking tests and quizzes with recorded instructions or questions

Student recordings:

• Fluency/speech assessments and tests

• Annotated art projects, oral reports and book reviews

Each Sound Stickers sheet includes:

• Sound Stickers

• Volume and mute controls

• Controls for managing the stickers, including record audio, delete recordings, and cancel.

Sound Sticker Guidelines
There are some general guidelines to follow when using Sound Stickers.

Your smartpen can support stickers from one pack of Sound Stickers at a time. Please do not use stickers from
multiple sticker packs at the same time, because your smartpen will recognize them as the same stickers.

Sound Stickers feature a strong adhesive and are intended to stay put. For best results, always test one sticker
on the surface material before using.

Sound Stickers have special controls that only work for the stickers. They do not work with other apps, including
Paper Replay. Controls from other Livescribe Dot Paper products, such as record, stop, and jump, will not work
with Sound Stickers.

Installing the Sound Sticker smartpen app

Download and install the Livescribe Sound Stickers app to your smartpen before using Sound Stickers. Visit
http://www.livescribe.com/store for information and other examples.

1. Launch Livescribe Desktop.

2. Dock your smartpen.

3. If prompted, update your smartpen firmware.

4. Go to http://www.livescribe.com/store and download the Sound Stickers app.

5. Use the Livescribe Desktop Application Manager to install the app.
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Recording Audio for a Sticker

1. Tap the Record button to start a recording session.

Your smartpen screen shows “Tap sticker to begin recording.”

2. Tap on a sticker.

Your smartpen screen shows “Begin recording now. Tap sticker again to end recording.”

3. Record the audio for the sticker.

4. Tap the sticker again to end the recording.

Your smartpen screen shows “Recording complete.”

5. You can cancel your changes at any time by tapping on the Cancel button, tapping on Livescribe Dot Paper
page, or tapping on a standard Paper Replay control.

One-Step Recording

You can bypass using the Record button and use tap-and-hold recording instead.

1. Change the One-step recording option in the Advanced Settings menu.

2. Tap and hold on a Sound Sticker for two (2) seconds.

The recording starts.

3. Record the audio for the sticker.

4. Tap the sticker again to end the recording.

Your smartpen screen shows “Recording complete.”

Re-Recording (Over-Writing) Audio

Sound Stickers prohibits recording over an existing recording as a safety precaution. To record over an existing
recording, first delete the recording and then record again.

If you would like to record directly over existing recordings, you can change the Overwriting option in the
Advanced Settings menu.

Playing Back Audio of a Sticker

You can play back, pause, and rewind audio recorded for a sticker.

1. To begin playback, tap on the sticker.

2. To pause playback, tap on the sticker again.

3. To resume playback, tap again.

4. To rewind and start playback from the beginning, double-tap on the sticker.

Deleting Recordings from a Sound Sticker

1. Tap the Delete button.

Your smartpen screen shows “Tap the sticker you wish to delete.”

2. Tap the sticker you wish to delete.

Your smartpen screen shows “Audio for this sticker will be deleted. Tap again to confirm.”

3. Tap the sticker again to confirm.
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Deleted recordings are permanently removed from your smartpen. They are not transferred to Livescribe
Desktop and cannot be retrieved from the smartpen or any other source.

Your smartpen screen shows “Audio deleted.”

Deleting All Recordings from All Stickers
You can delete all recordings from your stickers.

Deleted recordings are permanently removed from your smartpen. They are not transferred to Livescribe Desktop
and cannot be retrieved from the smartpen or any other source.

• Delete the recordings individually for each sticker, or
• Use the Advanced Settings to delete all stickers.

Advanced Settings

You change how you record and delete recordings using the Advanced Settings menu.

1.
Double-tap  on the center of a Nav Plus go to the Main Menu.

2.
Tap down  to locate the Applications menu.

3.
Tap right  to view the first of your Store apps.

4.
Tap down  to scroll through other apps and locate the Sound Stickers.

5.
Tap right  to select and launch it.

6.
Tap down  to the Settings menu. Choose from the available options.

7.
Tap right  and then tap down  to scroll through options.

Options are:

• Turn one-step recording on or off
• Turn overwriting on or off
• Delete ALL stickers

8.
Tap right  to select and change the option.

Smartpen Maintenance and Safety
You should regularly maintain your smartpen and be aware of how to use it safely.

Maintaining Your Smartpen

• Use Livescribe-approved ink cartridges only.

• Carry your smartpen in a protective case.

• Transfer your important notes and Paper Replay sessions from your smartpen to your Livescribe Desktop often
so that you have a backup copy on your computer. Also, backup your computer’s files regularly.

• Keep your smartpen charged. Do not attempt to charge your smartpen via any other means other than:
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The USB mobile charging cradle provided in the box with your Pulse smartpen or the Pro Charging Cradle
accessory, or

•

• The included Micro USB cable or any standard Micro USB cable for the Echo smartpen.

• Clean the infrared camera lens with an alcohol wipe if your smartpen appears sluggish or non-responsive when
you interact with printed controls.

• Regularly clean the exterior of your smartpen with a clean, soft cloth dampened slightly with water.

Storing Smartpens

Below are some recommendations for preparing and storing smartpens when they are not used for a long period
of time.

• Fully charge each smartpen prior to placing them in storage.

• Store smartpens in a location that does is dry and not excessively hot or cold. Excessive heat or cold may
adversely affect the battery performance.

• Keep the accessories with the smartpens so they are not lost.

Reducing Electrostatic Discharge (ESD)

Electrostatic discharge (ESD) can cause damage to electronic devices if discharged into the device. Static
electricity is an electrical charge caused by the buildup of excess electrons on the surface of a material. Even a
small amount of ESD can harm circuitry, so when working with electronic devices, take measures to help protect
your electronic devices from ESD harm.

Any electronic device that contains an external entry point for plugging in anything from cables to docking
stations is susceptible to ESD. Devices that you carry with you, such as your mobile phone, build up ESD in a
unique way because the static electricity that builds up on your body is automatically passed to the device. Then,
when the device is connected to another device such as a docking station, ESD discharge can occur.

Conditions that can contribute to the buildup of static electricity in the environment include the following:

• Low relative humidity.

• Material type. (The type of material gathering the charge. For example, synthetics are more prone to static
buildup than natural fibers like cotton.)

• The speed with which you touch, connect, or disconnect electronic devices.

• While you should always take appropriate precautions to discharge static electricity, if you are in an environment
where you notice ESD, you may want to take extra precautions to protect your electronic equipment against
ESD.

Follow these guidelines to reduce the occurrence of ESD:

• Discharge any built-up static electricity from yourself and your electronic devices before touching an electronic
device or connecting one device to another. Livescribe recommends you take this precaution before connecting
your smartpen to your computer, placing your smartpen in a cradle, or connecting it to any other device.

• Ground yourself when you are holding your mobile device by simultaneously touching a metal surface that
is at earth ground. For example, if your computer has a metal case and is plugged into a standard three prong
grounded outlet, touching the case should discharge the ESD on your body.

• Increase the relative humidity of your environment.

• Install ESD-specific prevention items, such as grounding mats.
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Safety

Caution:

Failure to follow these safety instructions could result in fire, electric shock, or other injury or damage.

The smartpen may be damaged by improper handling or storage.  Do not drop, throw, bend, crush, deform,
puncture or open the smartpen.  Failure to follow these instructions could result in electric shock, fire, personal
injury, property damage or damage to your smartpen, as well as voiding your limited warranty. It is also essential
that you take proper care of the smartpen to ensure its usability.

• Do not drop your smartpen or allow any other kind of strong impact. Doing so can severely damage your
smartpen or prevent it from working properly.

• Do not place your smartpen in any area where it could be crushed (such as a back pocket, bottom of backpack,
and so on.)

• Do not store your smartpen in extreme high or low temperatures. Store it in a cool, dry place.

• Do not expose your smartpen to water or any other liquids. It is not water-proof or water resistant.  Do not
leave it in damp conditions.

• Do not dispose of your smartpen in a fire, as the battery may explode or ignite.Do not dispose of this product
in the trash.  As with any product containing batteries, check with your local waste or recycling company to
determine the correct disposal method and location in your area.

Warnings

Do not attempt to do any repairs yourself.  Do not attempt to open the smartpen, disassemble it, remove the
battery, or attempt to replace the battery yourself. This runs the risk of electric shock, fire, personal injury,
property damage or damage to your smartpen, as well as voiding the limited warranty. There are no
user-serviceable components inside and any attempt to open your smartpen voids the warranty.

Hearing Notice: Long-term exposure to the playback of loud recordings, at high volume, may result in permanent
hearing loss.  When using earbuds or headphones, Livescribe recommends that your listen to recordings at
moderate volumes.  Set the volume to a safe level.  A rule of thumb is that the recorded audio should not be so
loud that you cannot hear people speaking to you.

Do not attempt to access the battery. The rechargeable battery is not accessible and is not intended to be
removed, replaced, or touched.  The battery contents can be hazardous if ingested.  The battery technology is
combustible and only chemical fire retardants or sand should be used to extinguish flames.  Do not use water.
If the battery leaks, do not allow the liquid to come in contact with the skin or eyes.  If it does come in contact
with skin or eyes use large amounts of water to wash the affected area and immediately seek medical advice.

Caution:

Do not mutilate, puncture, or dispose of batteries in fire. The batteries can burst or explode, releasing
hazardous chemicals. Discard used batteries according to the manufacturer’s instructions and in accordance
with your local regulations.

Varning: Eksplosionsfara vid felaktigt batteribyte. Använd samma batterityp eller en ekvivalent typ som.
rekommenderas av apparattillverkaren. Kassera använt batteri enligt fabrikan-tens instruktion.

Advarsel! Lithiumbatteri—Eksplosionsfare ved fejlagtig håndtering. Udskiftning må kun ske med batteri
af same fabrikat og type. Levér det brugte batteri tilbage tilleverandøren.

Varoitus: Paristo voi räjähtää, jos se on virheellisesti asennettu. Vaihda paristo ainoastaan valmistajan
suosittelemaan tyyppiin. Hävitä käytetty paristo valmistajan ohje-iden mukaisesti.
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Advarsel: Eksplosjonsfare ved feilaktig skifte av batteri. Benytt samme batteritype eller en tilsvarende
type anbefait av apparatfabrikanten. Brukte batterier kasseres i henhold til fabrikantens instruksjoner.

Waarschuwing! Bij dit produkt zijn batterijen geleverd. Wanneer deze leeg zijn, moet u ze niet weggooien
maar inleveren als KCA.

Managing Storage on a Smartpen
You can view and manage the data and applications stored on your smartpen.

Viewing Smartpen Storage with the Storage Button

1. Start your smartpen.

2. Open the inside cover of your Livescribe Dot Paper product and locate the Settings area.

3.

Tap the Storage button  once to see amount of remaining storage in megabytes.

4. Tap a second time to see the remaining recording time based on the current audio (recording) quality settings.

If available space is less than 1 MB, your smartpen shows storage in available KB.

If you see the circled exclamation mark indicator on the right side of the display, check your available storage
on the smartpen as it is almost full.

Viewing Smartpen Storage with a Shortcut

1.
Double-tap  on the center of a Nav Plus.

Your smartpen shows the Shortcut indicator in the Main Menu. It is waiting for you to write a Shortcut.

2. Within three (3) seconds, write the word “storage.”

Using its predictive text feature, your smartpen shows the first command that matches your written input In
this case, storage is displayed as soon as you write an “s”. As soon as you see the command you want on the
display, you can stop writing.

79



3.
Tap right  on the Nav Plus, or double-tap on any Livescribe Dot Paper.

If available space is less than 1 MB, your smartpen shows storage in available KB.

If you see the circled exclamation mark indicator on the right side of the display, check your available storage
on the smartpen as it is almost full.

Your smartpen shows the available storage.

When you create a Shortcut, it becomes an active button that you can tap to repeat the application or command.
The same is true for Launch Line Shortcuts you create.

Deleting Audio Recordings from a Smartpen

If you wish to delete sessions from your smartpen for any reason, such as managing storage, we recommend that
you transfer your notes to Livescribe Desktop and then delete Paper Replay sessions from your smartpen.

When you delete a session from the smartpen, your paper notes linked to that file no longer plays back the Paper
Replay audio that was previously linked to that ink. However, as long as you have transferred your notes to
Livescribe Desktop, you can continue to replay your notes from your computer.

Note:

You cannot retrieve a session after you delete it from both the smartpen and Livescribe Desktop. Deleting
sessions does not affect the notes on the smartpen - they remain on the smartpen until you archive the
notebook.

There are various ways to delete Paper Replay sessions from the smartpen:

• Use a Livescribe Desktop to remove the smartpen session.
• Archive your paper product. This removes all Paper Replay sessions from your smartpen for that paper

product.
• Using the Main Menu on the smartpen.
• Using the Delete Current Session shortcut to delete the most-recently accessed session.
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Deleting Audio Recordings from a Smartpen with the Nav Plus

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  to scroll through the apps on your smartpen until Paper Replayis displayed.

3.
Tap right  to launch Paper Replay.

4.
Tap down  to locate Delete session from the menu.

5.
Tap right  to browse sessions.

6.
Tap down  to scroll through a list of sessions.

7. Locate the session to delete.

8.
Tap right  to select it.

9.
Tap right  to confirm deletion.

Your smartpen indicates that the session is deleted.
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Deleting the Current Audio Recording with a Shortcut

You can use a shortcut to delete the current session. In this context, the current session is the most recently
accessed session. This is the last session that was either played or recorded.

1. On any Paper Replay Stop button, tap and hold for three seconds. Your smartpen instructs you to tap again
to delete the current session.

2. Tap Stop again to confirm the deletion.

Smartpen Warranty and Compliance
Livescribe provides a warranty for your smartpen and supports industry compliance standards.

Warranty

LIMITED WARRANTY. Livescribe warrants the smartpen to be free from defects in materials and workmanship
under normal use for a period of one year from the date of original direct or retail purchase.  This warranty is
void if the product has been damaged by accident or unreasonable use, immersion in water, neglect, abuse,
improper maintenance, our other causes not arising out of defects in workmanship or materials of the product.
All warranty claims are subject to: (1) you notifying Livescribe of the warranty claim within the warranty period,
(2) Livescribe verifying the existence of a defect in the product and (3) receipt of valid proof of your purchase
and the date of your purchase. Your exclusive remedy shall be, at Livescribe's option, to have it repaired or
receive a replacement smartpen. Before returning the smartpen, please contact the Livescribe Customer Service
Department for instructions.

In the event that a product under warranty is repaired or replaced, the replacement will be covered under the
original warranty or for 30 days, whichever is longer.  Repair or replacement is your exclusive remedy, and
Livescribe’s exclusive liability, under this warranty.

THE LIMITED WARRANTY SET FORTH HEREIN IS THE ONLY WARRANTY MADE TO YOU AND
IS PROVIDED IN LIEU OF ANY OTHER WARRANTIES (IF ANY) CREATED BY ANY
DOCUMENTATION OR PACKAGING. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL
RIGHTS.

DISCLAIMER OF WARRANTIES. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF
THE Livescribe Desktop SOFTWARE, smartpen AND OTHER PRODUCTS AND SERVICES IS AT YOUR
SOLE RISK AND THAT THE ENTIRE RISK AS TO SATISFACTORY QUALITY, PERFORMANCE,
ACCURACY AND EFFORT IS WITH YOU. EXCEPT FOR THE LIMITED WARRANTY SET FORTH
ABOVE AND TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE Livescribe
Desktop SOFTWARE, smartpen, PRODUCTS AND SERVICES ARE PROVIDED “AS IS”, WITH ALL
FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND LIVESCRIBE AND LIVESCRIBE'S
LICENSORS (COLLECTIVELY REFERRED TO AS “LIVESCRIBE”) HEREBY DISCLAIM ALL OTHER
WARRANTIES AND REPRESENTATIONS, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING,
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BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, OF SATISFACTORY
QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET ENJOYMENT,
AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS. LIVESCRIBE DOES NOT WARRANT AGAINST
INTERFERENCE WITH YOUR ENJOYMENT OF THE Livescribe Desktop SOFTWARE, smartpen,
PRODUCTS OR SERVICES, THAT THE FUNCTIONS CONTAINED IN THE Livescribe Desktop
SOFTWARE, smartpen, PRODUCTS OR SERVICES WILL MEET YOUR REQUIREMENTS, THAT THE
OPERATION OF THE Livescribe Desktop SOFTWARE, smartpen OR SERVICES WILL BE
UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE Livescribe Desktop SOFTWARE,
smartpen OR SERVICES WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR ADVICE
GIVEN BY LIVESCRIBE OR ANY LIVESCRIBE AUTHORIZED REPRESENTATIVE SHALL CREATE
A WARRANTY. SHOULD THE Livescribe Desktop SOFTWARE, smartpen, OR SERVICES PROVE
DEFECTIVE, YOU ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR
CORRECTION.

LIMITATION OF LIABILITY. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT SHALL
LIVESCRIBE BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, DAMAGES
FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY OTHER COMMERCIAL
DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR USE OR INABILITY TO USE THE
Livescribe Desktop SOFTWARE, smartpen, OR SERVICES, HOWEVER CAUSED, REGARDLESS OF THE
THEORY OF LIABILITY (CONTRACT, TORT OR OTHERWISE) AND EVEN IF LIVESCRIBE HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. In no event shall Livescribe's total liability to you
for all damages (other than as may be required by applicable law in cases involving personal injury) exceed the
amount of fifty dollars ($50.00). The foregoing limitations will apply even if the above stated remedy fails of
its essential purpose.

Agency Compliance Information

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1)
this device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

US FCC Statement

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions: (1)
This device may not cause harmful interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

• The use of shielded I/O cables is required when connecting this equipment to any and all optional peripheral
or host devices. Failure to do so may violate FCC rules. Shielded I/O cables are available for the smartpen
from Livescribe.
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Changes or modifications not covered in this Guide must be approved in writing by the manufacturer’s Regulatory
Engineering Department. Changes or modifications made without written approval may void the user’s authority
to operate this equipment.

Responsible Party:

Livescribe Inc

7677 Oakport Street, 12th Floor

Oakland, CA  94621

United States of America

(510) 777-0771

Canadian, Industrie Canada ICES-003 Statement

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur le matériel brouilleur du
Canada.

CE Declaration of Conformity

Manufacturer and EU Responsible Party:

Livescribe Inc.

7677 Oakport Street, 12th Floor

Oakland, CA  94621

United States of America

(510) 777-0771

This product was tested by Livescribe Inc. and found to comply with all the requirements of the EMC Directive
2004/108/EC and of the LVD Directive 2006/95/EC.

This device conforms to the following standards:

EN 55022 (1998); CISPR 22  as amended, (Class B Radiated and Conducted Emissions)

EN 55024 (1998); CISPR 24 as amended, (Emissions and Immunity, as applicable)

EN60950-1 and IEC 60950-1, Information technology equipment. Safety.

REACH Regulation

REACH is the Regulation for Registration, Evaluation, Authorisation and Restriction of Chemicals, which went
into effect on June 1, 2007 to streamline and improve the former legislative framework for chemicals of the
European Union (EU).

Thresholds and Substances of Very High Concern (SVHC) are defined in Article 7 and 57 of Regulation (EC)
No 1907/2006 of the European Parliament and of the Council of 18 December 2006. The Echo smartpen has
been tested to comply with the thresholds and substances of very high concern restrictions as defined by the
European Chemicals Agency (ECHA).
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ROHS Compliance Statement

Livescribe has determined that this product complies with the requirements of the Restriction of Hazardous
Substances (ROHS) directive 2002/95/EC and its amendments. For additional information, contact Livescribe
at the address above.

UL

Use only with Listed ITE.

This device conforms to the following standards: UL60950-1, First Edition
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Smartpen Apps User Guide

Using the Smartpen Calculator Card
A popular Store application is the Calculator Card, which is available for purchase from the Livescribe Online
Store: http://www.livescribe.com/store and as a redeemable app card from retailers that carry Livescribe products.

About the Calculator Card

The calculator card is similar to the printed calculator on many Livescribe Dot Paper. It performs basic math
functions, as well as many useful scientific functions. The back side of the card also provides standard Paper
Replay and status controls. To use the calculator, tap on the printed keys with the tip of your smartpen.

Using the Paper Tablet
The Livescribe Paper Tablet app is available for purchase from the Livescribe Online Store:
http://www.livescribe.com/store and as a redeemable app card from retailers that carry Livescribe products.

About the Paper Tablet App

The Livescribe Paper Tablet enables your Echo smartpen to work as an input device on your computer. Similar
to a graphics tablet, the Paper Tablet lets you use your Echo smartpen as a mouse and turns your Livescribe Dot
notebooks into an extension of your computer screen.

You connect your smartpen to your computer using its micro-USB cable and use it like a stylus on Livescribe
Dot Paper. Use the Paper Tablet to mark up slides, presentations, PDFs, documents and spreadsheets, quickly
and easily.
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When you hover the tip of your smartpen over a notebook page, you can control your computer’s cursor on
screen. You can also tap to click and drag to draw, and write or draw within apps that support graphics tablet
interfaces, such as Microsoft PowerPoint.

Although the Paper Tablet functions much like a graphics tablet, it does not provide features like
pressure-sensitivity and assignable stylus buttons. Also, if you have a dual monitor system, the Paper Tablet
controls the cursor on the primary monitor only.

Typical users of Paper Tablet include:

• Presenters: Anyone who presents hand-written information via a projector or online.

• Editors: Anyone who annotates (marks up) electronic documents.

• Collaborators: People who work together using online collaboration tools or screen sharing and would benefit
from drawing, sketching, or annotating.

• Signers: Individuals who want to insert their signature in electronic documents.

Absolute Positioning
The Paper Tablet works as an absolute positioning device. This means that fixed coordinates on your notepad
map to fixed coordinates on your computer screen.

Computer mice are pointing devices that use relative positioning. Mice indicate their position in relation to their
previous positions. For example, if you drag your mouse, the cursor moves relative to where it started. If you
then pick up your mouse, and place it somewhere else on your mouse pad the cursor does not move. You need
to drag the mouse to a new relative position to move the cursor.

The Paper Tablet works as an absolute positioning device. This means that fixed coordinates on your notepad
map to fixed coordinates on your computer screen. For example, when you touch the bottom left corner of your
notebook page with your smartpen, the cursor moves to the bottom left corner of the screen. If you then move
your smartpen to a different location on your notebook page, the cursor moves to the corresponding location on
your screen.
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System Requirements

Livescribe Paper Tablet requires:

• An Echo smartpen with micro-USB cable, with smartpen firmware version 2.5 or higher

• Livescribe Desktop version 2.3 or higher: only required to install the Paper Tablet app.

• Either a PC running Windows® XP with SP3, Windows® Vista (32-bit only), Windows® 7 (32-bit or 64-bit),
or an Intel-based Mac with Mac OS® X 10.5.5 or higher

Important:

The Paper Tablet is not compatible with the Mac OS version of Adobe Photoshop. Functional limitations
exist when using Windows or Mac OS version of Adobe Illustrator, and Windows version of Adobe
Photoshop. Specifically, the Tablet Pen cannot work properly with the Tools Panel.

Note:

The Paper Tablet works on Echo smartpens only.

Windows XP does not include special inking functions for Microsoft Office that are standard in Windows
Vista and Windows 7.

Installing Livescribe Paper Tablet

1. Purchase the Livescribe Paper Tablet from the Livescribe Online store:http://www.livescribe.com/store. If
you purchased a Paper Tablet retail app card from a store, redeem your purchase on the Livescribe Online
store by entering the redemption number on the card.

2. Launch Livescribe Desktop (version 2.3 or higher) and dock your Echo smartpen.

3. Accept any requests to update your smartpen firmware. Your smartpen firmware is updated to version 2.5
or higher, and includes the Paper Tablet app.

4. Launch the Paper Tablet.
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Launching Livescribe Paper Tablet

As with other smartpen apps, you can launch the Livescribe Paper Tablet using the Nav Plus menu or Launch
Line. See the Smartpen User Guide for details about these commands.

Launching Livescribe Paper Tablet with Launch Line

Using Launch Line, you can quickly launch the Livescribe Paper Tablet app.

1. With no other apps running, draw a horizontal line on your notebook (starting from right or left) and without
removing your smartpen tip from the page, immediately double back on the line ending close to where you
started.

2. Immediately begin writing the word Tablet above the line.

As you write the first few letters, look at your smartpen screen. If it shows the “Tablet” command, double-tap
anywhere on the page to run it. You do not need to finish writing the whole command name.

3. Tap a page to use as your Tablet Page.

When you tap a page to select it, it uses the default page orientation for the paper product. Usually, this is
portrait mode. If you want to change the orientation, instead of tapping the page, draw a short vertical line
in the desired orientation.

To launch the Paper Tablet at a later time, tap on the Launch Line name. The name remains as an active
“button” that you can tap at any time to launch the app.

While Tablet mode is active, you can still use other smartpen apps and functions.

Launching Livescribe Paper Tablet from the Nav Plus

1. Connect your Echo smartpen to your computer using its micro-USB cable.

2.

Double-tap  on the center of a Nav Plus to go to the Main Menu.

3.
Tap down  to scroll to the Applications menu.

4.
Tap right  and then tap down  until you locate the Tablet menu item.

5.
Tap right  to launch the Paper Tablet.

6. Tap a page to use as your Tablet Page.

When you tap a page to select it, it uses the default page orientation for the paper product. Usually, this is
portrait mode. If you want to change the orientation, instead of tapping the page, draw a short vertical line
in the desired orientation.
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Stopping the Paper Tablet

•
From the Main Menu, navigate to the Tablet app and Tap right  on Stop Paper Tablet.

The Paper Tablet mode turns off automatically when any of the following occur:

• You turn off your smartpen. As long as the smartpen is connected to the computer, Paper Tablet does not
shut off automatically.

• You turn off your computer

• You unplug the cable connecting the smartpen to the computer

Setting Up Tablet Pages

The Paper Tablet works using your smartpen as the pointer stylus and one or more Tablet Pages as the tablet.
Most Livescribe pages can become Tablet Pages.

Activating a Tablet Page

1. Launch the Paper Tablet.

2. When prompted by your smartpen, draw a short vertical line (approximately 1 inch or 25 mm) from top to
bottom to indicate the desired page orientation.

Or, to accept the default page orientation, tap anywhere on the page to activate it.

3.
To activate more Tablet Pages, Tap left  and then tap down  until you reach the Activate Page menu.

4.
Tap right  then tap or draw a vertical line on another notebook page to select it.

A Tablet Page functions until you deactivate it using the smartpen Deactivate Page menu.

You can continue to use a Tablet Page like other pages in your notebook. For example, you can use it for
Paper Replay or other smartpen apps.
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Optionally, mark your Tablet Page to indicate the page boundaries of your monitor screen. Hover over the
Tablet Page and locate each of the four corners of your monitor screen. Draw a small mark on the page at
each position.

Using the Activate Page Shortcut
You can also use a Shortcut to specify a Tablet Page.

This is useful when you are in the middle of using the Paper Tablet and want to activate to a new Tablet Page.

1. With no other apps running, draw a horizontal line on your notebook (starting from right or left) and without
removing your smartpen tip from the page, immediately double back on the line ending close to where you
started.

2. Immediately begin writing the words “activate page” above the line.

As you write the first few letters, look at your smartpen screen. If it shows the “activate page” command,
double-tap anywhere on the page to run it. You do not need to finish writing the whole command name.

3. To activate a Tablet Page, draw a short vertical line (approximately 1 inch or 25 mm) from top to bottom on
the page in the desired orientation, or tap it to accept the default orientation.

Specifying Page Orientation

Most monitors are used in landscape mode (they are wider than they are tall). However, most notebooks are
printed in portrait mode (they are taller then they are wide).

By default, Livescribe Dot Paper orients the top of the page to the top of the monitor. To make a Tablet Page
match your monitor more closely, you can change the page’s orientation. Changing the orientation may use more
of the page for the tablet and improve the Paper Tablet resolution.

1. Launch the Paper Tablet.

2. Rotate your notebook 90 degrees so it is wider than it is tall.
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3. When prompted by your smartpen, draw a short vertical line (approximately 1 inch or 25 mm) from top to
bottom to indicate the desired page orientation.

Setting the Tablet Page Aspect Ratio

In some cases, you may want to change the aspect ratio of your Paper Tablet. The aspect ratio determines the
active area of a Tablet Page. By default, the aspect ratio of any Tablet Page is 16:10.

Tip:

The best way to know if the aspect ratio is correct is to experiment with your Tablet Page on your monitor.
Draw a pre-defined shape using a drawing tool such as Microsoft Paint and see if it looks correct. For
example, draw a square and see if it looks like a square. If it does, the aspect ratio is fine. If it looks like
a rectangle, you should try a different aspect ratio.

1. Launch the Paper Tablet.

2.

If prompted by your smartpen to activate a page, instead Tap left  on the Nav Plus.

3.
Tap down  to locate the Settings > Aspect Ratio menu.

4.
Tap right  to choose this option. Tap right  to select Set for one page.

5. Tap the page that you want to change.

6.
Tap right  and then tap down  to find the new aspect ratio. Then Tap right  to select it.

The Paper Tablet supports these aspect ratios:

• 16:10 (default)

• 16:9

• 4:3

• 5:3

• 5:4

• 10:16 (Portrait)

• 9:16 (Portrait)

• 3:4 (Portrait)

• 4:5 (Portrait)

Note:

You can also use this menu to Set the aspect ratio for all pages or Change the default aspect ratio.
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Common Screen Resolution Aspect Ratios

Aspect ratioHeightWidthNameCode

4:3480640Video Graphics ArrayVGA

4:3600800Super Video Graphics ArraySVGA

4:37681024eXtended Graphics ArrayXGA

4:38641152eXtended Graphics Array PlusXGA+

4:39601280Super eXtended Graphics ArraySXGA

4:312001600Ultra eXtended Graphics ArrayUXGA

5:37681280Widescreen eXtended Graphics ArrayWXGA

5:410241280Super eXtended Graphics ArraySXGA

16:97681366High Definition (Basic)HD

16:99001600High Definition (Plus)HD+

16:910801920Full High DefinitionHD-1080

16:108001280Widescreen eXtended Graphics ArrayWXGA

16:109001440Widescreen Super eXtended Graphics ArrayWSXGA

16:1010501680Widescreen Super eXtended Graphics Array PlusWSXGA+

16:1012001920Widescreen Ultra eXtended Graphics ArrayWUXGA

Adjusting Active Areas for Mac OS X

Windows and Mac OS X computers manage screen locations differently. This difference affects the active areas
on Livescribe Dot Paper. If you are using a Mac, you can adjust the active areas to improve the mapping between
Tablet Pages and your monitor.

1. Launch the Paper Tablet.

2.
Tap down  to locate the Settings option.

3.
Tap right  and then tap down  to locate the MacOS option.

4.
Tap right  to activate the option.

Once set, the MacOS option remains active unless you deactivate it. If you want to use your smartpen on a
Windows computer, revisit this menu and deselect MacOS.

93



Removing a Tablet Page

You may want to remove (deactivate) a Tablet Page so you can write on it and not affect your computer’s cursor.

1. Launch the Paper Tablet.

2.
Tap down  to find the Deactivate Page menu. If prompted by your smartpen to activate a Tablet Page,

first tap left  and then tap down  to find the Deactivate Page menu.

3. Tap a page to deactivate it.

Learning Paper Tablet Basics

1. Launch the Paper Tablet and specify a Tablet Page.

2. The top area of a Tablet Page is its active area. The active areas vary depending on the Livescribe Dot Paper
you are using.

3. Hold your smartpen just above the page (but not touching it).

This is called hovering. Move your smartpen to see the cursor move on the screen.

4. Tap the smartpen on the paper.

This is the same as left-clicking a mouse.

5. Tap and draw a line to perform a mouse click-drag function.

6. After starting the Paper Tablet, you can use other smartpen apps and continue to use your smartpen as your
mouse. For example, to record your notes using Paper Replay, tap the Record button on any notebook page.
Your notes are saved by Paper Replay, and your smartpen continues to control your computer cursor.
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Tips for Using the Paper Tablet

Unlike a mouse, the Paper Tablet works as an absolute positioning device. Each spot on your page corresponds
to a position on your computer screen. Because of this design, when you hover the smartpen close to a page, the
computer cursor jumps to the new position on the screen corresponding to the location on the Tablet Page. This
is expected behavior for absolute positioning devices, but is different from relative positioning devices like your
computer mouse.

When you hover your smartpen tip on a Tablet Page and then tap to perform a mouse click, the cursor on your
screen may appear to move on the screen (usually downward). This effect is related to the parallax effect, in
which the apparent position of the smartpen tip from your point of view is different from the point of view of
the camera in the smartpen tip. The camera is “seeing” a slightly different set of coordinates (position on the
page) than you are.

In general, to minimize the jumping effect of your cursor, follow these guidelines:

• Use the largest available notebook for your Tablet Page. Using a larger piece of paper improves the Paper
Tablet resolution.

• Set your computer’s double-click speed to slow.

• Before tapping, move your smartpen very close to the page.

• When tapping, hold your smartpen in an upright position, perpendicular to the page surface. Or, if you are
holding your smartpen at an angle, tap by moving your smartpen in the direction of the smartpen tip at the
same angle. This follows the point of view of the smartpen camera.

Right-Clicking with the Paper Tablet

By default, tapping on a page is the same as a left-click on a mouse. To right-click, you can either tap and
hold, or create and use a right-click button.

Right-Clicking with Tap and Hold

1. Hover over an active area of a Tablet Page.

2. Tap and hold on the page for a few seconds to initiate a right-click command.

Right-Clicking with a Right-Click Button

1. Launch the Paper Tablet.
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2.

Tap down  to locate the Right-Click Button option, then tap right .

3. Follow the instructions on your smartpen to draw a right-click button.

Livescribe recommends you draw this button outside the active area of a Tablet Page.

4. After drawing the button, tap on it to activate the right-click feature.

5. Tap anywhere on a Tablet Page to initiate a right-click command. You can use this button repeatedly to
initiate right-clicks.

Using Paper Tablet with Other Apps

This topic describes how to use Paper Tablet with several apps.

Working with Microsoft Office Products
Many Microsoft products support some form of inking capabilities. This topic describes how to use these features.

Note:

For Windows Vista and Windows 7, some apps provide inking commands only if the computer is enabled
for inking, and if an inking device, such as the Echo smartpen, is connected.

Working with Microsoft PowerPoint for Windows

1. Open your PowerPoint document.

2. Start a Slide Show.

3. Right-click anywhere on the current slide and choose Pointer Options. Choose a pen type: Ballpoint Pen,
Felt Tip Pen, or Highlighter.

4. Optionally, choose an ink color using the Ink Color menu.

5. Begin drawing on your slides.

6. When finished, quit the Slide Show.

7. You are prompted to save your annotations. Click Keep to save all the your annotations. The annotations
are saved as new objects that you can move, resize, or delete.
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Working with Microsoft PowerPoint for Mac

1. Open your PowerPoint document.

2. Start a Slide Show.

3. Control-click anywhere on the current slide and choose Pointer Options. Choose Pen.

4. Optionally, choose an ink color using the Ink Color menu.

5. Begin drawing on your slides.

6. When finished, quit the Slide Show.

On the Mac, you cannot save ink to a PowerPoint slide. The feature is for presentation only.

Enabling Special Inking Features in Windows 7 and Vista

If you are running Windows 7 or Vista, you can also use special inking features available in certain Microsoft
Office apps (Word, Excel, Outlook).

1. Ensure that no Microsoft Office apps are running.

2. Dock your Echo smartpen.

3. Start one or more Office apps. Special inking features enable automatically for each app you start.

Working with Microsoft Word and Excel

1. Open a Word or Excel document.

2. Under the Review tab, choose Start inking.

3. Begin drawing.

4. When finished, choose Close ink tools, Select objects, or press the ESC key.

Working with Microsoft Outlook

1. Open a message.

2. Under the Message tab, choose Start inking.

3. Begin drawing.

4. When finished, choose Close ink tools or Select objects.

Using Online Collaborative Apps
This topic describes using the Paper Tablet with several popular online collaborative apps.

Using Dabbleboard

1. Go to http://www.dabbleboard.com.

2. Click Get Started.

3. In the Share and Chat dialog, click Invite Others.

4. In the Invite Others dialog, send a link to your drawing. Either enter a collaborator’s email and click Email,
or click Copy Link and send the link using email, an instant messaging tool, or other method.

5. Click the top left button and choose Clear canvas.

6. Close the Share and Chat window.

7. On the Dabbleboard drawing page, click the Freehand button.

8. Start drawing. You and your collaborator see each other’s work.
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You or your collaborator can click Insert document or Insert image to upload it. Then each of you can draw on
top of it.

Using Skype iDroo

IDroo is an online educational multiuser whiteboard for Skype.

1. Go to http://www.idroo.com.

2. Click the Download button to install the app.

3. Double-click iDroo shortcut on your desktop.

4. Open Skype and click Allow access so iDroo can use your contact information.

5. Close the About iDroo window.

6. Click the + button in the Participants window to add new users to the board.

7. Choose one or more participants and click Add. Click OK.

8. Begin drawing on the board.

Using Cisco® WebEx® Meeting Center

1. Using an existing Cisco® WebEx® account, host or join a WebEx meeting.

2. From your webex.com page, click the down-arrow to the right of the Share my desktop button.

3. Select app to share, such as Microsoft PowerPoint or Dabbleboard in a browser window.

4. Begin drawing in the shared app using its inking features.

Using Adobe® Connect

1. Create an Adobe® Connect account and log in.

2. Click Create new meeting at the top of the page.

3. Fill out the meeting form and click Next.

4. Add meeting participants and click Next.

5. Send the meeting invitations and click Finish.

6. Click Enter meeting room.

7. When the meeting screen opens, choose to share your desktop, a specific document, or a whiteboard. For a
whiteboard, click on the bottom-right button to open a whiteboard tools menu. Select the pencil at the top of
the menu.

8. Begin drawing in the shared document or whiteboard.

Adding an Ink Signature to Documents

You can use the Paper Tablet to sign documents that support handwritten ink, including Microsoft Word and
Adobe Acrobat PDF. When signing a document electronically, it is important to understand the legal implications.

Signing a document using the Paper Tablet or other digital ink device is similar to annotating a document. This
is called an ink signature and is not the same as a digital signature. An ink signature does not necessarily make
the signature legally binding. In fact, in many cases, it does not. However, signing a document this way may
help the document appear more personal to the recipients.

Adding an Ink Signature to Adobe Acrobat PDF Documents

1. Open the document in Acrobat Pro 8 or higher or Acrobat Reader 9 or higher.

2. Click the Pencil icon to activate the pencil tool.
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3. Hover to the place on the page where you want to sign.

4. Write your signature.

5. Save the document to include the signature with it.

There are other tools and plug-ins you can use to sign PDF documents, such as PDF-XChange Viewer. You
can find these tools by searching the internet for “signing a PDF”.

Adding an Ink Signature to Microsoft Word or Excel Documents
If you are running Windows 7 or Vista, you can add a signature to Microsoft Word and Excel documents.

1. Open a Word or Excel document.

2. Under the Review tab, choose Start inking.

3. Hover to the place on the page where you want to sign.

4. Write your signature.

5. When finished, choose Close ink tools, Select objects, or press the ESC key.

6. Save the document to include the signature with it.

About Digital Signatures
A common approach for signing legal agreements and contracts is to apply a digital signature to a document.
A digital signature is used to authenticate or certify a document. A digital signature can include a visible ink
signature, but usually does not require one.

In many cases, certifying a document is legally binding, although some organizations do not accept
digitally-certified signatures. Digitally signing a document usually requires third-party software to set up private
and public keys for the signer of the document and a certification process for the document being signed. Several
companies provide digital certification services, tools, and plug-ins for this purpose.

Digital certification is a complex topic and beyond the scope of this guide. For more information about digitally
signing documents, search the Microsoft Office and Adobe Acrobat Help for “digital signatures”.

Working with Evernote

1. Download the Windows Evernote desktop client from the Evernote website.

2. Launch the Paper Tablet

3. Go to your Evernote web page.

4. Click on the “Ink Note” button

5. Tap on the note once to turn on the pencil and set pen to paper to draw.

Using the Smartpen English Dictionary
The smartpen English Dictionary is available for purchase from the Livescribe Online Store:
http://www.livescribe.com/store.

About this Dictionary App

This English Dictionary app is based on the American Heritage® Desk Dictionary, Fourth Edition from Houghton
Mifflin.

This Dictionary app features American English and includes:

• 70,000 entries, and provides audio for over 28,000 words.
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• More than 1,000 new meanings, from bioreserve and domestic partner to MP3 and zine.

• Expert guidance on correct English usage.

• Synonyms, regional notes, etymologies, and more.

More about the American Heritage® Spanish Dictionary

This app uses a similar structure and content as the printed and eReference versions of the American Heritage®

Spanish Dictionary. For more information about this dictionary, follow these links:

• Using the dictionary: Guide to Using the Dictionary

• Spanish verb conjugations: Spanish Verb Table

App Map

The map below shows the basic menu structure of this app.

Using the App

This app allows you to write a word with your smartpen, and then view the word’s definition, or scroll through
an alphabetical list to select another word.

There are three ways to look up a word:

• Launch the app from the Main Menu. When launched, the app defaults to Word Lookup mode, which prompts
you to Write a word.

• Use the Nav Plus within the app to navigate to Word Lookup mode. You are prompted to Write a word.
• While browsing the Dictionary List, simply move to another line on the page, and write a word; the smartpen

attemptd to look up the word.

Launching the App

You can launch the app by tapping a previously-looked-up word, or with the Nav Plus, from the app menu.

1.

Double-tap  on the center of a Nav Plus to go to the Main Menu.
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2.
Tap down  to scroll to the Applications menu.

3.
Tap right  and then tap down  to scroll through your apps and locate the Dictionary.

4.
Tap right  to launch the app. The smartpen shows Write a word.

Using the Dictionary Lookup Feature

After launching the Dictionary app, you can look up words by writing them in your notebook.

Write an entire word

1. Write a word in your notebook.

As you write, the smartpen screen shows the closest match to a word in the Dictionary List. As you write
more letters, the screen updates to include those letters. If no match can be found, the smartpen screen shows
not found.

You must write in a horizontal direction. The smartpen cannot interpret vertically-written text.

2.
To move to the Definitions List for the word on the screen, Tap right  on the Nav Plus or double tap on
the page. To scroll to other words in the Dictionary List, tap up or down.

If your written entry is not found in the Dictionary List, the smartpen places you in the list at the point,
alphabetically, where it would belong. You cannot tap right from an entry that is not found, because there
are no definitions to display. However, you can tap up or down to scroll from that point in the list.

3. If an audio pronunciation exists for the entry, it plays automatically.

To see additional definitions (if any exist) for the current entry, Tap down .
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4.
Tap left  to return to Dictionary Lookup mode, and write a new word or part of a word to look up another
entry.

You must be in Dictionary Lookup mode for the smartpen to look up what you write; if you try to write a
word while in the Definitions List, nothing happens.

Write part of a word

1. Write the first few letters of the word in your notebook.

The smartpen screen shows the closest match to the word in the Dictionary List, and updates after each letter
you write. If no match can be found, the smartpen screen shows not found.

You must write in a horizontal direction. The smartpen cannot interpret vertically-written text.

2.
To move to the Definitions List for the word on the screen, Tap right  on the Nav Plus or double tap on
the page. To scroll to other words in the Dictionary List, tap up or down.

If your written entry is not found in the Dictionary List, the smartpen places you in the list at the point,
alphabetically, where it would belong. For example, if you write biol, the smartpen would display biological
… You cannot tap right from an entry that is not found, because there are no definitions to display. However,
you can tap up or down to scroll from that point in the list.

3. If an audio pronunciation exists for the entry, it plays automatically. To see additional definitions (if any

exist) for the current entry, Tap down .
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4.
Tap left  to return to Dictionary Lookup mode, and write a new word or part of a word to look up another
entry.

You must be in Dictionary Lookup mode for the smartpen to look up what you write; if you try to write a
word while in the Definitions List, nothing happens.

Pronunciation Key

You can consult the Pronunciation Key for more information about the pronunciation symbols used in the
included definitions. Use the Nav Plus to launch the Dictionary app and navigate to the Pronunciation Key list.
Then scroll through the list to see the entries.

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  to scroll to the Applications menu.

3.
Tap right  and then tap down  to scroll through your apps and locate the Dictionary.

4.
Tap right  to launch the Dictionary app.

The Dictionary launches Dictionary Lookup mode and shows Write a word.

5.
Tap left  to return to the Dictionary menu.

6.
Tap down  until you reach Pronunciation Key.

7.
Tap right  to enter the list. The smartpen shows the first entry in the list.
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8.
Tap down  to scroll through the list of pronunciation symbols.

Abbreviations Used

You can consult the Abbreviations Used for more information about the language abbreviations used in the word
etymologies found in some definitions. Use the Nav Plus to launch the Dictionary app and navigate to the
Abbreviations Used list. Then scroll through the list to see the entries.

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  to scroll to the Applications menu.

3.
Tap right  and then tap down  to scroll through your apps and locate the Dictionary.

4.
Tap right  to launch the Dictionary app.

The Dictionary launches Dictionary Lookup mode and shows Write a word.

5.
Tap left  to return to the Dictionary menu.

6.
Tap down  until you reach Abbreviations Used.

7.
Tap right  to enter the list. The smartpen shows the first entry in the list.
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8.
Tap down  to scroll through the list of pronunciation symbols.

Tips and Tricks

Flick and Scrub Scrolling

You may find it useful to use the Flick and Scrub feature of your smartpen to quickly scroll through dictionary
content. For details on setting up and using this feature, see the Navigating chapter of the smartpen User Guide.

Look Up a New Word

After writing part of a word while browsing the Dictionary List, you may find that you want to quickly jump to
a different part of the list. You can do this by simply moving to a new line and writing new letters or a new word.
The smartpen ignores what you had previously written and move to a point in the Dictionary List that matches
your new entry.

Homographs

These are words that are identical in spelling, but which constitute separate entries. These are indicated with
superscript numbers. For example, wind1 and wind2. When you look up a word that has homographs, they appear
as separate entries for that word in the Dictionary List.

Using the Smartpen Spanish Dictionary
The smartpen Spanish Dictionary is available for purchase from the Livescribe Online Store:
http://www.livescribe.com/store.

About this Dictionary App

This English Dictionary app is based on the American Heritage® Desk Dictionary, Fourth Edition from Houghton
Mifflin.

This Dictionary app features American English and includes:

• 70,000 entries, and provides audio for over 28,000 words.

• More than 1,000 new meanings, from bioreserve and domestic partner to MP3 and zine.

• Expert guidance on correct English usage.

• Synonyms, regional notes, etymologies, and more.

More about the American Heritage® Spanish Dictionary

This app uses a similar structure and content as the printed and eReference versions of the American Heritage®

Spanish Dictionary. For more information about this dictionary, follow these links:

• Using the dictionary: Guide to Using the Dictionary

• Spanish verb conjugations: Spanish Verb Table
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Using the App

This app allows you to write a word with your smartpen, and then view the word’s definition, or scroll through
an alphabetical list to select another word.

There are three ways to look up a word:

• Launch the app from the Main Menu. When launched, the app defaults to Word Lookup mode, which prompts
you to Write a word.

• Use the Nav Plus within the app to navigate to Word Lookup mode. You are prompted to Write a word.
• While browsing the Dictionary List, simply move to another line on the page, and write a word; the smartpen

attemptd to look up the word.

Creating Hand-Drawn App Buttons

The easiest way to use this app is to create paper buttons for commonly-used commands. You can create buttons
for:

• English->Spanish: Tapping this button launches the app to translate from English to Spanish.

• Spanish->English: Tapping this button launches the app to translate from Spanish to English.

• Conjugation: Tapping this button launches the app to look up Spanish verb conjugations.

• Audio: Plays back audio for translations that have audio.

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  to scroll to the Applications menu.

3.
Tap right  and then tap down  to scroll through your purchased apps and locate the Spanish Dictionary.

4.
Tap right  to launch the app. The smartpen shows the top of the menu list for the app.
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5.
Tap down  until you reach the Setup menu. Then, Tap right  to start the setup instructions.

Be sure your smartpen is not muted to hear the instructions.

6. Follow the instructions to draw the four buttons. After creating these, you can use them at any time to launch
the dictionary and invoke the corresponding commands.

Launching the App

You can launch the app by tapping a previously-looked-up word, or with the Nav Plus, from the app menu.

1.

Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  to scroll to the Applications menu.

3.
Tap right  and then tap down  to scroll through your apps and locate the Dictionary.

4.
Tap right  to launch the app. The smartpen shows Write a word.

Using the Word Lookup Feature

After launching the app from a hand-drawn button or the Nav Plus menus, you can look up words by writing
them in your notebook.

1. Write a word in your notebook.

You must write in a horizontal direction. The smartpen cannot interpret vertically-written text.
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The smartpen screen shows the first dictionary translation of the word.

2. If audio is available for the translation, the smartpen shows a note symbol  on the right side of the display.

To listen to the audio, Tap right . Alternatively, tap the Audio button you created during setup.

If you are translating from English to Spanish, the audio is the Spanish translation. If you are translating from
Spanish to English, then the audio is the word you looked up.

3.
To see additional translations, Tap down .

4. Tap up to reach the top of the dictionary entry. The display shows the word followed by the total number of
translations.

5. The definitions for each main entry are grouped by their part of speech. Headers for each part of speech are
included within the list of translations, along with the number of translations that correspond to that part of
speech. For example, the word “train” can be a noun or a verb. The display shows there are ten instances of
train as a noun.

6.
Continue to tap down  through the noun translations to reach the Transitive verb summary. For train,

there are ten instances of train as a transitive verb. Tap down  to view these. Continue with this process
to view other parts of speech for the current word.

7.
To translate another word, tap left  to return to the language selection screen, or tap the English->Spanish
button.

8.
Tap right  to re-invoke the “Write a word” command.
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9. Write another word in your notebook to view its translation.

You can tap the word again at any time to invoke the dictionary app and view the word’s translations.

Conjugating Verbs

You can use the dictionary app to view conjugations of verbs.

• Tap on the Conjugations button you created with the Setup menu.

• Use the Nav Plus to launch the dictionary app and navigate to the Conjugations menu.

1.
Double-tap  on the center of a Nav Plus to go to the Main Menu.

2.
Tap down  to scroll to the Applications menu.

3.
Tap right  and then tap down  to scroll through your purchased apps and locate the Spanish Dictionary.

4.
Tap right  to launch the app. The smartpen shows the top of the menu list for the app.

5.
Tap down  until you reach Conjugations.

6.
Tap right  to invoke the “Write a Spanish verb” command.

7. Write the infinitive form of a Spanish verb in your notebook.

The smartpen recognizes and shows the verb.
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8.
Tap down  to view the first conjugation of the verb.

9.
To navigate to different tenses, tap right .

10.
To navigate to different persons (first, second, and third person singular and plural), tap down .

11.
To conjugate another verb, tap up to return to the infinitive. Then tap left  to return to the Conjugations
menu. Or, tap on your hand-drawn Conjugations button.

12.
Tap right  to re-invoke the “Write a Spanish verb” command. Write another verb in your notebook.
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Livescribe Desktop for Windows User
Guide

About Livescribe Desktop for Windows
Livescribe Desktop is software that runs on your computer to view and listen to the content you create and
capture using your Smartpen.

About Livescribe Desktop
With Livescribe Desktop, you can view your notes, listen to your recorded audio, manage apps, and more.

Livescribe Desktop is also a portal to Livescribe Online, where you can upload and share content, purchase new
apps and paper products, and connect to the smartpen user community.  Using Livescribe Desktop, you can:

• Save and search notes, and play back audio recordings from your computer.

• Search your handwritten notes for keywords.

• Organize and manage your notes.

• Export and share your notes and audio recordings.

• Upload notes and audio to your MyLivescribe account.

Installing Livescribe Desktop on Windows
You can install Livescribe Desktop on one or more computers.

System Requirements
Before installing Livescribe Desktop, ensure your computer meets or exceeds the system requirements.

Livescribe Desktop requires:

• A PC running Windows® XP SP3, Windows® Vista (32-bit or 64-bit), or Windows® 7. For Windows XP, you
must install Livescribe Desktop with administrator rights.

• 600MHz CPU or higher

• 300 MB of free disk space

• USB 2.0 port

• Internet connection for software download

Installing Livescribe Desktop for the First Time
If this is the first time you are installing Livescribe Desktop, follow these steps.

Be sure to download and install Livescribe Desktop on the computer where you want your notes and audio to
reside.

1. Verify that your computer meets the software and hardware requirements for Livescribe Desktop.
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2. Download the Livescribe Desktop installer from www.live-scribe.com/install.

3. Open the installer and follow the on-screen instructions to complete the installation. When asked to dock
your smartpen, make sure to use the USB Mobile charging cradle (for Pulse smartpens) or Micro-USB cable
(for Echo smartpens) that came with your smartpen.

Pulse smartpen models that have a power symbol  printed on the power button are only compatible with
USB mobile charging cradles that have SKU: AAA-00012 printed underneath. These cradles come with
these smartpens and are compatible with all smartpen models. Pro Charging Cradles, which ship with Pro
Packs and are also available for individual purchase, are compatible with all Pulse smartpen models.

Authorizing Livescribe Desktop
When you use Livescribe Desktop on a computer for the first time, Livescribe Desktop prompts you to log on
to your Livescribe Online account. After doing so, that installation of Livescribe Desktop is authorized for (or
linked to) your account.

As a Livescribe user, all your Livescribe tools link to each other using the same email address and password.
This means that your smartpen registration, your Livescribe Online account, and your installations of Livescribe
Desktop, all identify themselves to each other using the same email address and password.

You can use Livescribe Desktop on as many computers as you like, and you can use as many smartpens as you
like. Just ensure that when you authorize Livescribe Desktop and register your smartpens, that you use the same
email address and password as your Livescribe Online account.

Uninstalling Livescribe Desktop
You can uninstall Livescribe Desktop from your computer.

1. Choose Start > Settings > Control Panel. In the Control Panel, locate and double-click on Add or Remove
Programs.

The Livescribe Desktop installer prompts you to confirm the removal of the app.

2. Click Yes to proceed.

3. Follow the on-screen instructions to complete the uninstall process.

Upgrading Livescribe Desktop
If you have an older version of Livescribe Desktop running on your computer, follow the steps below to upgrade
it.

Upgrading Livescribe Desktop from Pre-2.1 Versions

If you are upgrading Livescribe Desktop from a pre-2.1 version, follow the steps below. If you are have never
used Livescribe Desktop on this computer, follow the steps in .

Note:

When you launch Livescribe Desktop 2.0 or 2.1, the installer prompts to migrate all existing Livescribe
data on your computer to a new format and location. This is necessary to support new and future features.
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Important:

If you have multiple computers running Livescribe Desktop, be sure to upgrade Livescribe Desktop on
each computer before docking your smartpen to that computer.

1. Undock your smartpen from your computer.

2. Before downloading and running the latest installer, launch your current installation of Livescribe Desktop.

3. When prompted, accept all recommended software updates to Livescribe Desktop. You may need to install
more than one update to get to the latest version.

4. Continue this process by downloading versions of Livescribe Desktop sequentially from
www.livescribe.com/install. When you finish upgrading, you should have the current version of Livescribe
Desktop. To determine the current version numbers, see About This Release on page 8.

5. After upgrading to the latest Livescribe Desktop, dock your smartpen to your computer and wait until your
data is transferred. Follow this process for each smartpen you own.

The version 2.0 and 2.1 installers check to see if you have data from pre-2.0 installations of Livescribe
Desktop. If you do have pre-2.0 data, the installer recommends that you migrate all existing Livescribe data
on your computer to a new format and location. Before the migration process starts, Livescribe recommends
(although does not require) that you back up your data.

6. After migrating your data, download the latest Livescribe Desktop Version installer from
www.livescribe.com/install.

7. Open the installer and follow the on-screen instructions to complete the installation.

Configuring Livescribe Desktop
You can customize the behavior of Livescribe Desktop using its configuration options.

Setting Up Auto-Launch

You can configure Livescribe Desktop to automatically launch when you dock a smartpen. This feature is called
Auto-Launch.

• Check the Auto-launch option in the app tab under Tools > User Settings.

If you disable auto-launch and Livescribe Desktop is not running, docking your smartpen charges it only. It
does not launch Livescribe Desktop or transfer the smartpen content.

Configuring Livescribe Desktop Settings

With the User Settings feature, you can set your preferences for Livescribe Desktop app, the interaction of
Livescribe Desktop with the smartpen, and how you want to show pages in Livescribe Desktop.

To set user preferences:

1. Go to Tools > User Settings

2. Navigate through the tabs to set your preferences as described below.

App Settings

Use the Applications tab to set preferences for the Livescribe Desktop app. Options include:
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• Keeping you logged in to Livescribe Online when you launch Livescribe Desktop.
• Specifying settings if your network uses a proxy server. Contact your system administrator for information

about what settings to use.
• Disabling the Livescribe Desktop startup sound.

Smartpen Settings

Use the Smartpen tab to set preferences for your smartpen. Options include:

• Automatically installing apps and updates to your smartpens instead of manually selecting which to install
and where.

• Enabling Livescribe Desktop to show the library for a particular smartpen by default on startup.

Pages Settings

Use the Pages tab to set preferences for how to show pages in Livescribe Desktop. Options include:

• Hiding blank (empty) pages when viewing thumbnails.
• Choosing screen colors for active ink (ink that has linked audio), inactive ink (ink without audio), and ink

added during audio playback (ink annotations).

About Paper Replay
When you start your smartpen, it is ready to capture anything you write on Livescribe Dot Paper.

Your smartpen captures and stores your notes as digital ink. You can then send your notes to your computer or
other destinations using Livescribe Connect or Livescribe Desktop. When you are taking notes without the need
to record audio at the same time, simply start your smartpen and begin writing.

To record audio as you take notes, use the Paper Replay smartpen app. Using Paper Replay, your smartpen
records audio and links it to what you write. Later, you can tap on any of your notes and hear the audio recorded
from that moment. Each time you use Paper Replay, it stores the information it captures as a Paper Replay
session.

You also can use Paper Replay to record audio only. The resulting audio is a standalone recording not linked to
your notes. This kind of recording is called a paperless session.

You can add notes to any audio recording (even paperless sessions) by playing back pre-recorded audio and
writing as you listen. This process is called annotating and is useful when you need to clarify or expand your
notes by reviewing the audio.

To start and stop a Paper Replay session and control session playback,  use the Paper Replay controls printed
on all Livescribe Dot Paper.

Note:

The Paper Replay printed controls are not page-specific. For example, you can tap the Record button on
one page to start recording, and then tap the Stop button on a different page to stop recording.
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About Paper Replay Sessions

When you begin recording with the smartpen, your smartpen automatically links the audio to anything you write
on Livescribe Dot Paper. The recorded audio (and any linked written notes) is called a Paper Replay session.

Important facts about sessions:

• Notes not linked to audio are just notes. They are not part of a session.

• A session always contains audio.

• A session can optionally include written notes (pages) linked to the audio. However, you can record audio
only, known as paperless sessions.

• A session begins when you start recording audio and ends when you stop recording audio.

• Pausing and unpausing a recording does create separate sessions. The paused and unpaused session remains
as one. Starting and stopping recordings creates separate sessions.

• You can have one session that spans multiple pages, such as when taking many notes while recording a long
lecture or meeting.

• Starting and stopping recording multiple times per page creates multiple sessions on that page.

• By default, sessions are named on your smartpen and Livescribe Desktop based on the time and date they are
created. For example, if a session is started on June 03, 2011, at 12:22PM, it is named and displayed as 06.03.11
12:22p.

Viewing Notes and Playing Back Audio In Livescribe Desktop

In Livescribe Desktop, you can view your notes and play back audio recordings made with Paper Replay. In
Livescribe Desktop, notes that have linked audio appear as green ink. Livescribe calls this ink active ink.

To listen to audio recordings that are linked to your notes, click on the active ink using your mouse or other
pointing device. Clicking active ink is similar to tapping your paper notes to begin audio playback on your

smartpen. When you mouse over ink that is active, the mouse cursor changes to a pointing hand cursor to help
you identify where you can click to begin audio playback.

If you annotated your notes (added notes while playing back an audio recording), Livescribe Desktop shows this
ink as blue. This ink is also active. You can click on it to play back the audio at the point where you added the
notes.

Note:

You can change the color of active and inactive ink by setting a user preference.

Livescribe Desktop for Windows Basics
Livescribe Desktop provides views, menus, toolbars, and controls you can use to view and manage notes and
audio transferred from your smartpen.

Running Livescribe Desktop
To run Livescribe Desktop and transfer notes and audio from your smartpen, follow these steps.

When connecting your smartpen to your computer, make sure to use the USB Mobile charging cradle (for Pulse
smartpens) or Micro-USB cable (for Echo smartpens) that came with your smartpen.
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Pulse smartpen models that have a power symbol  printed on the power button are only compatible with USB
mobile charging cradles that have SKU: AAA-00012 printed underneath. These cradles are compatible with all
Pulse smartpen models. Pro Charging Cradles, which ship with Pro Packs and are also available for individual
purchase, are compatible with all Pulse smartpen models.

Note: After you dock your smartpen, do not remove it until the content transfer is complete. Livescribe
Desktop shows a message confirming the transfer is successful and it is safe to undock the smartpen.

Important:  Be sure that your computer does not go into sleep mode during the transfer process. If it
does, undock and redock your smartpen so transfer can restart.

1. On your desktop, double-click the Livescribe Desktop shortcut or go to Start > Programs > Livescribe >
Livescribe Desktop.

If you are upgrading from a pre-2.0 version, Livescribe Desktop migrates all existing Livescribe data on your
computer to a new format and location. This is necessary to support new and future features.

2. Connect your USB mobile charging cradle (for Pulse smartpens) or Micro-USB cable (for Echo smartpens)
to your computer and dock your smartpen.

When you dock the smartpen, do not remove it until the transfer is complete. Livescribe Desktop shows a
message confirming the transfer is successful.

If your smartpen is authorized for the computer you are using, data transfer begins automatically.

3. If prompted, type a name for your smartpen. This is the name that this computer and all other computers you
link to shows when you dock and work with your smartpen. This name is also shown on your smartpen when
you power it on.

4. If you have not registered your smartpen, Livescribe Desktop prompts you to do so. Once you register, you
is able to upload notes, install apps, and create a personal account on Livescribe Online.

5. Click the smartpen selector  in the Main Toolbar to choose which smartpen content
to view in Livescribe Desktop.

Livescribe Desktop shows the Library of notebooks and other paper products that you have used with the
selected smartpen, including your notes and any audio you have recorded. Livescribe Desktop can also shows
details about the selected smartpen, including its memory (storage) usage and apps that can be installed on
it.

When you dock your smartpen to your computer begins transferring content from the smartpen to your computer.
When transferring content to Livescribe Desktop, the original content remains on the smartpen. In this sense,
transferring content actually means copying the content from the smartpen to Livescribe Desktop.

Quitting Livescribe Desktop
To quit Livescribe Desktop, follow these steps.

Quitting Livescribe Desktop ends the connection between your computer and your smartpen. It also disconnects
from Livescribe Online.

• Click the close button at the top right-hand corner of Livescribe Desktop, or
• Choose File > Exit.

Livescribe Desktop Views
To use Livescribe Desktop, you should become familiar with its views and panes.
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Thumbnail View

Thumbnails View is the default Livescribe Desktop view. Livescribe Desktop shows pages as thumbnails.

Single-Page View

Single-Page View shows individual pages.

Click on green ink to play back audio recordings linked to the page.
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Audio View

In Audio View, you can view a list of your audio recordings.

In this view, you can also play back recorded audio, and upload audio to your personal space on Livescribe
Online.

Livescribe Online View

Livescribe Online is your connection to the web. Use this view to manage your personal Livescribe space, share
content with others, and access the Livescribe Online Store.
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Download Manager

The Download Manager is for viewing apps you have downloaded from Livescribe Online, including software
updates and apps your have purchased from the Livescribe Online Store.

Apps Manager

The Apps Manager is for viewing, installing, and uninstalling smartpen apps you have downloaded.
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Central Viewing Pane

The Central Viewing Pane is the central area where you view and interact with your notes. For example, this
pane is where you view your notes and audio recordings. You can also play back audio recordings by clicking
on your notes in this pane.

Navigation Pane

Livescribe Desktop provides a Navigation Pane on the left side of the Central Viewing Pane. The Navigation
Pane lists items that you can navigate to or view in more detail in the Central Viewing Pane. For example,
clicking one of the notebooks in the Navigation Pane opens the notebook and shows all of its pages as thumbnails.

Using the Navigation Pane, you can view your library of notebooks, view pages that contain search results, and
view active audio recordings and optionally upload them to your personal space on livescribe.com. The Navigation
Pane uses tabs to organize its content.

Library Tab

This tab shows your entire library of notebooks, journals, and other paper products you have used with your
smartpen. Use the Library tab to select which notebook you want to view in the Central Viewing Pane. The
Library Tab lists your physical notebooks, custom notebooks, and notebooks you have imported as pencasts.
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Sessions Tab

This tab shows all of the pages of the audio recording currently playing. This tab appears in the Navigation Pane
when you play back an audio recording, either by clicking active ink on page, or by selecting an audio recording
in Audio View and viewing its pages Single-Page View.

Search Tab

This tab shows the pages found using the Search feature. This tab shows the pages found with the search text
highlighted in yellow. This tab appears in the Navigation Pane the first time you initiate a search. The tab's
content refreshes during a search and holds one set of search results at a time. The results remain within the
Search tab until you either initiate another search or close the tab.

Livescribe Desktop Menus and Toolbars
Livescribe Desktop provides menus, toolbars, and controls you can use to view and manage notes and audio
from your smartpen.

Menu

The Menu provides different menu items based on the view you choose. Use these menus to access features of
Livescribe Desktop.

Main Toolbar

The Main Toolbar is located under the Menu. This toolbar provides buttons for the Main views of Livescribe
Desktop. It also provides a messaging area, search field, and pencast/upload features.

Paging Controls

Paging Controls are for paging through notebooks, zooming pages, and toggling between Single-Page and
Thumbnail Views.

Audio Controls

Audio Controls are located at the bottom of the Livescribe Desktop screen. This toolbar is for controlling
playback of recorded audio.

Memory Bar

The Memory Bar in Apps Manager shows the storage state of your smartpen.

Viewing Notes
With Livescribe Desktop, you can view notes transferred from your smartpen.

121



Viewing Page Thumbnails

In Thumbnail View, you can see all your pages at once as thumbnails. When you find the notes you want to
study, you can open them to full size. Optionally, click on green active ink to hear the audio captured with your
notes.

1.

Click the Pages View button  in the Main Toolbar to go to Pages View.

2. Click the Library tab of the Navigation Pane and click the notebook you want to view.

3. Click the Thumbnails button  in Paging Controls, or choose View > Thumbnails from the Main Toolbar.

4. Click the thumbnail to select it.

Use Control-click to select multiple, non-sequen-tial thumbnails.

Use Shift-click to select a sequential set of thumbnails.

Viewing a Single Page

1.
Click the Pages View button  in the Main Toolbar to go to Pages View.

2. Click the Library tab of the Navigation Pane and click the notebook you want to view.

3. In the Central Viewing Pane, click a thumbnail of the page to view.

4. From the Central Viewing Pane, view the page in Single-Page View using one of these methods:

• Double-click the thumbnail of the page you want to view.
• Single-click the thumbnail of the page you want to view and click the Single-Page   button in Paging

Controls.
• Single-click the thumbnail of the page you want to view and choose View > Single Page from the Main

Toolbar.

When you view a single page, the page automatically zooms to fit in the current pane.

Paging through a Livescribe Dot Paper Product

In Livescribe Desktop, you can page through your notebooks and view either single pages or thumbnails. Paging
only shows pages that contain content and skips empty pages.

•
Click the Pages View button  in the Main Toolbar to go to Pages View. Then, use one of the
following methods:

• Type a page number into the page field  and press the Enter key to go to a specific page. Blank
pages are not valid.

• Using Paging Controls, click the next page  button or previous page  button. Or, choose View > Next
Page or View > Previous Page from the Main Toolbar.

• Using Paging Controls bottom of the Central Viewing Pane, click the first page  button or last page 
button. Or, choose View > First Page or View > Last Page from the Main Toolbar.
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Using Paging Controls

Livescribe Desktop provides paging controls. You can use these controls to page through your Livescribe Dot
Paper, go to specific pages, activate Thumbnail or Single-Page View, and zoom into or out of a viewed page.

This toolbar has the following buttons and controls:

First page: Shows the first page in your notebook that contains notes.

Last page: Shows the last page in your notebook that contains notes.

Next page: Shows the next page in your notebook that contains notes.

Previous page: Shows the previous page in your notebook that contains notes.

Current page number: Shows the currently shown page. You can also type a page number in the number field
and press the Enter key to go to that page.

Thumbnail View: Switches Pages View to view pages as thumbnails.

Single-Page View: Switches Pages View to the currently selected thumbnail as a single page.

Zoom slider: Zooms in or out of the current Pages View by moving the slider control.

Zoom out: Zooms out the current Pages View.

Zoom in: Zooms in the current Pages View.

Viewing Pages Linked to an Audio Recording

From Audio View, you can view the pages that have linked audio.

• Click the View Page button  next to the audio recording you want to view.
• Choose the audio recording from the list and choose File > View Pages in the Menu.

Either of these actions switches your view to Pages View and open the Sessions tab of the Navigation Pane,
showing all pages in this audio recording. The first page of the audio recording shows in the Central Viewing
Pane and the audio recording plays back.

Zooming Pages

You can zoom into or out of a selected page or thumbnails.

1. Open the page in Single-Page View or in Thumbnail View.

2. Use one of the following methods to zoom:

• Click the zoom buttons in Paging Controls to zoom in  or zoom out

123



•
Drag the zoom slider  in Paging Controls to zoom in or out of the page.

• Choose View > Zoom In or Zoom Out from the Main Toolbar.

Repositioning a Zoomed Page

When you zoom a page to a size that is larger than the Central Viewing Pane, Livescribe Desktop crops some
of the page. You may want to reposition the page to view its content.

• Reposition using the vertical and horizontal scroll bars in the pane to move the page to your preferred location
in the pane.

• Reposition by hand using the open hand cursor . This cursor replaces the standard arrow cursor when the
page is zoomed to be larger than the current Central Viewing Pane. The open hand cursor appears when you
move over empty areas on the page.

• To move a page, click-and-drag the page to the desired position.

When you move the cursor over active ink, the cursor changes to a pointing hand to identify the active
ink.

Converting Handwritten Notes to Text

You can use MyScript® for Livescribe to convert your handwritten notes to digital text. MyScript for Livescribe
is a desktop app from Vision Objects® that is sold separately (visit www.visionobjects.com).

After you have purchased and installed MyScript for Livescribe, you can export your pages to it using the sharing
dialog of Livescribe Desktop using the With MyScript sharing option.

Copying and Pasting Pages to Other Apps
You can copy your pages to the Clipboard of your operating system (such as Windows® Clipboard) and paste
them into other apps like Microsoft Word®.

Livescribe Desktop saves the content you copy as an image to the Clipboard.

1.
Click the Pages View button  in the Main Toolbar to go to Pages View.

2. Choose a page.

For example, click the page in Thumbnail View or double-click to open it in Single-Page View.

3. Choose Edit > Copy Page > With Background or Without Background.

If you choose to include the background, the copied image includes anything shown on the page of the actual
notebook.

For example, an image from a college-ruled notebook contains ruled lines.

4. Open a document in any app that handles images.

For example, choose Micro-soft Word, most email programs, Microsoft® Paint, and so on.

5. Use the app's Paste feature to paste the copied image into the document.

Livescribe User Guides124

http://www.visionobjects.com


Searching Notes
With Livescribe Desktop, you can search notes transferred from your smartpen.

Searching Pages

You can search notes written in cursive, print, or a combination. Search accuracy depends on the neat-ness and
consistency of your handwriting. The Search command can locate whole words. Your search text can be part of
a word, a whole word, or consecutive words.

1. Type search text into the search text box  in the Main Toolbar.

By default, this search method finds whole words in the currently-selected notebook or journal. For example,
entering “top” would find instances of “top” only. Search would not find other words that contain the letters
“top”, like “topographic”, and “mountaintop”. Search is not case sensitive, so if you search for “Top”, it
returns the same results as “top” and “TOP”.

2. Press the Enter key to initiate the search.

Advanced Searching

1. Click the Search button  in the search text box.

Livescribe Desktop shows the advanced search dialog:

2. Type the search text into the Search dialog. By default, this search method finds whole words in the current
notebook or journal.

To search for partial words, uncheck the Match Whole Word checkbox. For partial word searches, entering
“top” would find “top” and other words that contain the search string like “topographic”, and “mountaintop”.
Because Search is not case sensitive, “Top”, “top”, and “TOP” return the same results.

3. Choose which notebooks to search: the currently-open notebook, all notebooks, or selected notebooks that
you have checked.

4. Click Search to initiate the search.

Viewing Search Results

When you perform a search in the current notebook or journal, Livescribe Desktop searches through all its pages.

When Search finds one or more hits (text matches), it shows the results in the Search tab in the Navigation Pane.
Livescribe Desktop shows thumbnails of the pages where it found the search text. The results remain within the
Search tab until you either initiate another search or close the tab. The Search tab holds one set of search results
at a time.

To view one of the search result pages, click on its thumbnail in the Search tab. This opens the page in Single-Page
View in the Central Viewing Pane with the search hits highlighted yellow.

Playing Back Audio
With Livescribe Desktop, you can play back audio transferred from your smartpen.

125



Browsing Audio Recordings

To view a list of all audio recordings:

•
Click the Audio View button , or choose Navigation > Audio from the Menu. This opens the
Audio View and brings up a list of all audio recordings.

When you view audio recordings as a list, Livescribe Desktop shows the audio recordings as a series of rows
with named columns.

Audio recording columns

DescriptionView List Column

Identifies which file, if any, is currently playing audio.  If no file is playing, the icon does
not appear.

Audio Indica-tor

View pages linked to an audio recording. You may have audio recordings that do not have
this icon because they are paperless sessions.View in Pages button

By default, this name is the audio recording's creation date and time.Audio Name

The length of the audio recordingDuration

The timestamp when audio is recordedLast Modified

The size of the audio file in MB or KBSize

Shows the name of the source smartpen for the audio recording or Desktop Only.Source

Desktop Only indicates that the source smartpen is removed from Livescribe Desktop, but
its content is preserved in Livescribe Desktop.

Playing Audio Recordings in Audio View

With Livescribe Desktop, you can play audio while viewing the audio recording's pages, or you can play the
audio by itself in the Audio View.

1. Go to Audio View.

2. Double-click the audio recording in the list.

The left-most column shows the audio play-ing  icon when the audio recording begins to play.

Playing Audio while Viewing Pages

With Livescribe Desktop, you can play an audio recording while viewing its linked pages Single-Page View.
You can also play an audio recording by itself in Audio View.

If you play back an audio recording that spans multiple pages, Livescribe Desktop automatically moves to
successive pages in real time synchronization with the playing audio. This automatic paging continues until you
manually switch pages using Paging Controls. From then on, the paging is under manual control only until play
back another audio recording.
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When viewing a page Single-Page View, click on the active ink (shown as green) on the page.

This starts the audio playback. This is analogous to tapping your notes in a notebook to play back the audio
recording. Playing an audio recording also opens the Sessions tab in the Navigation Pane.

When you mouse over ink that is active, the mouse cursor changes to a pointing hand cursor  to help you
identify where you can click to begin audio playback.

If you added notes while playing back an audio recording, Livescribe Desktop shows this ink as blue, by
default. You can click on this ink to play back the audio at the point where you added the notes.

You can change the color of active and inactive ink by setting a preference.

Using Audio Controls

Livescribe Desktop shows Audio Controls at the bottom of its screen. You can use these controls to start, pause,
stop, and control audio playback. Livescribe Desktop disables these controls unless you select the audio recording.

This toolbar has the following buttons and controls:

Begin playing audio

Pause audio

Jump back (in 10 second increments)

Jump forward (in 10 second increments)

Audio timeline control: Indicates the relative position of the currently playing
audio, within the context of the entire audio file.

This control also shows the current elapsed time position of the audio and the
total length of the audio file.

You can also use this control to reposition the audio playback. As you listen to
an audio recording and view its pages, you can move the slider to move forward
or backward in the audio recording.

Jump to previous bookmark

Jump to next bookmark

Playback speed control: Increases or decreases the speed of the playing audio.

Scrubbing an Audio Recording

Single-Page View, while you listen to an audio recording and view its pages, move the audio timeline slider 
to reposition the audio playback. When you move the slider and audio is playing, the audio and its active ink
move to the corresponding timeline position. This process is scrubbing the audio. You can use this feature to
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move forward or backward to a specific area of your audio recording and see how it corresponds to your written
notes.

Renaming an Audio Recording in Livescribe Desktop

By default, your smartpen names each audio recording using its creation date and time. For example, Livescribe
Desktop would name an audio recording recorded on March 7, 2008 at 12:56 in the afternoon as 03.07.2008
12:56p. In Audio View, you can rename your audio recordings.

1.

Click the Audio View button , or choose Navigation > Audio from the Menu.

This opens the Audio View and brings up a list of all audio recordings.

2. Click the audio recording you want to rename.

3. Choose Edit > Rename from the Menu.

4. Type a new name and click OK.

Printing
With Livescribe Desktop, you can print notes transferred from your smartpen. You can also print your own
Livescribe Dot Paper notepads.

Printing a Single Page

You can print pages from your Livescribe Dot Paper. Although active ink appears as green in the Central Viewing
Pane, Livescribe Desktop prints it in black, just like non-active ink. Your printed page does not interact with
your smartpen.

1. View the page as a single page, or choose the thumbnail of the page.

2.
In the Menu, choose File > Print. On the print dialog, choose a printer and click the Print  button.

By default, the page prints showing the page background. To print the page without the background, uncheck
the Print Page Background checkbox. If you choose to include the background, the printed pages include
anything shown on the pages of the actual notebook. For example, an image from a college-ruled notebook
contains ruled lines.

Printing Multiple Pages

1. View pages as thumbnails.

2. Use Control-click to select multiple, non-sequential thumbnails. Use Shift-click to select a sequential set of
thumbnails.

3.
In the Menu, choose File > Print. On the print dialog, choose a printer and click the Print  button.

By default, the page prints showing the page background. To print the page without the background, uncheck
the Print Page Background checkbox. If you choose to include the background, the printed pages includes
anything shown on the pages of the actual notebook. For example, the college-ruled notebook the printed
pages contains ruled lines.
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Printing Your Own Notepads

Using Livescribe Desktop, you can print your own notepads using a qualified color laser printer that can print
600 dpi or greater.

Testing Your Printer

1.

Click the Pages View button  in the Main Toolbar to go to Pages View.

2. Select a notebook on the left to activate the Tools menu option and choose Tools > Printable Notepads >
Test Page (1 page).

Livescribe Desktop shows the Print dialog and automatically selects the first qualified printer you have in
your printer list.

3. Click Print.

4. When the test page is finished printing, follow the instructions printed on the page using your smartpen. The
instructions ask you to write some words in each of four areas and then dock your smartpen to your computer.

5. Next, in Livescribe Desktop, examine the test page after it has transferred from your smartpen. If all of your
words transfer successfully, then your printer can print Livescribe Dot paper and you can begin printing your
own notepads.

Printing a Notepad

1. Choose Tools > Printable Notepads and select a notepad to print such as Notepad 1 (25 pages).

2. In the Print dialog, specify a range of pages to print or accept the default. Click Print.

Livescribe Desktop prints a notepad. You can use the notepad just like any other Livescribe Dot paper. When
you dock your smartpen after writing on this notepad, your content transfers like it does with pre-printed
Livescribe note-books and journals.

Organizing Notes and Audio
With Livescribe Desktop, you can organize notes and audio transferred from your smartpen.

Creating a Custom Notebook
You can create Custom Notebooks in Livescribe Desktop to organize and better manage your pages.

You can add pages from any notebook, and drag them to arrange them in any order within a Custom Notebook.
Pages in a Custom Notebook work like other notebook pages. For example, you can view, zoom, search, and
print pages.

Note:

A Custom Notebook is similar to a music playlist, or a digital photo album, but instead of pointing to
songs or pictures, it points (links) to pages in their source notebooks.

1. Choose File > Custom Notebooks > Create.

2. In the Notebook Name dialog, enter a name for your custom notebook and click OK.
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Livescribe Desktop creates an empty custom notebook and places it in the Navigation pane under the heading
Custom Notebooks.

3. To add pages to a custom notebook, select one or more pages in Page View and drag and drop them onto the
custom notebook in the Navigation pane.

Adding Custom Notebook Pages by Dragging and Dropping

You can add pages to a Custom Notebook by dragging and dropping page.

1. Navigate to a notebook in your library and select one or more pages.

2. Drag and drop the page(s) to the Custom Notebook name in the Library Pane.

The pages you selected appear in the Custom Notebook.

Adding Custom Notebook Pages with a Menu Command

1. Navigate to a notebook in your library and select one or more pages.

2. Choose File > Custom Notebooks > Add pages to

3. In the Select Notebooks dialog, check the target Custom Notebook name, then click Done.

The pages you selected appear in the Custom Notebook.

You can also choose to create a new Custom Notebook from this dialog by clicking Create. After the new
notebook is created, check the new notebook name in the Select Notebook area and click Done to add the
selected pages.

Reorganizing Custom Notebook Pages

You can organize the pages in a Custom Notebook by simply dragging, moving, and dropping them into their
new order.

1. Open a Custom Notebook in Page View.

2. Select a page to be moved.

3. Drag, move, and drop the page into its new location. The pages are automatically renumbered in the Livescribe
Desktop view.

You can view information about the source of a page by hovering over it with a mouse cursor. Source
information includes the smartpen linked to the page, its notebook, and source page number.

Deleting a Custom Notebook
You can delete a Custom Notebook or pages from a Custom Notebook. Deleting a Custom Notebook or pages
from a Custom Notebook does not affect the source notebooks or their pages.

1. Select a Custom Notebook in the Library tab.

2. Choose File > Delete Notebook

3. At the prompt, click Yes to confirm the deletion.
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Deleting a Custom Notebook Page

1. Open a Custom Notebook in Page View.

2. Select one or more page to be deleted.

3. Choose File > Delete Page(s)

4. At the prompt, click Yes to confirm the deletion.

Managing Storage for Livescribe Desktop and Your Smartpen
With Livescribe Desktop, you can manage its storage of notes and audio, and the storage on your smartpen.

Freeing Space on Your Smartpen

Your smartpen uses flash storage to your notes and audio, as well as apps and system files. Recorded audio
requires the most space. If you are running out of space on your smartpen, then can delete these audio recordings.
There are several ways to free space on your smartpen:

• Select and remove one or more audio recordings using Livescribe Desktop.

• Archive any Livescribe Dot Paper you are no longer using.

• Remove apps you are not using.

• Use the Main Menu on your smartpen to select and delete audio recordings.

Use the Memory Bar to view the storage usage of your smartpen. The Memory Bar is located at the bottom of
the Applications Manager.

This bar shows:

• Total storage capacity of your smartpen (both used and free)

• Storage used by system software (shown in green)

• Storage used by apps (shown in orange)

• Storage used by content you created (shown in purple)

• Available storage (shown in gray)

Removing Audio from Your Smartpen
You can remove audio from your smartpen with Livescribe Desktop.

Removing audio from your smartpen frees storage. Because the audio is gone, any notes linked to the audio does
not interact with your smartpen. That is, if you tap on notes that were linked to the audio, the audio no longer
plays back.

1.

Click the Audio View button , or choose Navigation > Audio from the Menu.

This opens the Audio View and brings up a list of all audio recordings.

2. Single-click or multi-select the audio recordings you want to delete.

3. Choose File > Remove Audio from Smartpen.
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4. To confirm the removal, click OK, otherwise click Cancel.

To remove all audio from your smartpen for a specific Livescribe Dot Paper product, use the Archive feature.

You can also delete an audio recording from Livescribe Desktop.

Deleting Audio from Livescribe Desktop

You can delete audio recordings from Livescribe Desktop. Deleting audio from Livescribe Desktop does not
affect your smartpen:

1.

Click the Audio View button , or choose Navigation > Audio from the Menu.

This opens the Audio View and brings up a list of all audio.

2. Single-click or multi-select the audio recording you wish to delete.

3. Choose File> Delete Audio from Livescribe Desktop.

4. To confirm the deletion, click OK, otherwise click Cancel.

You can also remove audio recordings from your smartpen.

Removing a Smartpen from Livescribe Desktop

You can remove your entire smartpen and its contents from Livescribe Desktop. Livescribe Desktop does not
recognize your smartpen after this operation.

Note:

Removing a smartpen from Livescribe Desktop does not affect the content of the smartpen.

1. Choose Tools > Smartpen > Remove.

2. At the prompt, choose to Delete or Save.

If you choose Delete, all notes and audio recordings from this smartpen are removed and are no longer
available in Livescribe Desktop.

If you choose Save, all notes and audio recordings from the removed smartpen are saved in the as archived
notebooks. You can also access the removed smartpen’s audio from the Audio View.

3. In the dialog, Confirm or Cancel the smartpen removal.

If you previously archived notebooks that were on the removed smartpen, those archived notebooks are not
removed from Livescribe Desktop.

Backing Up Your Livescribe Desktop Content Folder
Livescribe recommends that you regularly back up Livescribe Desktop files just like other important files on
your computer.

Backing up your files protects you from losing important files in case your computer becomes damaged, lost,
or stolen. If you later need to restore your Livescribe Desktop files, contact Livescribe Customer Service for
instructions.
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You can find all files linked to Livescribe Desktop in your Livescribe folder. This folder contains your notes
and audio, as well as important information about your smartpen and Livescribe Desktop. By default, Livescribe
Desktop creates the Livescribe folder in these locations:

For Windows XP:

C:\Documents and Settings\<username>\Local Settings\Application 
Data\Livescribe

Note:

By default, Windows hides the Local Settings folder. Refer to your Windows documentation on how to
enable the “show hidden files and folders” option for your Documents and Settings folder.

For Vista and Windows 7:

C:\Users\<username>\AppData\Local\Livescribe

1. Quit Livescribe Desktop.

2. Locate your Livescribe folder.

3. Copy the folder to a backup device, such as a CD, DVD, or external drive.

Copying Smartpen Content to Multiple Computers
You can copy your smartpen content to any computer that has Livescribe Desktop.

If you choose to transfer content to multiple computers, be sure to dock the smartpen and transfer your data to
each computer on a regular basis. Also, every time you delete data from Livescribe Desktop or archive a notebook,
be sure to do the same operations on your other computers.

1. Dock the smartpen to the other computer. Livescribe Desktop presents a dialog asking if you want to copy
your smartpen contents to this computer.

2. To copy the smartpen contents to this computer, click the Connect and Transfer button. Livescribe Desktop
prompts you to name the smartpen (the first time only) and automatically copies the smartpen content to
Livescribe Desktop. To charge the smartpen through the computer's USB port without copying your data,
click the Charge Only button.

Archiving Livescribe Dot Paper on Windows
When you have finished using a Livescribe Dot paper product, you should archive it in Livescribe Desktop.

Archiving Livescribe Dot Paper

Archiving a Livescribe Dot paper product does the following:

• Frees up storage space on your smartpen

• Enables you to use another Livescribe Dot paper product that has the same dot pattern as the one you archived.
Livescribe Dot Paper products with the same dot pattern have the same name.

• Moves your notes and audio for a Livescribe Dot Paper product into an Archived Notebooks folder in the
Library Pane of Livescribe Desktop. Your notes and audio remain interactive in Livescribe Desktop, just like
non-archived Livescribe Dot Paper products.
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• Deletes your notes (ink data) and audio from your smartpen. Because of this, your smartpen no longer interacts
with the physical Livescribe Dot Paper product that you archived. That is, when you tap the notes in your
archived physical notebook, they do not play back any audio.

Important:

Do not archive a notebook unless you are finished using the physical notebook and are ready to set it
aside. After you archive a notebook, do not go back to its physical notebook and start writing on it again,
unless you have unused pages and want to treat them as a part of a new notebook. For example, you
could archive a notebook that is partially completed, and then use the remaining pages as a second
notebook.

If you are using multiple computers to manage your smartpen data, be sure to archive your notebooks
on all of these computers.

1. Update your smartpen software to Version 1.2 or later. Prior versions do not support this feature. To update
your software, choose Help > Check for Updates in the Menu.

2.

Click the Pages View button  in the Main Toolbar to go to Pages View.

3. Click the Library tab of the Navigation Pane and click the notebook you want to archive.

4. Choose File > Archive Notebook.

5. When prompted, click OK to confirm the archive operation, otherwise click Cancel.

6. When prompted, click Archive this notebook, otherwise click Cancel.

7. Livescribe Desktop confirms your notebook is archived, and you see the archived notebook in your Library
tab in an Archived Notebooks group.

If you are using multiple computers, be sure to archive the notebook on each of them.

Deleting Archived Notebooks from Livescribe Desktop

1. Select an Archived Notebook in the Library tab.

2. Choose File > Delete Notebook

3. At the prompt, choose if you want to also delete the notebook’s audio.

4. Click Yes to confirm the deletion.

Deleting archived content from Livescribe Desktop removes the content permanently. You cannot recover
the archived content by docking your smartpen because the process of archiving the content removed it from
your smartpen.

Deleting Archived Pages from Livescribe Desktop

1. Open an Archived Notebook in Page View.

2. Select one or more page to be deleted.

3. Choose File > Delete Page(s)

4. At the prompt, choose if you want to also delete the page’s audio.

5. At the prompt, click Yes to confirm the deletion.

Deleting archived content from Livescribe Desktop removes the content permanently. You cannot recover
the archived content by docking your smartpen because the process of archiving the content removed it from
your smartpen.
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Managing Your Smartpen
With Livescribe Desktop, you can manage properties of your smartpen, including registration, naming, and Paper
Replay password.

Registering Your Smartpen

It is important that you register your smartpen. Registering your smartpen:

• Creates your personal MyLivescribe account with 500MB of free storage.

• Allows you to broadcast or privately share your notes and audio online.

• Enables you to purchase and install new smartpen apps from our online software store.

• Qualifies you to install free smartpen apps after registering!

• Provides enhanced security for your smartpen data.

• Gives you access to special promotional offers.

1. When you dock your smartpen for the first time, Livescribe Desktop prompts you to register with Livescribe.
When prompted, click Next to register. Or, click Remind Me Later to register later. Livescribe Desktop
reminds you the next time you dock the smartpen.

You can also manually start the registration process by clicking the Livescribe Online  button
on he Main Toolbar, or choose Tools > Smartpen > Register.

2. On the registration dialog, choose either Create a new account and click Next, or if you already have an
account with Livescribe, choose Use my existing account and enter your email address and password.

If you forgot your password, click the Forgot Password button, and Livescribe sends you instructions on
how to reset it.

When creating your user name and password, follow these guidelines:

• Your user name is your email address. It cannot be more than 128 characters and is not case sensitive. For
example, MyName@MyCompany.com and myname@mycompany.com are the same.

• Your password must be at least four characters long and no more than 64 characters. Your password is case
sensitive, and cannot start with a space or contain characters that are not printable. Your password and user
name cannot be the same.

3. On the registration information dialog, fill in the required fields and click Continue to complete the registration
process. When the registration process is complete, Livescribe Desktop opens your personal MyLivescribe
space on http://www.livescribe.com.

Renaming a Smartpen on Windows

You can rename a smartpen in Livescribe Desktop.

1. Launch Livescribe Desktop

2. Dock the smartpen to be renamed.

3. If it is not already selected, use the smartpen selector drop down to choose the smartpen you want to rename.

4. Choose Tools > Smartpen > Rename.

5. Type a new name and click OK.
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Removing a Paper Replay Password
On your smartpen, you can create a password for your audio recordings. Setting a password can prevent others
from listening to your recorded audio on your smartpen. When Paper Replay is protected, audio play back is
prevented until the password is entered on your smartpen.

You can remove a Paper Replay Password from your smartpen using your smartpen’s Main Menu, or using
Livescribe Desktop.

To remove a password using Livescribe Desktop:

1. Launch Livescribe Desktop.

2. Dock your smartpen.

3. Choose Tools > Smartpen > Clear Paper Replay Password.

4. Confirm the password is cleared by playing back a Paper Replay audio recording on your smartpen. If the
password is cleared, you can play back audio recordings without writing the password first.

\Paper Replay Password does not prevent playback from Livescribe Desktop, only from your smartpen.

You cannot set your Paper Replay Password using Livescribe Desktop. You must set it from your smartpen’s
Main Menu.

Managing Smartpen Software and Apps on Windows
You can install and update smartpen software and apps using Livescribe Desktop.

Installing Smartpen Software Updates
Livescribe periodically updates smartpen apps (such as Paper Replay) and underlying smartpen firmware.
Livescribe also updates this software to support new kinds of Livescribe Dot Paper.

When you dock your smartpen and launch Livescribe Desktop, it checks for available updates. You can also
manually check for updates using Livescribe Desktop.

Note:

If you try to use a new Livescribe Dot Paper product, and get an error message that it is “not supported”,
you need to update your smartpen software.

1. Dock your smartpen.

2. Launch Livescribe Desktop.

Livescribe Desktop automatically checks for recent updates.

3. Accept the updates.

Livescribe Desktop downloads and installs them to your smartpen.

If you choose to postpone transferring updates to your smartpen, you can re-initiate the transfer process by
undocking and re-docking your smartpen. Livescribe Desktop prompts you to transfer available items.

Checking for Updates Manually
By default, Livescribe Desktop automatically downloads and installs apps and their updates when you dock a
registered smartpen. This feature is called Auto-Install.
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You can disable the check for updates feature by changing the Smartpen user setting. At any time, you can
manually check for updates to Livescribe Desktop, smartpen firmware, and apps you have purchased:

1. Choose Help > Check for Updates in the Menu.

2. Accept the recommended updates.

Getting More Apps
Livescribe and other companies offer new apps for your smartpen. You can download these from the Livescribe
Online Store.

1. From a web browser, go to www.livescribe.com/store and browse the apps available.

Some apps are free and others are available for purchase. These apps are designed to work like the built-in
apps that come with your smartpen.

2. After you download a new app, use Livescribe Desktop to add it to any smartpen registered to your Livescribe
account.

Livescribe Desktop installs downloaded apps to your smartpen under a new Applications menu. This menu
is the first menu item underneath the Main Menu and is available after you install your first downloaded app.

Purchasing an App

Using the Livescribe Online Store, you can purchase and download new apps for your smartpen from Livescribe
and other vendors.

1.

From Livescribe Desktop, click the Livescribe Online button  in the Main Toolbar. This
connects you to the Livescribe Community page and open your personal space (called MyLivescribe) within
the Central Viewing Pane of Livescribe Desktop.

Alternatively, go to www.livescribe.com from your web browser and click on the Community tab to go to
Community page.

2. Click the Log In button  to go to Livescribe account.

3. Click on the Store tab. From the store page, browse and purchase apps.

4. Select and app to purchase by clicking its Add button. Optionally, look at the apps details page.

From the details page, you can download documentation for the App.

5. Click Add to Cart to add the app into your shopping cart. This opens your shopping cart and begins the
four-step purchasing process. Click the Continue to Checkout button.

6. Add or confirm your billing and shipping information.

7. Confirm your purchase.

8. Place your order. After placing your order, your app is ready for downloading in the Download Manager
tab.

Downloading an App

1. After purchasing an App, click the Download Manager tab in the Livescribe Online view of Livescribe
Desktop.

2. Click the Download button next to the app you want to download to Livescribe Desktop. From there, you
install the app using the Apps Manager view.
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3. In the Downloads dialog, confirm the apps to install by checking or unchecking the apps available to download.

4. You can view the download progress from that Download Manager view. Once the app is downloaded, click

theClick the Apps Manager button  to begin the installing the App.

Installing an App

The Apps Manager lists all apps that you have downloaded from Livescribe Online. Use the Apps Manager to
install these apps to any smartpen registered to you.

To install an App:

1. Dock the smartpen on which you want to install the App.

2.
Click the Apps Manager button  in the Main Toolbar.

You see a list of all the apps you have downloaded, including those you have already installed to your
smartpens and those waiting to be installed.

3. Click the To smartpen  button next to the app to install. This starts the installation process for
the smartpen you have docked.

4. The Apps Manager shows the progress of the installation.

5. After installation completes, the Apps Manager indicates the app is installed by showing a checkmark in the
On Smartpen column.

Uninstalling an App

To uninstall an App:

1. Dock the smartpen on which you want to un-install the App.

2.
Click the Apps Manager button  in the Main Toolbar.

You see a list of all the apps you have downloaded, including those you have already installed to your
smartpens and those waiting to be installed.

3. Click the From Smartpen  button next to the app to un-install. This removes the app from the
smartpen you have docked.

To re-install the App. click the To Smartpen  button next to the app to install. This starts the
installation process for the smartpen you have docked.

Viewing Installed Apps and Software

Use the Apps Manager to view all apps you have purchased and downloaded from the Livescribe Online Store:

•
Click the Apps Manager  button in the Main Toolbar. You see a list of all the apps and software
you currently own and their status for the currently-selected smartpen.

When you view a list of apps and software in Apps Manager, Livescribe Desktop shows them as a list of rows
with named columns. The table below describes the columns.

DescriptionColumn

The name of the AppApp Name
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A checkmark indicates that the app is on your currently-docked smartpen.On Smartpen

The To Smartpen  button indicates the app is downloaded to Livescribe Desktop and
cane be installed to any smartpen registered to your Livescribe account by clicking this button.

Transfer

The From Smartpen  button indicates the app is installed on your currently-docked
smartpen and can be uninstalled by clicking this button.

Getting App Information

To get information for any App, click on the app name in the Apps Manager. This shows the current version
and size of the App.

Using Livescribe Online
Livescribe Online is your connection to your Livescribe account and to content shared by the Livescribe
community. You can connect to Livescribe Online either from a web browser or directly from within Livescribe
Desktop.

About Livescribe Online

Setting up a Livescribe account creates a personal space for you on Livescribe Online called MyLivescribe. This
is a personal area reserved for you. There you can set up your account profile, upload and store content to share
with your friends, the community, or anyone on the web.

Sending Content to Livescribe Online

To send pencasts using Livescribe Online, upload a pencast to using the Upload to Community sharing option.

After uploading a pencast to Livescribe Online, you can set your Sharing Preferences on your MyLivescribe
account. There are several methods available to share your content.
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Emailing Content to a Friend from Livescribe Online

Choose the Email a Friend preference to share content with a friend via email:

1. Select a file. To select a file from the Livescribe Online Community, click the file’s thumbnail to view it.
To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files area to
view it.

2. On your MyLivescribe page, click on Email a Friend.

3. Enter your friend’s email address in the To field.

4. Optionally, add a message in the Personalize It section.

5. Click Send. Your friend receives an email that links him or her to your file on Livescribe Online. If your
content is private, your friend must create a Livescribe Online account. Their user-name must be the email
address you sent the invitation to.

To select multiple friends to send a file to, just check the box next to each friends email address in your
Address Book before clicking the Send button.

When you send the invitation, Livescribe Online automatically adds your friend to your Contact list for future
ease of sharing. As you share more files, your Address Book contact list grows.  Use the gray Edit a Contact
button to add a friend’s name or edit an email address.  Use the red Delete a Contact button to remove an email
address from the list.

Download a PDF Document from Livescribe Online

You can use the Download as PDF preference to download to your computer your uploaded content in PDF
format. You can then share this PDF file with others via email or other means.

1. Select a file. To select a file from the Livescribe Online Community, click the file’s thumbnail to view it.
To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files area to
view it.

2. Click on Download as PDF. The file is downloaded in PDF format to your computer.

Get a Web Link to Your Content on Livescribe Online

Use the Get a Link to this file preference to obtain web link to your content that you can paste in a blog or
elsewhere.

1. Select a file. To select a file from the Livescribe Online Community, click the file’s thumbnail to view it.
To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files area to
view it.

2. Click on Get a link to this file. If the file is on your MyLivescribe page and private, make it public.
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3. In the Get a link for this file dialog, highlight the link and copy it to the clipboard.

4. Open your HTML editor for your blog or other web page.

5. Access the HTML edit area and click in the edit field. Make sure you are in HTML edit mode, not Text
composition mode.

6. Paste the text.

7. Publish the file.

8. In Livescribe Online, click Done to close the dialog window.

Sharing Content on Facebook through Livescribe Online

Use the Share on Facebook preference to embedded content into your website, forum, or blog.  You can only
embed public files.

Files posted to the general Livescribe Online Community are public and available for embedding. If the file you
want to embed is on your MyLivescribe page, you must first make it public.

1. Select a file. To select a file from the general Livescribe Online Community, click the file’s thumbnail to
view it. To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files
area to view it.

2. Click Share on Facebook.

3. Facebook prompts you to log in unless you are already logged in.

4. If you would like to share content by posting to your Facebook page, use the Post to Profile tab. The posting
appears on your Facebook Home page.

5. If you would just like to share content by email, use the Send a Message tab. The recipient gets an email with
a link that they can use to access the file.

Embedding Content in a Website or Blog With Livescribe Online

Use the Embed this file preference  to embedded content into your website, forum, or blog.  You can only embed
public files.

Files posted to the general Livescribe Online Community are public and available for embedding. If the file you
want to embed is on your MyLivescribe page, you must first make it public.

1. Select a file. To select a file from the Livescribe Online Community, click the file’s thumbnail to view it.
To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files area to
view it.

2. Click the Embed this file link. If the file is on your MyLivescribe page and private, make it public.

3. In the Embed this file dialog, highlight the HTML code and copy it to the clipboard.

4. Open your HTML editor for your website, forum, or blog.

5. Access the HTML edit area and click in the edit field. Make sure you are in HTML edit mode, not Text
composition mode.

6. Paste the text.
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7. Preview the posting in your HTML editor.

8. If the pencast displays and plays back properly, publish the file.

9. Click Done to close the Embed this file window.

Making Content Public or Private on Livescribe Online

Make your uploaded content public to allow others to access it without an invitation. When a file is public,
visitors can view the file without logging in.

Important:

When you upload your Livescribe smartpen content to your MyLivescribe space, Livescribe makes the
content private by default. Making a file public allows anyone to access the file. Livescribe recommends
that you not make any of your confidential files public.

1. Select a file from your personal MyLivescribe space. Click the file’s thumbnail in the My Files area to view
it.

2. Click the Make this file Public (or Private). Making the file public adds the file to the Livescribe Online
Community area so anyone can see it without logging in. If you make the file private, Livescribe Online
removes the file from the Livescribe Community.

Editing Your Access List on Livescribe Online

The Access List preference controls who can and cannot see a file when it is private. To give your friends
permission to see a private file, add your friend to this list. They are able to see the file when they log into their
Livescribe account.

1. Select a file from your personal MyLivescribe space. Click the file’s thumbnail in the My Files area to view
it.

2. Click the Edit Access List preference to set create an access list for this file.

3. In the Access List dialog, click Add Contact button and type a friend’s email address. Use the gray Edit a
Contact button to add a friend’s name or edit an email address.  Use the red Delete a Contact button to
remove an address from the list.

Managing Your MyLivescribe Account on Livescribe Online

Setting up a Livescribe account creates a personal space for you on Livescribe Online called your MyLivescribe
space. This is a personal area reserved for you. There you can set up your account profile, upload and store
content to share with your friends, the community, or anyone on the web.

Setting Up a MyLivescribe Account

When you register your Livescribe smartpen through Livescribe Desktop, the registration process prompts you
to create a Livescribe account. If you need to, you can also create an account manually without registering (or
even owning a Livescribe smartpen).

You can manually set up a Livescribe account either from Livescribe Desktop or directly from a web browser.
To set up a Livescribe account from a web browser:

1. Go to www.livescribe.com from your web browser and navigate to the Community page by clicking the
Community tab.

2. Click the Sign Up button .

3. Provide a username and password. The username must be a valid email address.
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When creating your user name and password, follow these guidelines:

• Your user name is your email address. It cannot be greater than 128 characters and is not case sensitive.
For example, MyName@MyCompany.com and myname@mycompany.com are the same.

• Your password must be at least four characters long and no longer than 64 characters. Your password is
case sensitive, and cannot start with a space or contain characters that are not printable. Your password and
user name cannot be the same.

Using Your MyLivescribe Account

When you create a MyLivescribe user profile, you receive space to store content.

• Select Account in the upper right corner of Livescribe Online.

On your MyLivescribe profile page you see a list of sharing options, viewer comments, and how much space
you have used and you have available.

Managing Your Uploaded Content on Livescribe Online

From your MyLivescribe space, you can manage content in your Livescribe account as described in the following
table:

DescriptionTask

Select the filename in the central viewing pane and edit it in place.Rename files

Click the thumbnail X icon next to the file name to delete it. This does not remove the
files from your Livescribe Desktop App or your Livescribe smartpen, only from your
online account.

Delete files

Choose a category in which to place your file by clicking on the category name in the
description area and choosing one of the pre-defined categories.

Choose categories for files

You can add short descriptions of your uploaded files by selecting click to edit… under
the Description area and typing a name into the text field.  Edit existing descriptions
by clicking on the existing description and typing into the text field.

Add/Edit file descriptions

Managing Your Account Details on Livescribe Online

From your MyLivescribe space, you can manage your Livescribe account and perform other administrative tasks
described in the following table:

DescriptionTask

Select the name and edit it in place in the upper left area under the My Account section.Change your user name

Click on the unlink option under My Pens in the lower left area under the My Account
section.

Unlink your Livescribe smartpen from your
account

Go to the Edit Login tab in the central Details section and click Change Your Password.Change your password

Go to the Profile tab in the central Details section and click Upload an Avatar Photo.
You may need to log in using a web browser to see this option.

Upload an Avatar Photo

Go to the Profile tab in the central Details section to edit your contact information and
optionally details about you.

Change your contact and personal information
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DescriptionTask

Check or uncheck the option to receive news and offers about Livescribe and related
products.

Subscribe or unsubscribe to Livescribe news and
offers

Viewing Livescribe Online Community Content

In the Livescribe Community, you can see what others are doing with their Livescribe smartpens and post your
own creations for others to rate and comment on.

The Community page has several sections:

Livescribe randomly chooses files to feature on the front page of the Community area.Featured Files

Lists members of the Livescribe Community who provide the highest-rated submissions.
Click on a Featured Contributor to go their MyLivescribe profile.

Featured Contributors

Shows the top-rated content in the Livescribe Community.Top Rated

Shows visitors which content has been viewed the most.Most Viewed

Visiting the Livescribe Online Store

At the Livescribe Online Store - www.livescribe.com/store - you can purchase additional smartpens, paper
products, Apps, and more. At checkout, you need to log in to your account, or create an account if you have not
already. You can access the Livescribe Store either from a web browser or directly from Livescribe Desktop via
the Livescribe Online view by clicking Livescribe Store.

Livescribe User Guides144

http://www.livescribe.com/store


Connecting to Livescribe Online from Windows
Livescribe Online is your connection to your Livescribe account and to content shared by the Livescribe
community.

You can connect to Livescribe Online either from a web browser or directly from within Livescribe Desktop.

1.

From Livescribe Desktop, click the Livescribe Online button in the Main Toolbar.

This connects you to the Livescribe Community page and open your personal space (called MyLivescribe)
within the Central Viewing Pane of Livescribe Desktop.

2. Alternatively, go to www.livescribe.com from your web browser and click on the Community tab to go to

Community page. From there, click the Log In button  to go to your MyLivescribe space.
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Livescribe Desktop for Mac User Guide

About Livescribe Desktop for Mac
Livescribe Desktop is software that runs on your computer to view and listen to the content you create and
capture using your Smartpen.

About Livescribe Desktop
With Livescribe Desktop, you can view your notes, listen to your recorded audio, manage apps, and more.

Livescribe Desktop is also a portal to Livescribe Online, where you can upload and share content, purchase new
apps and paper products, and connect to the smartpen user community.  Using Livescribe Desktop, you can:

• Save and search notes, and play back audio recordings from your computer.

• Search your handwritten notes for keywords.

• Organize and manage your notes.

• Export and share your notes and audio recordings.

• Upload notes and audio to your MyLivescribe account.

Livescribe Desktop Components

Finding your way around the Livescribe Desktop environment is easy and consistent. Use the main components
shown below to view, listen to, and manage your notes and audio recordings.
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Installing Livescribe Desktop on a Mac
You can install Livescribe Desktop on one or more computers.

System Requirements
Before installing Livescribe Desktop, ensure your computer meets or exceeds the system requirements.

Livescribe Desktop requires:

• Intel-based Mac with Mac OS® X 10.5.5 or later, including 10.6

• 600MHz CPU or higher

• 300 MB of free disk space

• USB 2.0 port

• Internet connection for software download

Installing Livescribe Desktop for the First Time

To install Livescribe Desktop for the first time:

1. Go to the Livescribe web site (www.livescribe.com), and click on the Save and Search button on the bottom
of the page.

2. On the Save and Search page, click on the Mac OS X button to start downloading. The download process
installs the disk image file (.dmg) and mounts a virtual disk.

3. During the download process, Livescribe shows the Livescribe Software license agreement. Accept the
agreement to continue the process.

4. Within the disk image, drag and drop the Livescribe Desktop app to the Apps folder. This automatically
copies Livescribe Desktop.

5. Launch Livescribe Desktop.

6. Dock your smartpen. This copies content from your smartpen to Livescribe Desktop.

7. When prompted, register your smartpen. If you already have an account, use the same log in credentials.
Otherwise, create a new account.

You may want to dock your smartpen overnight if it has a large amount of data on it, as it may take an hour
or so to transfer the data the first time you dock.

Authorizing Livescribe Desktop

As a Livescribe user, all your Livescribe tools link to each other using the same email address and password.
This means that your smartpen registration, your Livescribe Online account, and your installations of Livescribe
Desktop, all identify themselves to each other using the same email address and password.

When you use Livescribe Desktop on a computer for the first time, Livescribe Desktop prompts you to authorize
it. Log into your Livescribe Online account and Livescribe Desktop is authorized for (or linked to) your account.

You can use Livescribe Desktop on as many computers as you like, and you can use as many smartpens as you
like. Just ensure that when you authorize Livescribe Desktop and register your smartpens, you use the same
email address and password as your Livescribe Online account.
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Switching from Windows to Mac

If you have been using your Livescribe Desktop for Windows, and you want to switch to Livescribe Desktop
for Mac, dock your smartpen to your Macintosh after installing Livescribe Desktop. This automatically copies
your content.

To switch to Livescribe Desktop for Mac from Windows:

1. Install and launch Livescribe Desktop on your Macintosh. Follow the steps in .

2. When prompted, register your smartpen using your exist-ing Livescribe account.

3. Dock your smartpen. This copies content from your smartpen to Livescribe Desktop.

You may want to dock your smartpen overnight if it has a large amount of data on it, as it may take an hour
or so to transfer the data the first time you dock.

If you had archived notebooks in Livescribe Desktop for Windows, the archived content is no longer be on
your smartpen. Therefore, simply docking your smartpen does not transfer the archived content. The archived
content only resides in your My Livescribe folder on your Windows PC, where you can view it as needed.

Uninstalling Livescribe Desktop

If you need to delete the Livescribe Desktop app from your computer, use one of the procedures below.

• Go to the folder where you installed Livescribe Desktop and drag livescribe.app to the Trash.
• Select livescribe.app and press  + Delete.

Livescribe Desktop stores some large files in the Library > App Support > Livescribe folder. Manually delete
these files.

Upgrading Livescribe Desktop
If you have an older version of Livescribe Desktop running on your computer, follow the steps below to upgrade
it.

Checking for Livescribe Desktop Updates

If you are connected to the Internet, Livescribe Desktop automatically checks the Livescribe website to see if
your version of Livescribe Desktop is current, and if the software and firmware on your smartpen are up to date.

If your system needs updates, Livescribe Desktop prompts you to update now or later. It is good practice to
accept the updates available for both Livescribe Desktop and your Livescribe smarten.

If you are currently using any version earlier than 2.7 of Livescribe Desktop for Mac OS X, perform these steps
to upgrade:

1. Launch Livescribe Desktop. If an update is available, Livescribe Desktop prompts you to accept the update.
Confirming the update downloads the latest version of Livescribe Desktop for Mac OS X from the Livescribe
website.

2. Check for additional updates. Choose Livescribe Desktop > Check for Updates from the Menu. Accept
any updates offered. Repeat this process until you have installed the current version of Livescribe Desktop.
To determine the current version numbers, see About This Release on page 8.
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Configuring Livescribe Desktop
You can customize the behavior of Livescribe Desktop using its configuration options.

Setting Livescribe Desktop Preferences

Livescribe Desktop gives you control over how the app looks and responds, as well as access to updates. To set
your Livescribe Desktop preferences:

1. From the Livescribe Desktop menu, select Preferences. The Preferences dialog opens with the General
options available. Note the names of the Preferences sections at the top of the dialog. You can reset the
preferences to the Livescribe Desktop factory settings at any time by pressing the Factory Settings button
available on each preference dialog.

2. In the General section, choose if you would like to automatically launch Livescribe Desktop when you dock
a smartpen. Also choose if you want to auto-install all newly-purchased apps and software updates.

3. In the Paper section, choose the default ink color and the color for active and animated ink. You can also
choose to show or hide blank pages and draw or hide page background images (ruled lines and so on).

4. In the Audio section, set the playback latency (in seconds). This setting rewinds your audio playback up to
ten seconds from when your writing occurred. This compensates for written notes that lag behind the recorded
audio, which occurs as you write notes about something shortly after hearing it. The lag varies depending
on your note-taking style.

5. In the Software Update section, specify how Livescribe Desktop checks for updates of software and firmware.

About Paper Replay
When you start your smartpen, it is ready to capture anything you write on Livescribe Dot Paper.

Your smartpen captures and stores your notes as digital ink. You can then send your notes to your computer or
other destinations using Livescribe Connect or Livescribe Desktop. When you are taking notes without the need
to record audio at the same time, simply start your smartpen and begin writing.

To record audio as you take notes, use the Paper Replay smartpen app. Using Paper Replay, your smartpen
records audio and links it to what you write. Later, you can tap on any of your notes and hear the audio recorded
from that moment. Each time you use Paper Replay, it stores the information it captures as a Paper Replay
session.

You also can use Paper Replay to record audio only. The resulting audio is a standalone recording not linked to
your notes. This kind of recording is called a paperless session.

You can add notes to any audio recording (even paperless sessions) by playing back pre-recorded audio and
writing as you listen. This process is called annotating and is useful when you need to clarify or expand your
notes by reviewing the audio.

To start and stop a Paper Replay session and control session playback,  use the Paper Replay controls printed
on all Livescribe Dot Paper.
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Note:

The Paper Replay printed controls are not page-specific. For example, you can tap the Record button on
one page to start recording, and then tap the Stop button on a different page to stop recording.

About Paper Replay Sessions

When you begin recording with the smartpen, your smartpen automatically links the audio to anything you write
on Livescribe Dot Paper. The recorded audio (and any linked written notes) is called a Paper Replay session.

Important facts about sessions:

• Notes not linked to audio are just notes. They are not part of a session.

• A session always contains audio.

• A session can optionally include written notes (pages) linked to the audio. However, you can record audio
only, known as paperless sessions.

• A session begins when you start recording audio and ends when you stop recording audio.

• Pausing and unpausing a recording does create separate sessions. The paused and unpaused session remains
as one. Starting and stopping recordings creates separate sessions.

• You can have one session that spans multiple pages, such as when taking many notes while recording a long
lecture or meeting.

• Starting and stopping recording multiple times per page creates multiple sessions on that page.

• By default, sessions are named on your smartpen and Livescribe Desktop based on the time and date they are
created. For example, if a session is started on June 03, 2011, at 12:22PM, it is named and displayed as 06.03.11
12:22p.

Viewing Notes and Playing Back Audio In Livescribe Desktop

In Livescribe Desktop, you can view your notes and play back audio recordings made with Paper Replay. In
Livescribe Desktop, notes that have linked audio appear as green ink. Livescribe calls this ink active ink.

To listen to audio recordings that are linked to your notes, click on the active ink using your mouse or other
pointing device. Clicking active ink is similar to tapping your paper notes to begin audio playback on your

smartpen. When you mouse over ink that is active, the mouse cursor changes to a pointing hand cursor to help
you identify where you can click to begin audio playback.

If you annotated your notes (added notes while playing back an audio recording), Livescribe Desktop shows this
ink as blue. This ink is also active. You can click on it to play back the audio at the point where you added the
notes.

Note:

You can change the color of active and inactive ink by setting a user preference.

Livescribe Desktop for Mac Basics
Livescribe Desktop provides views, menus, toolbars, and controls you can use to view and manage notes and
audio transferred from your smartpen.
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Running Livescribe Desktop
To run Livescribe Desktop, follow these steps.

1. Launch Livescribe Desktop.

2. Dock your smartpen using a charging cradle (for Pulse smartpens) or Micro-USB cable (for Echo smartpens).

If your smartpen is authorized for the computer you are using, data transfer begins automatically.

3. Watch the progress bar and wait for the transfer confirmation message. Once you dock your smartpen, do
not remove it until transfer is complete. If you do, the next time you dock your smartpen the transfer process
begins again.

You may want to dock your smartpen overnight if it has a large amount of data on it, as it may take an hour
or so to transfer the data the first time you dock.

When transferring notes and audio to Livescribe Desktop, the original notes and recorded audio remain on
your smartpen. In this sense, transferring actually means copying content from your smartpen to Livescribe
Desktop.

Make sure to use the USB Mobile charging cradle (for Pulse smartpens) or Micro-USB cable (for Echo
smartpens) that came with your smartpen. Pulse smartpen models that have a power symbol  printed on
the power button are only compatible with USB mobile charging cradles that have SKU: AAA-00012 printed
underneath. These cradles are compatible with all Pulse smartpens. Pro Charging Cradles, which ship with
Pro Packs and are also available for individual purchase, are compatible with all Pulse smartpen models.

Backing Up Your Livescribe Files

Back up Livescribe Desktop files just as you would any other important files on your computer.

1. Quit Livescribe Desktop.

2. Click Go > Home > Library > App Support > Livescribe.

3. Copy the Livescribe folder to a backup device such as a CD, DVD, or external drive. You can also use
Apple’s Time Machine app to back up your Livescribe Desktop files.

Quitting Livescribe Desktop

Quitting Livescribe Desktop closes the Livescribe Desktop App, disconnects you from Livescribe Online, and
ends the connection between your computer and your smartpen.

• Click the red Close button at the top left corner of the Livescribe Desktop App
• Go to the Livescribe Desktop > Quit Livescribe Desktop.

Viewing Notes
With Livescribe Desktop, you can view notes transferred from your smartpen.

Viewing Thumbnails

In Thumbnail View, you can see all your pages at once as thumbnails. When you find the notes you want to
study, you can open them to full size. Optionally, click on green active ink to hear the audio captured with your
notes.
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1. Select the notebook you want by clicking on its name in the Navigation Pane. As soon as you select a notebook,
its pages appear as thumbnails in the Central Viewing Pane.

2. Select a page you want to view in full size by double-clicking its thumbnail, or clicking the single-page 
button next to the zoom slider.

You can switch between Thumbnail and Single-Page Views by clicking the thumbnail  or single-page

 buttons next to the zoom slider with a thumbnail selected.

Viewing a Single Page

Use Single-Page View to read, search, export, and print your notes. From this view, you can also listen to audio
recordings as you read your notes, and upload your notes to your personal space on Livescribe Online.

To view notes in Single-Page View:

1. Under The Pages Category in the Navigation Pane, click your notebook. This opens the page in the Central
Viewing Pane. Then locate and click the page you want to view.

2. Read your notes using your computer’s screen, and optionally print them.

Paging through a Livescribe Dot Paper Product

As an alternative to clicking on thumbnails, you can use the hovering Page Control or the page controls at the
bottom of the page.

Type the page number in the text box on the toolbar and press Enter. Note that Livescribe Desktop shows the
total number of pages in the notebook beside the text box. Use the Page Controls to move from page to page, or
to the beginning or end of the document.

Tip:

Another way to page through a notebook is to use paging options in the Go menu. Note the keyboard
shortcuts at the right of each command.

Note:

When you select a page, Livescribe Desktop highlights its thumbnail in blue.

First page: Shows the first page in your notebook that contains notes.

Previous page: Shows the previous page in your notebook that contains notes.

Next page: Shows the next page in your notebook that contains notes.

Last page: Shows the last page in your notebook that contains notes.

Current page number: Shows the currently shown page. You can also enter a valid page number in this field to select
a specific page.
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Zooming Pages

You can zoom into or out of a selected page or thumbnail.

1. Open a page or double-click on a thumbnail.

2. Drag the Zoom slider  to enlarge or reduce the size of the shown page or thumbnail.

Click a point on the slider bar to snap to that zoom level.

As an alternative, use the Zoom percentage options in the View menu.

Double-click a page to return to Thumbnail View or click the thumbnail  button next to the zoom slider.

Double-click a thumbnail to go to Single-Page View, with the page fitting into the Central Viewing Pane,
or click the single-page button next to the zoom slider.

Repositioning a Zoomed Page

When you zoom a page to a size that is larger than 100%, Livescribe Desktop crops some of the page. You may
want to reposition the page to view its content.

• Use the vertical and horizontal scroll bars to move the page to your preferred location.
• Instead of using the scroll bars, reposition a zoomed page using the panning hand . To move the page,

click-and-drag the page to the desired position.

Viewing Pages Linked to an Audio Recording

From Audio View, you can open pages linked to an audio recording to view the page and listen to the audio.

1. Click the row that contains the audio recording whose notes you want to view. It must have a page icon in
the Pages column. The number beside the page icon indicates how many pages are included in the selected
audio recording.

2. Double-click on the audio recording to begin playing it.

The Now Playing pane opens and shows the thumbnail of the pages linked to the audio recording.

3. Double-click on a thumbnail in the Now Playing pane to see the page in full size.

Converting Handwriting to Text
You can purchase MyScript® for Livescribe to convert your handwritten notes to digital text.

MyScript for Livescribe is a desktop App from Vision Objects® that is sold separately (visit
www.visionobjects.com). After purchasing and installing MyScript for Livescribe, you can export your notes
using Livescribe Desktop.

1. Select one or more pages.

2. Click the MyScript button . This launches MyScript for Livescribe and converts your pages.

For more information on how to set up and configure MyScript® for Livescribe, refer the Help provided with
it.
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Copying and Pasting Pages to Other Apps

You can copy Livescribe pages to the Clipboard and paste them into other apps. Livescribe Desktop saves the
content you copy from the Central Viewing Pane to the Clipboard as an image.

To copy a page in Single-Page View:

1. In single Single-Page View, press the Command and C keys. Alternately, click on the page and select Copy
from the Edit menu.

2. In another App, use the Paste command to insert an image of the Livescribe page into a document.

Searching Notes
With Livescribe Desktop, you can search notes transferred from your smartpen.

Searching Pages

You can search notes written in cursive, print, or a combination. Search accuracy depends on the neat-ness and
consistency of your handwriting. The Search command can locate whole words. Your search text can be part of
a word, a whole word, or consecutive words.

1. Type your search term into the Search text box .

2. Press Return. By default, this searches for the term in all your notebooks.

To search only in the currently selected notebook, click the Spotlight icon  in the Search text box. Check
Search Only Selected Notebook in the Search menu.

3. Livescribe searches for the term and shows the total number of pages on which the term is found, and
thumbnails of pages containing the search text. The search results are highlighted in orange.

4. Double-click a thumbnail to see it in Single-Page View.

5. If your notes are active ink, play back the audio recording by clicking active (green) text.

Search Tips

• Search works only for alpha-numeric characters. Special characters are not supported.
• For a case-insensitive search, type a search string that is all lower case. For example, typing “apple” looks

for “apple”, “Apple”, and “APPLE”. For a case-sensi-tive search, type the search string containing the mixed
case you want to find. For example, typing “Apple” only looks for “Apple”.

• Click the Spotlight icon  to see up to 10 previously entered search items. Select one from the list and press
Return to search for that item.

• When there is an entry in the Search box, an X icon appears at the right. Click the X icon to clear the Search
text. Livescribe Desktop returns to Thumbnail View.

• To retain the focus of a search result, select it before you clear your results.

Playing Back Audio
With Livescribe Desktop, you can play back audio transferred from your smartpen.
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Playing Audio while Viewing Pages
With Livescribe Desktop, you can play audio while viewing its linked pages. You can also play audio in Audio
View.

If you play back an audio recording that spans multiple pages, Livescribe Desktop automatically moves to
successive pages in real time synchronization with the playing audio. This automatic paging continues until you
manually switch pages using Paging Controls. From then on, the paging is under manual control only until you
play back another audio recording.

1. Listen to recorded audio linked with your notes by clicking on the ink. Hover the mouse cursor over the green
active ink that corresponds with the audio you want to hear. The mouse cursor changes to a pointing hand

 when hovering over active ink.

2. Click on the green text. The audio you recorded with your notes plays back through your computer's speakers.
As the audio plays back, the linked notes changes to a darker shade of green. When playing back audio,
Audio Controls open to give you playback options.

Getting Information About Audio Recordings

You can get information about audio recordings on a page using Get Info. The information includes the date
and time the audio recording is started, and its size (MB) and length.

In Thumbnail or Single-Page View, select the page and choose File > Get Info, or use press  -I.

Browsing a List of Audio Recordings
Use the Audio View to see a list of audio recordings captured with Paper Replay. From this view, you can listen
to your audio recordings and upload them to your personal space on Livescribe Online.

From Audio view, you can also export audio recordings, delete audio recordings from your smartpen and from
Livescribe Desktop.

Use Audio View to manage your audio recordings as computer files. Each row on the Audios list contains the
details of a single audio recording stored on your Macintosh. The column titles describe the information types
that are summarized. Sort the list by clicking column titles.

1. In the Navigation Pane, click on Audio under the Audio folder. All audio recordings stored on your computer
appear as a list in Audio View.

2. Select an audio recording for review by clicking anywhere on its detail line. An audio recording can consist
of audio only, or audio linked with pages. Audio-only has no icon in the Pages column.

Audio Recording columns

In Audio View, Livescribe Desktop shows your audio recordings as a series of rows with named columns. Click
a column title to sort the list by that title. See below for a description of each column.

DescriptionColumn

Audio playing: Identifies which file is currently playing audio.

The number of note pages linked to an audio recording. Some audio recordings have no note pages.Pages

The default name of an audio recording: the time and date it began.Session Name
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DescriptionColumn

The name of the notebook that contains the selected audio recording.Notebook(s)

The length of the audio recording.Duration

The audio recording start time.Recorded

The size of the audio recording in MB or KB.Size

A check mark indicates if an audio recording is on your smartpen or if it is removed.On Smartpen

Smartpen that captured the audio.Pen

Playing Audio from Audio View

1. Double-click anywhere in an audio recording's row.

2. Select an audio recording’s row and from the Audio Controls menu, click Play.

3. Click the audio control button  below the Central Viewing Pane to open the Audio Controls and click

the Play  button.

About Audio Controls
Use Audio Controls to change how audio plays back.

As you listen to an audio recording, the Audio Controls pane opens automatically. You can also open Audio

Controls anytime by clicking the audio control button .

Play the audio.

Stop playback

Jump back 10 seconds.

Jump forward 10 seconds.

Jump to previous bookmark.

Jump to next bookmark.

Slow down or speed up the audio playback.
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Adjust the volume.

Move backward or forward in the audio recording.

Renaming an Audio Recording in Livescribe Desktop

Changing the name of an audio recording from its default — the date and time it is recorded — to a name that
reflects the audio recording's content makes it easier to locate in the future.

1. In the Audio Name column, click on the name of the audio recording whose name you want to change. After
a few moments click again. The current name is highlighted.

2. Type the new name and press Return. The new name replaces the old one.

Printing
With Livescribe Desktop, you can print notes transferred from your smartpen. You can also print your own
Livescribe Dot Paper notepads.

Printing a Single Page

You can print pages from Pages view, Thumbnail View, or Audio View.

1. View or select the page in Single-Page View or Thumbnail View.

2. Choose File > Print. The Print dialog opens.

3. Click Print.

Printing Multiple Pages from Thumbnail View

You can print a range of contiguous pages or a set of non-contiguous pages as follows. The simplest method is
to print from Thumbnail View.

1. Multi-select a range of pages in Thumbnail View.

2. Choose File > Print. The Print dialog opens.

3. Click Print.

Printing Multiple Pages from Single-Page View

You can print a range of contiguous pages or a set of non-contiguous pages from Single-Page View.

1. In Single-Page View, view a page.

2. Choose File > Print. The Print dialog opens.

3. Specify the page range from the printable pages shown in the Print dialog.

If the page numbers in your notebook are not continuous, then the page numbers in the print pane differs
from the page numbers in your notebook.  Please use the preview on the print pane to verify that the you are
printing the correct pages. You cannot print an empty page range.

4. Click Print.
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Hiding Page Backgrounds When Printing

You can set a preference to show or hide page backgrounds when viewing, exporting as PDF, or copying and
pasting into other apps.

1. Go to File > Preferences and choose the Paper tab.

2. To hide backgrounds, uncheck Draw backgrounds.

Printing Your Own Notepads

Using Livescribe Desktop, you can print your own notepads using a color laser printer that can print 600 dpi or
greater.

Testing Your Printer

1. Choose Tools > Print Your Own Notebook.

2. Select a printer. Livescribe Desktop automatically selects the first qualified printer you have in your printer
list.

3. Click Print Test Page.

4. When the test page is finished printing, follow the instructions printed on the page using your smartpen. The
instructions ask you to write some words in each of four areas and then dock your smartpen to your computer.

5. Next, in Livescribe Desktop, examine the test page after it has transferred from your smartpen. If all of your
words transfer successfully, then your printer can print Livescribe Dot Paper and you can begin printing your
own notebook.

Printing a Notebook

1. Choose Tools > Print Your Own Notebook

2. Select a printer. Livescribe Desktop automatically selects the first qualified printer you have in your printer
list.

3. Select a notebook to print such as Notebook 1 (25 pages).

4. Click Print.

Livescribe Desktop prints the notebook. You can use the notebook just like any other Livescribe Dot Paper.
When you dock your smartpen after writing on this notebook, your content transfers like it does with
pre-printed Livescribe note-books and journals.

You should archive this notebook before printing and using it again.

Organizing Notes and Audio
With Livescribe Desktop, you can organize notes and audio transferred from your smartpen.

Creating a Custom Notebook
You can create Custom Notebooks in Livescribe Desktop to organize and better manage your pages.

You can add pages from any notebook, and drag them to arrange them in any order within a Custom Notebook.
Pages in a Custom Notebook work like other notebook pages. For example, you can view, zoom, search, and
print pages.
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Note:

A Custom Notebook is similar to a music playlist, or a digital photo album, but instead of pointing to
songs or pictures, it points (links) to pages in their source notebooks.

1. Choose File > Create Custom Notebooks.

Livescribe Desktop creates an empty custom notebook and places it in the Navigation pane under the heading
Custom Notebooks.

2. To add pages to a custom notebook, select one or more pages in Page View and drag and drop them onto the
custom notebook in the Navigation pane.

3. To add pages from Audio View, select one or more audio recordings that have linked pages and drag and
drop them onto the custom notebook.

Organizing Custom Notebook Pages

You can organize the pages in a Custom Notebook by simply dragging, moving, and dropping them into their
new order.

1. Open a Custom Notebook in Page View.

2. Select a page to be moved.

3. Drag, move, and drop the page into its new location. The pages are automatically renumbered in the Livescribe
Desktop view.

Deleting a Custom Notebook
You can delete a Custom Notebook or pages from a Custom Notebook. Deleting a Custom Notebook or pages
from a Custom Notebook does not affect the source notebooks or their pages.

1. Select a Custom Notebook in the Navigation pane.

2. Choose File > Delete Notebook

3. At the prompt, click Yes to confirm the deletion.

Deleting a Custom Notebook Page

1. Open a Custom Notebook in Page View.

2. Select one or more page to be deleted.

3. Choose File > Delete Page(s)

4. At the prompt, click Yes to confirm the deletion.

Managing Storage for Livescribe Desktop and Your Smartpen
With Livescribe Desktop, you can manage its storage of notes and audio, and the storage on your smartpen.

Freeing Smartpen Storage

Your smartpen uses flash storage to store your notes and audio, as well as apps and system files. Use the Livescribe
Desktop Memory Bar to monitor the data storage remaining in your smartpen.
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To display the Memory Bar: in the Navigation Pane, open the Applications folder by clicking the arrow on the
left, and then select Smartpen Applications. The Memory Bar appears at the bottom of the Central Viewing
Pane.

The Memory Bar shows:

• Total storage capacity of the smartpen (both used and free)

• Storage used by system software

• Storage used by apps

• Storage used by content you created

• Available storage

Audio recordings require the most space. If your smartpen is running out of space, remove some of its audio
recordings.

• Choose and remove an audio recording in Audio View.
• Archive any notebooks, journals and other paper products you are finished with. See .
• On your smartpen, use the Menu to select the audio recording you want to delete and remove it.

Removing Audio from Your Smartpen

You can remove one or more audio recordings from your smartpen with Livescribe Desktop. You can also delete
audio recordings from Livescribe Desktop itself. Removing an audio recording from your smartpen does the
following:

• Frees up storage space on your smartpen

• Removes the audio recording from your smartpen. Your smartpen no longer interacts with the notes on the
Livescribe Dot paper for the removed audio recording. That is, when you tap the notes linked to the removed
audio recording, there is no audio playback.

To remove all audio recordings from your smartpen for a specific notebook, journal or other paper product, use
the Archive feature.

1. In Audio View, locate and single-click the audio recording to be removed. To select multiple audio recordings,
shift-click to choose adjoining items and  -click to choose non-adjoining items.

2. Press the Delete key, or Choose File > Remove Audio Recording from Smart-pen. You can also choose
the contextual menu item by pressing control-click.

3. At the prompt, confirm the removal. You can confirm that an audio recording is no longer on your smartpen
by looking at the On Smartpen column in Audio View. If the audio recording is on your smartpen, the audio
recording’s row in this view shows a check mark in the column. If the audio recording is not on your smartpen,
the column is empty.

4. At the prompt, confirm the deletion.

Backing Up Your Livescribe Data Folder

Livescribe recommends that you regularly back up Livescribe Desktop files just like other important files on
your computer. Backing up your files protects you from losing important files in case your computer becomes

Livescribe User Guides160



damaged, lost, or stolen. If you later need to restore your Livescribe Desktop files, contact Livescribe Customer
Service for instructions.

You can find all files linked to Livescribe Desktop in your Livescribe folder. This folder contains your notes
and audio, as well as important information about your smartpen and Livescribe Desktop. By default, Livescribe
Desktop creates the Livescribe folder in these locations:

1. Quit Livescribe Desktop.

2. Locate your Livescribe folder.

3. Copy the folder to a backup device, such as a CD, DVD, or external drive.

Deleting Audio Recordings from Livescribe Desktop

You can delete audio recordings from Livescribe Desktop.

1. First, remove the audio recording(s) from your smartpen as described in . You can con-firm that an audio
recording is no longer on your smartpen by looking at the Location column in Audio View. If the audio
recording is on your smartpen, the audio recording’s row in this view shows a check mark in the On Smartpen
column. If the audio recording is not on your smartpen, the Location column is empty.

2. In Audio View, single-click the audio recording to be deleted from Livescribe Desktop. To select multiple
audio recordings, shift-click to choose adjoining items and  -click to choose non-adjoining items.

3. Press the Delete key on the keyboard. Or, choose File> Delete Audio Recording from Livescribe Desktop,
or open the contextual menu item by pressing control-click.

If you select multiple audio recordings to delete from Livescribe Desktop, and one or more are still on your
smartpen, Livescribe Desktop shows the File > Remove Audio Recording from Smartpen menu option. This
allows you to remove the audio recordings from your smartpen first. When all audio recordings are removed,
Livescribe Desktop shows the File> Delete Audio Recording from Livescribe Desktop menu option so you
can continue deleting your selected audio recordings from Livescribe Desktop.

4. At the prompt, confirm the deletion.

Archiving Livescribe Dot Paper on Mac
When you have finished using a Livescribe Dot paper product, you should archive it in Livescribe Desktop.

Archiving Paper Products

Archiving a Livescribe Dot paper product does the following:

• Frees up storage space on your smartpen

• Enables you to use another Livescribe Dot paper product that has the same dot pattern as the one you archived.
Livescribe Dot paper products with the same dot pattern have the same name.

• Moves your notes and audio for a Livescribe Dot paper product into an Archived Notebooks folder in the
Library Pane of Livescribe Desktop. Your notes and audio remain interactive in Livescribe Desktop, just like
non-archived Livescribe Dot paper products.

• Deletes your notes (ink data) and audio from your smartpen. Because of this, your smartpen no longer interacts
with the physical Livescribe Dot paper product that you archived. That is, when you tap the notes in your
archived physical notebook, they do not play back any audio.
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Important:

Do not archive a notebook unless you are finished using the physical notebook and are ready to set it
aside. After you have archived a notebook, do not go back to its physical notebook and start writing on
it again, unless you have unused pages and want to treat them as a part of a new notebook. For example,
you could archive a notebook that is partially completed, and then use the remaining pages as a second
notebook. If you are using multiple computers to manage your smartpen data, be sure to archive your
notebooks on all of these computers.

1. In the Navigation pane, click the notebook you want to archive.

2. Choose File > Archive.

3. When prompted, click Archive to confirm the archive operation, otherwise click Cancel.

Livescribe Desktop confirms your notebook is archived, and you see the archived notebook under the Archived
Notebooks group in the Navigation pane.

Deleting an Archived Notebook

1. Select a notebook to be deleted under Archived Notebooks.

2. Choose File > Delete a Notebook.

3. At the prompt, click Yes to confirm the deletion.

Deleting archived content from Livescribe Desktop removes the content permanently. You cannot recover
the archived content by docking your smartpen because the process of archiving the content removed it from
your smartpen.

Managing Your Smartpen
With Livescribe Desktop, you can manage properties of your smartpen, including registration, naming, and Paper
Replay password.

Registering Your Smartpen

It is important that you register your smartpen. Registering your smartpen:

• Creates your personal MyLivescribe account with 500MB of free storage.

• Allows you to broadcast or privately share your notes and audio online.

• Enables you to install smartpen apps from our online software store.

• Qualifies you to install free smartpen apps after registering!

• Provides enhanced security for your smartpen data.

To register your smartpen

1. After you name your smartpen, Livescribe Desktop prompts you to register it with Livescribe. Before you
click Register Now, make sure to connect to the internet.

If you click Remind Me Later, Livescribe Desktop reminds you to register the next time you dock your
smartpen.
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You can register your smartpen anytime by selecting the Register option in the Livescribe Desktop menu.

2. Click Register Now. The Livescribe Account page opens.

If you do not already have a Livescribe account, click Create New Account, and then enter your email
address and a password.

Your email address is your user name next time you log in.

Your password must be at least four characters long and no longer than 64 characters. Your password is case
sensitive, and cannot begin with a space or contain characters that are not printable. Your password and user
name cannot be the same.

3. If you already have a Livescribe account, the process enters your account name automatically. If you forgot
your password, click the Forgot Password button and Livescribe emails instructions on resetting your
password.

4. If you do not already have an account, click Create. The Account Information page opens.

5. In the Account Information page, fill in the required fields and click Continue to complete the registration
process.

Registering Your Smartpen Manually

Livescribe Desktop prompts you to register your smartpen when you dock it. If you choose to ignore this request,
you can later manually register your smartpen.

1. Dock the smartpen to be registered.

2. Choose Tools > Smartpen > Register Smartpen.

3. Follow the prompts to register.

Renaming a Smartpen on a Mac
You can rename your smartpen to identify it from other smartpens in Livescribe Desktop.

1. Launch Livescribe Desktop.

2. Dock the smartpen to be renamed.

3. If it is not already selected, use the smartpen selector drop down to choose the smartpen you want to rename.

4. Choose Tools > Smartpen > Rename Smartpen.

5. At the prompt, type the smartpen name and click Rename.

Removing a Paper Replay Password
On your smartpen, you can create a password for your audio recordings. Setting a password can prevent others
from listening to your recorded audio on your smartpen. When Paper Replay is protected, audio play back is
prevented until the password is entered on your smartpen.

You can remove a Paper Replay Password from your smartpen using your smartpen’s Main Menu, or using
Livescribe Desktop.

To remove a password using Livescribe Desktop:

1. Launch Livescribe Desktop.

2. Dock your smartpen.

3. Choose Tools > Smartpen > Clear Paper Replay Password.

4. Confirm the password is cleared by playing back a Paper Replay audio recording on your smartpen. If the
password is cleared, you can play back audio recordings without writing the password first.
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Paper Replay Password does not prevent playback from Livescribe Desktop, only from your smartpen.

You cannot set your Paper Replay Password using Livescribe Desktop. You must set it from your smartpen’s
Main Menu.

Managing Smartpen Software and Apps on a Mac
You can install and update smartpen software and apps using Livescribe Desktop.

Installing Smartpen Software Updates
Livescribe periodically updates smartpen apps (such as Paper Replay) and underlying smartpen firmware.
Livescribe also updates this software to support new kinds of Livescribe Dot Paper.

When you dock your smartpen and launch Livescribe Desktop, it checks for available updates. You can also
manually check for updates using Livescribe Desktop.

Note:

If you try to use a new Livescribe Dot Paper product, and get an error message that it is “not supported”,
you need to update your smartpen software.

1. Dock your smartpen.

2. Launch Livescribe Desktop.

Livescribe Desktop automatically checks for recent updates.

3. Accept the updates.

Livescribe Desktop downloads and installs them to your smartpen.

If you choose to postpone transferring updates to your smartpen, you can re-initiate the transfer process by
undocking and re-docking your smartpen. Livescribe Desktop prompts you to transfer available items.

Checking for Updates Manually
By default, Livescribe Desktop automatically downloads and installs apps and their updates when you dock a
registered smartpen.

This feature is called Auto-Install. You can disable this feature by changing the Smartpen user setting.

At any time, you can manually check for updates to Livescribe Desktop, smartpen firmware, and apps you have
purchased:

1. Choose Help > Check for Updates in the Menu.

2. Accept the recommended updates.

Getting More Apps
Livescribe and other companies offer new apps for your smartpen. You can download these from the Livescribe
Online Store.

1. From a web browser, go to www.livescribe.com/store and browse the apps available.

Some apps are free and others are available for purchase. These apps are designed to work like the built-in
apps that come with your smartpen.
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2. After you download a new app, use Livescribe Desktop to add it to any smartpen registered to your Livescribe
account.

Livescribe Desktop installs downloaded apps to your smartpen under a new Applications menu. This menu
is the first menu item underneath the Main Menu and is available after you install your first downloaded app.

Purchasing Apps
Using the Livescribe Online Store, you can purchase and download new apps for your smartpen from Livescribe
and other vendors.

1. From Livescribe Desktop, click Livescribe Store in the Livescribe Online view.

Alternatively, go to www.livescribe.com from your web browser and click on the Community tab to go to
Community page.

2. Click the Log In button  to go to Livescribe account.

3. Click on the Store tab. From the store page, you can browse and purchase apps.

4. Select an application to purchase by clicking its Add button. Optionally, look at the application’s details
page.You can also download documentation for the application from its details page.

5. Click Add to Cart to add the application into your shopping cart. This opens your shopping cart and begins
the four-step purchasing process.

6. Click the Continue to Checkout button.

7. Add or confirm your billing and shipping information.

8. Confirm your purchase and place your order by clicking the Place Order button.

9. After placing your order, click the Download and Add Smartpen Applications button. You can then
download your apps to Livescribe Desktop and add them on your smartpen(s).

By default, your apps are automatically download and added to your currently-docked smartpen.

10. Confirm the added apps in the Applications View.

Adding Apps

The Applications View lists all apps that you have downloaded from Livescribe Online, and those apps already
added to your currently-selected smartpen.

Tip:

By default, all apps you purchase are automatically downloaded and added to your smartpen when docked.
If you disable this feature and need to manually add purchased apps, follow the procedure below. You
can also use this feature if you removed an application from your smartpen and want to add it back.

To add an application manually:

1. Dock the smartpen on which you want to add the application.

2. In the Applications View, locate the application you want to add to your smartpen.

You see a list of all the apps you have downloaded, including those you have already added to your smartpens
and those waiting to be added.

3.
Click the add button  to add the application to the smartpen you have docked.

The Applications View shows the progress of adding the application under the Status column.
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After the process completes, the Applications View indicates the application is added by showing a check
mark in the Location column.

Removing Apps

The Applications View lists all apps that you have already added to your currently-selected smartpen. If an
application is added to the currently-selected smartpen, the Locations column next to the application shows a
check mark.

To remove an application:

1. Dock the smartpen from which you want to remove the application.

2. In the Applications View, locate the application you want to remove from your smartpen.

3.
Click the remove button  to remove the application from the smartpen you have docked.

The Applications View shows the progress of the removal under the Status column.

4. Confirm that the application is removed.

Viewing Installed and Installable Apps

To view all apps you own and other software installed to your smartpen:

1. Click the Applications menuin the Navigation pane.

2. Next, click Smartpen Applications.

You see a list of all the apps and software you currently own for your smartpen.

Application View list

When you view a list of apps and software in Applications View, Livescribe Desktop shows them as a list of
rows with named columns. The table below describes the columns of the Applications View list.

DescriptionColumn

The name of the applicationApplication Icon and Name

Version of the applicationVersion on Smartpen

The size of the application in MB or KBSize

A check mark indicates the application is added to the currently-selected smartpen. If the application
can be removed from this smartpen.

Location

indicates the application is ready to be added to the currently-selected smartpen. Click on this
button to add the application to this smartpen.

Add/Remove

indicates the application can be removed from the currently-selected smartpen. Click on this
button to remove the application from this smartpen.

Describe the status of the current application, such as whether the application is current, needs to
be added, and so on.

Status
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Using Livescribe Online
Livescribe Online is your connection to your Livescribe account and to content shared by the Livescribe
community. You can connect to Livescribe Online either from a web browser or directly from within Livescribe
Desktop.

About Livescribe Online

Setting up a Livescribe account creates a personal space for you on Livescribe Online called MyLivescribe. This
is a personal area reserved for you. There you can set up your account profile, upload and store content to share
with your friends, the community, or anyone on the web.

Sending Content to Livescribe Online

To send pencasts using Livescribe Online, upload a pencast to using the Upload to Community sharing option.

After uploading a pencast to Livescribe Online, you can set your Sharing Preferences on your MyLivescribe
account. There are several methods available to share your content.

Emailing Content to a Friend from Livescribe Online

Choose the Email a Friend preference to share content with a friend via email:

1. Select a file. To select a file from the Livescribe Online Community, click the file’s thumbnail to view it.
To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files area to
view it.

2. On your MyLivescribe page, click on Email a Friend.

3. Enter your friend’s email address in the To field.

4. Optionally, add a message in the Personalize It section.
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5. Click Send. Your friend receives an email that links him or her to your file on Livescribe Online. If your
content is private, your friend must create a Livescribe Online account. Their user-name must be the email
address you sent the invitation to.

To select multiple friends to send a file to, just check the box next to each friends email address in your
Address Book before clicking the Send button.

When you send the invitation, Livescribe Online automatically adds your friend to your Contact list for future
ease of sharing. As you share more files, your Address Book contact list grows.  Use the gray Edit a Contact
button to add a friend’s name or edit an email address.  Use the red Delete a Contact button to remove an email
address from the list.

Download a PDF Document from Livescribe Online

You can use the Download as PDF preference to download to your computer your uploaded content in PDF
format. You can then share this PDF file with others via email or other means.

1. Select a file. To select a file from the Livescribe Online Community, click the file’s thumbnail to view it.
To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files area to
view it.

2. Click on Download as PDF. The file is downloaded in PDF format to your computer.

Get a Web Link to Your Content on Livescribe Online

Use the Get a Link to this file preference to obtain web link to your content that you can paste in a blog or
elsewhere.

1. Select a file. To select a file from the Livescribe Online Community, click the file’s thumbnail to view it.
To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files area to
view it.

2. Click on Get a link to this file. If the file is on your MyLivescribe page and private, make it public.

3. In the Get a link for this file dialog, highlight the link and copy it to the clipboard.

4. Open your HTML editor for your blog or other web page.

5. Access the HTML edit area and click in the edit field. Make sure you are in HTML edit mode, not Text
composition mode.

6. Paste the text.

7. Publish the file.

8. In Livescribe Online, click Done to close the dialog window.

Sharing Content on Facebook through Livescribe Online

Use the Share on Facebook preference to embedded content into your website, forum, or blog.  You can only
embed public files.

Files posted to the general Livescribe Online Community are public and available for embedding. If the file you
want to embed is on your MyLivescribe page, you must first make it public.
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1. Select a file. To select a file from the general Livescribe Online Community, click the file’s thumbnail to
view it. To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files
area to view it.

2. Click Share on Facebook.

3. Facebook prompts you to log in unless you are already logged in.

4. If you would like to share content by posting to your Facebook page, use the Post to Profile tab. The posting
appears on your Facebook Home page.

5. If you would just like to share content by email, use the Send a Message tab. The recipient gets an email with
a link that they can use to access the file.

Embedding Content in a Website or Blog With Livescribe Online

Use the Embed this file preference  to embedded content into your website, forum, or blog.  You can only embed
public files.

Files posted to the general Livescribe Online Community are public and available for embedding. If the file you
want to embed is on your MyLivescribe page, you must first make it public.

1. Select a file. To select a file from the Livescribe Online Community, click the file’s thumbnail to view it.
To select a file from your personal MyLivescribe space, click the file’s thumbnail in the My Files area to
view it.

2. Click the Embed this file link. If the file is on your MyLivescribe page and private, make it public.

3. In the Embed this file dialog, highlight the HTML code and copy it to the clipboard.

4. Open your HTML editor for your website, forum, or blog.

5. Access the HTML edit area and click in the edit field. Make sure you are in HTML edit mode, not Text
composition mode.

6. Paste the text.

7. Preview the posting in your HTML editor.

8. If the pencast displays and plays back properly, publish the file.

9. Click Done to close the Embed this file window.

Making Content Public or Private on Livescribe Online

Make your uploaded content public to allow others to access it without an invitation. When a file is public,
visitors can view the file without logging in.

Important:

When you upload your Livescribe smartpen content to your MyLivescribe space, Livescribe makes the
content private by default. Making a file public allows anyone to access the file. Livescribe recommends
that you not make any of your confidential files public.

1. Select a file from your personal MyLivescribe space. Click the file’s thumbnail in the My Files area to view
it.

2. Click the Make this file Public (or Private). Making the file public adds the file to the Livescribe Online
Community area so anyone can see it without logging in. If you make the file private, Livescribe Online
removes the file from the Livescribe Community.
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Editing Your Access List on Livescribe Online

The Access List preference controls who can and cannot see a file when it is private. To give your friends
permission to see a private file, add your friend to this list. They are able to see the file when they log into their
Livescribe account.

1. Select a file from your personal MyLivescribe space. Click the file’s thumbnail in the My Files area to view
it.

2. Click the Edit Access List preference to set create an access list for this file.

3. In the Access List dialog, click Add Contact button and type a friend’s email address. Use the gray Edit a
Contact button to add a friend’s name or edit an email address.  Use the red Delete a Contact button to
remove an address from the list.

Managing Your MyLivescribe Account on Livescribe Online

Setting up a Livescribe account creates a personal space for you on Livescribe Online called your MyLivescribe
space. This is a personal area reserved for you. There you can set up your account profile, upload and store
content to share with your friends, the community, or anyone on the web.

Setting Up a MyLivescribe Account

When you register your Livescribe smartpen through Livescribe Desktop, the registration process prompts you
to create a Livescribe account. If you need to, you can also create an account manually without registering (or
even owning a Livescribe smartpen).

You can manually set up a Livescribe account either from Livescribe Desktop or directly from a web browser.
To set up a Livescribe account from a web browser:

1. Go to www.livescribe.com from your web browser and navigate to the Community page by clicking the
Community tab.

2. Click the Sign Up button .

3. Provide a username and password. The username must be a valid email address.

When creating your user name and password, follow these guidelines:

• Your user name is your email address. It cannot be greater than 128 characters and is not case sensitive.
For example, MyName@MyCompany.com and myname@mycompany.com are the same.

• Your password must be at least four characters long and no longer than 64 characters. Your password is
case sensitive, and cannot start with a space or contain characters that are not printable. Your password and
user name cannot be the same.

Using Your MyLivescribe Account

When you create a MyLivescribe user profile, you receive space to store content.

• Select Account in the upper right corner of Livescribe Online.

On your MyLivescribe profile page you see a list of sharing options, viewer comments, and how much space
you have used and you have available.
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Managing Your Uploaded Content on Livescribe Online

From your MyLivescribe space, you can manage content in your Livescribe account as described in the following
table:

DescriptionTask

Select the filename in the central viewing pane and edit it in place.Rename files

Click the thumbnail X icon next to the file name to delete it. This does not remove the
files from your Livescribe Desktop App or your Livescribe smartpen, only from your
online account.

Delete files

Choose a category in which to place your file by clicking on the category name in the
description area and choosing one of the pre-defined categories.

Choose categories for files

You can add short descriptions of your uploaded files by selecting click to edit… under
the Description area and typing a name into the text field.  Edit existing descriptions
by clicking on the existing description and typing into the text field.

Add/Edit file descriptions

Managing Your Account Details on Livescribe Online

From your MyLivescribe space, you can manage your Livescribe account and perform other administrative tasks
described in the following table:

DescriptionTask

Select the name and edit it in place in the upper left area under the My Account section.Change your user name

Click on the unlink option under My Pens in the lower left area under the My Account
section.

Unlink your Livescribe smartpen from your
account

Go to the Edit Login tab in the central Details section and click Change Your Password.Change your password

Go to the Profile tab in the central Details section and click Upload an Avatar Photo.
You may need to log in using a web browser to see this option.

Upload an Avatar Photo

Go to the Profile tab in the central Details section to edit your contact information and
optionally details about you.

Change your contact and personal information

Check or uncheck the option to receive news and offers about Livescribe and related
products.

Subscribe or unsubscribe to Livescribe news and
offers

Viewing Livescribe Online Community Content

In the Livescribe Community, you can see what others are doing with their Livescribe smartpens and post your
own creations for others to rate and comment on.

The Community page has several sections:

Livescribe randomly chooses files to feature on the front page of the Community area.Featured Files

Lists members of the Livescribe Community who provide the highest-rated submissions.
Click on a Featured Contributor to go their MyLivescribe profile.

Featured Contributors

Shows the top-rated content in the Livescribe Community.Top Rated
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Shows visitors which content has been viewed the most.Most Viewed

Visiting the Livescribe Online Store

At the Livescribe Online Store - www.livescribe.com/store - you can purchase additional smartpens, paper
products, Apps, and more. At checkout, you need to log in to your account, or create an account if you have not
already. You can access the Livescribe Store either from a web browser or directly from Livescribe Desktop via
the Livescribe Online view by clicking Livescribe Store.

Connecting to Livescribe Online from a Mac
Livescribe Online is your connection to your Livescribe account and to content shared by the Livescribe
community. You can connect to Livescribe Online either from a web browser or directly from within Livescribe
Desktop.

You can connect to Livescribe Online from within Livescribe Desktop. The Central Viewing Pane becomes a
browser view.

1. From Livescribe Desktop, click My Livescribe under Livescribe Online in the Navigation pane.

2. Log in to Livescribe Online using your Livescribe account.

If you do not have an account, create a new account when prompted to log in. If you forgot your password,
click the Forgot Password button and Livescribe emails instructions on resetting your password.

When you log in, Livescribe Desktop opens your personal MyLivescribe space on Livescribe Online. From
there you can click the Store, Community, and Support tabs to navigate within these areas of Livescribe
Online.

3. To view or change your Livescribe Online account settings, on your home page, click the link “This page
belongs to You”.
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Alternatively, go to www.livescribe.com from your web browser and click on the Community tab to go to

Community page. From there, click the Log In button  to go to your MyLivescribe space.

Shortcuts
You can use keyboard shortcuts and contextual menus for several Livescribe Desktop menu options.

Keyboard Shortcuts

ShortcutCommand

 -CCopy

 -XCut

 -EExport as AAC

 -FFind

 -IGet Info

 -HHide Livescribe Desktop

 -HHide Others

  or F9 (on newer Mac keyboards)Next

 -PPage Setup

 -GGo To Page…

 -VPaste

space/F8 (on newer Mac keyboards)Play/Pause

F7 (on newer Mac keyboards)Play from Beginning

 -,Preferences…

 Previous

 -PPrint

 -QQuit Livescribe Desktop

 -YRedo

DeleteRemove/Delete Audio Recording

 -RRename Notebook
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ShortcutCommand

 -ASelect All

 -KShow Audio Controls

 -ZUndo

 -+Zoom In

 --Zoom Out

Contextual Menus
Instead of using the Livescribe Desktop menu, you can use contextual menus to access many Livescribe Desktop
features.

To use a contextual menu, select an item and control-click.

RenameNotebook

Thumbnail View • Get Info

• Print

• Upload to Community

Single-Page View • Print

• Upload to Community

Audio View • Export as AAC

• Remove/Delete

• Upload to Community
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Livescribe Connect User Guide

Welcome to Livescribe Connect

Livescribe Connect makes it easy to send and share notes and audio with people and destinations of your
choice—all from your paper.

Simply draw a line and write send. Tap the pages you want to send. Notes and audio are automatically sent as
an interactive audio PDF file, called a Pencast.

You can send Pencasts to destinations like Email, Facebook, Google™ Docs, Evernote
®
, and even your mobile

device. You can also send to these destinations from within Livescribe Desktop. Simply drag and drop your
pages to Connector icons to quickly send or share them.

Basic and Premium Connectors

Livescribe Connect supports two sets of Connectors—Connect Basic and Connect Premium. Livescribe Connect
Basic is part of your free download of Livescribe Desktop. Connect Basic includes the following Connectors:

• Computer
• MyLivescribe
• Evernote

®

• Facebook
• Microsoft

®
 OneNote

®

You can purchase the Connect™ Premium Upgrade Pack from the Livescribe Application store. Connect Premium
includes the following Connectors:

• Email
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• Google™ Docs
• Google™ Sites

System Requirements

Livescribe Connect requires:

• PC running Windows® XP SP3, Windows® Vista (32-bit), or Windows® 7 (32-bit or 64-bit). Mac running
Mac OS 10.5.8 or higher.

• Livescribe Desktop version 2.8 or higher. Install it from: http://www.livescribe.com/install
• Smartpen firmware version 2.8 or higher. This is installed to your docked smartpen when you run Livescribe

Desktop version 2.8 or higher.
• Adobe Air 2.6 or higher (installed automatically).
• Adobe Reader 10.0.1 or higher to view Pencast PDF files.

Installing and Configuring
Livescribe Connect consists of two software apps: one for your computer and one for your smartpen.

Install Livescribe Connect on your computer and your smartpen. Then in the computer app, configure Connectors
and modify or create shortcuts for use on your smartpen.

Before Installing the Livescribe Connect Apps
If you recently bought a Livescribe smartpen and installed Livescribe Desktop on your computer, you may
already have Livescribe Connect on your computer and your smartpen.

You should check if Livescribe Connect is installed on your computer and smartpen.

Checking If Livescribe Connect Is Installed on Your Computer
Check for Livescribe Connect on your computer. You check differently on Windows and Mac.
On Windows

Choose Start > All Programs > Livescribe. If you see Livescribe Connect in the Livescribe folder, then
the computer app is installed.

On Mac

Check for the Livescribe Connect icon in your Mac dock. If you see it, then the computer app is installed.

If Livescribe Connect is not on your computer, proceed with installation now.

Checking If Livescribe Connect Is Installed on Your Smartpen
Check the main menu of your smartpen to see if Connect is installed.

1. Double-tap on the center of the Nav Plus.

2. Tap down until you see Connect.

If you see it, the Livescribe Connect smartpen app is installed.

If Livescribe Connect is not on your smartpen, proceed with installation now.
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Installing Livescribe Connect on Your Smartpen and Computer
You can install Livescribe Connect on your smartpen and computer by installing the Livescribe Desktop or by
updating your existing Livescribe Desktop.

Livescribe Connect requires the following versions of desktop and smartpen software:

• Livescribe Desktop version 2.8 or higher on your computer
• Smartpen firmware version 2.8 or higher on your Livescribe smartpen

If you do not have these versions, Livescribe Desktop prompts you to update them before installing Livescribe
Connect.

Installing Livescribe Connect and a New Livescribe Desktop
Installing Livescribe Desktop installs the Livescribe Connect computer and smartpen apps at the same time.

If you have not yet installed Livescribe Desktop on your computer, install it now. Then check for updates that
may be necessary.

1. Disconnect your smartpen from your computer.

2. Install Livescribe Desktop from http://www.livescribe.com/install. Follow instructions in the Livescribe
Desktop installer.

Livescribe Desktop and Livescribe Connect will be installed on your computer.

3. Connect your smartpen to your computer.

Your smartpen firmware will be updated and the Livescribe Connect smartpen app installed.

4. In Livescribe Desktop, select Help > Check For Updates.

You are prompted to update your Livescribe Desktop software and your smartpen firmware—if any of them
need updates.

5. Accept the updates.
Updates will be installed automatically to your computer and smartpen.

To try out Livescribe Connect immediately, skip to Livescribe Connect Quick Start on page 184. Otherwise,
proceed with configuring Connectors.

Installing Livescribe Connect from an Existing Livescribe Desktop
Updating Livescribe Desktop installs the Livescribe Connect computer and smartpen software.

From an existing Livescribe Desktop installation, select all updates. You will receive updates to Livescribe
Desktop and the smartpen firmware. In addition, Livescribe Connect will be installed on your computer and
smartpen.

1. Connect your smartpen to your computer.

2. In Livescribe Desktop, select Help > Check For Updates.

You are prompted to update your Livescribe Desktop software and your smartpen firmware—if any of them
need updates.

3. Accept all updates.

Updates will be installed to your computer and smartpen.

To try out Livescribe Connect immediately, skip to Livescribe Connect Quick Start on page 184. Otherwise,
proceed with configuring Connectors.
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Configuring Connectors
Connectors are plugins to Livescribe Connect that target a particular destination, such as your computer, your
Evernote notebooks, your MyLivescribe space, your Facebook wall, Email recipients, or your Google Docs
collections.

Configure your Connectors before using them. The Connectors tab of the Livescribe Connect computer app
has an icon for each Connector.

If you are currently displaying Livescribe Desktop, you can access Livescribe Connect quickly by clicking an
icon in the Connectors pane of Livescribe Desktop. The Livescribe Connect computer app will display with the
Connectors tab open to the configuration page for the Connector you clicked.

Important:  In Livescribe Connect, click a Connector icon to display the configuration page. Then specify
applicable login information and destination defaults (folder, collection, tags, post descriptions, etc.).

Note:  In the Email Connector, you can also create an Address Book, which you use from the Livescribe
Connect smartpen app.

To configure particular Connectors, click one of the following links:

• Configuring the Computer Connector on page 203
• Configuring the MyLivescribe Connector on page 205
• Configuring Mobile on page 207
• Configuring the Evernote Connector on page 207
• Configuring the Facebook Connector on page 209
• Configuring the Email Connector on page 211
• Configuring the Google Docs Connector on page 215
• Configuring the Google Sites Connector on page 217
• Configuring the Microsoft OneNote Connector on page 220

After configuring Connectors, you can use them to send notes and audio from the smartpen (with Livescribe
Connect shortcuts) or from Livescribe Desktop.

The Switch Connector Dropdown Menu
In the Livescribe Connect computer app, you can quickly move between Connectors during configuration.

The Connectors tab has a Switch Connector dropdown menu in the right-hand corner.

1. Click the Switch Connector control to display available Connectors.

2. Select the name of a Connector.

The configuration page of the Connector displays.

Modifying and Creating Shortcuts
Livescribe Connect shortcuts are how you use Connectors from the smartpen. A shortcut starts the Livescribe
Connect smartpen application with appropriate parameters.

A Livescribe Connect shortcut specifies destination values (folder, collection, tags, post descriptions, etc.) and
sending formats. The destination values override any defaults specified in the configuration page of the Connector.
Certain Connectors allow you to specify additional information. Each shortcut is associated with one Connector,
though a Connector may have several shortcuts.
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Livescribe Connect comes with default shortcuts, which you may modify in certain ways. You can also create
your own custom shortcuts.

Shortcuts specify three kinds of information:

• the Connector to use.

• (optional) refinements of the destination settings of the Connector. These values override the default destination
settings specified in the Connector configuration.

Note:  Custom Email shortcuts allow you to enter email addresses to form a mail list. On the smartpen,
your custom Email shortcut uses the mail list, and the smartpen app does not ask you for selections from
the Address Book.

• the format to send: PDF or PNG Image for notes only; M4A Audio for audio only; Pencast or Pencast PDF for
notes and audio. Formats available depend on which Connector is selected. See Formats For Sending Notes
and Audio on page 221.

Modifying Shortcuts
Modify shortcuts on the Shortcuts tab of the Livescribe Connect computer app.

For default shortcuts, you can modify:

• the destination values, such as Folder for Computer; Notebook and Tags for Evernote; the post descriptions
for Facebook; Collection and Share With for Google Docs.

Note:  In the default Email shortcut, you cannot create a list of email recipients. You select email
recipients from your Address Book while using the default Email shortcut on the smartpen. If you want
to create a mail list, create a custom Email shortcut.

• the Format in which the pages are sent. The formats available depend on which Connector is used.

For custom shortcuts, you can change the Connector, as well.

Modify a shortcut, following these general steps. For details, click one of the links below.

1. Click the row containing the shortcut you wish to modify.

2. Click the down arrow in the Connector column and select a different Connector.

Note: You cannot change the Connectors of a default shortcut.

3. Click the Add... links below the Connector. Specifying values here will override the destination defaults
from the Connector configuration on the Connectors tab.

4. Click the down-arrow in the Format column and select a send format. See Formats For Sending Notes and
Audio on page 221.

5. Click Save.

6. Connect (dock) your smartpen to your computer to transfer new and updated shortcuts to the smartpen.

For information on defining shortcuts for particular Connectors, click one of the links below:

• Defining Shortcuts for Computer on page 204
• Defining Shortcuts for MyLivescribe on page 206
• Defining Shortcuts for Evernote on page 208
• Defining Shortcuts for Facebook on page 210
• Defining Shortcuts for Email on page 213
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• Defining Shortcuts for Google Docs on page 215
• Defining Shortcuts for Google Sites on page 219
• Defining Shortcuts for Microsoft OneNote on page 220

Creating Custom Shortcuts

You can create custom shortcuts for Livescribe Connect. Custom shortcuts specify:

• the Connector to use.

• (optional) refinements of the destination settings of the Connector. Settings you specify here override defaults
specified in Connector configuration.

• the format to send.

Create a custom shortcut by following these general steps. For details, click one of the links below.

1. Click Add Shortcut.

2. Enter a name for the shortcut.

Note: The shortcut name cannot be the same as any other Livescribe Connect shortcut or Connector
name. You may enter all characters recognized by the locale currently selected on your smartpen.
Spaces are allowed. Choose a shortcut name of just a few characters, since you will be writing it often.
The shortcut name displays on the smartpen as you write it.

3. Click the down-arrow in the Connector column and select a Connector.

Additional links may appear, depending on the Connector selected.

4. Click the Add... links below the Connector, if desired. Specifying values here overrides the destination
defaults from the Connector configure page.

Note: When creating a custom Email shortcut, you can enter email addresses to form a mail list. Click
the To, CC, and BCC links to enter email addresses in those fields. On the smartpen, your custom
Email shortcut uses the mail list; the smartpen app does not ask you for selections from the Address
Book.

5. Click the down-arrow in the Format column.

The menu contains available formats for the Connector. See Formats For Sending Notes and Audio on page
221.

6. Select the desired format.

7. Click Save.

8. Connect (dock) your smartpen to your computer to transfer new and updated shortcuts to the smartpen.

For information on defining shortcuts for particular Connectors, click one of the links below:

• Creating a Custom Shortcut for Computer on page 204
• Creating a Custom Shortcut for MyLivescribe on page 206
• Creating a Custom Shortcut for Evernote on page 208
• Creating a Custom Shortcut for Facebook on page 210
• Creating a Custom Shortcut for Email on page 213
• Creating a Custom Shortcut for Google Docs on page 216
• Creating a Custom Shortcut for Google Sites on page 219
• Creating a Custom Shortcut for Microsoft OneNote on page 220
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The Me Shortcut
The Me shortcut gives you a quick alternative to creating a custom shortcut. You can modify all aspects of the
Me shortcut, except the shortcut name.

You can select:

• the Connector to use.
• the destination settings. Click a link below the Connector name to enter values for the settings.
• the Format in which to send your notes and audio. See Formats For Sending Notes and Audio on page 221.

You can modify the definition of the Me shortcut as often as you like. Dock your smartpen to your computer to
transfer the new Me definition to your smartpen.

Deleting a Custom Shortcut
You can delete a custom shortcut on the Shortcuts tab of the Livescribe Connect computer app. You cannot
delete default shortcuts.

1. Click in a shortcut row on the Shortcuts tab.

2. Click the Delete This Shortcut button.

Starting and Stopping Livescribe Connect
You can start and exit the Livescribe Connect computer app and configure it to automatically transfer data at
smartpen dock. These tasks differ on Windows and Mac.

Starting and Stopping Livescribe Connect (Windows)
You can manually start and exit Livescribe Connect, check if it is currently running, and display the app's window.
You can also control whether Livescribe Connect transfers data automatically when you dock your smartpen to
the computer.
Manually Starting Livescribe Connect (Windows)

Choose Start > All Programs > Livescribe > Livescribe Connect.

Note: You can also set Livescribe Connect so that it starts automatically when you connect the
smartpen to the computer. See Automatically Starting Data Transfer at Smartpen Dock (Windows) on
page 182

Checking If Livescribe Connect Is Running (Windows)
You can check if Livescribe Connect is currently running.

Note:  Clicking either the minimize button or the close button on the Livescribe Connect window closes
the window, but leaves the app running.

Check the Windows system tray.
If the app is running, you will see the Livescribe Connect icon:

Displaying the Livescribe Connect Window

The Livescribe Connect window may be closed because you clicked the minimize button or the close button.
However, the app is still running. You can re-display the window from the Start menu or the Windows system
tray.
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Displaying the Window from the Start Menu

Choose Start > All Programs > Livescribe > Livescribe Connect.
If the app is running, the window displays. If the app is not running, it starts and the window displays.

Displaying the Window from the System Tray
When the Livescribe Connect is running, you can display the Livescribe Connect window from the Windows
system tray.

Click the Livescribe Connect icon in the Windows system tray.

Alternatively, you can right-click the Livescribe Connect icon in the Windows system tray and choose Open
Livescribe Connect.

Exiting Livescribe Connect Computer App (Windows)
You can exit Livescribe Connect from the Windows system tray.

This is the primary way to exit Livescribe Connect. Closing the Livescribe Connect window does not exit the
app.

1. Right-click the Livescribe Connect icon in your system tray.

2. Select Exit on the popup menu.

The Livescribe Connect computer app exits. The icon no longer appears in the system tray or the Hidden
Icons Menu.

Automatically Starting Data Transfer at Smartpen Dock (Windows)
Livescribe Connect can automatically transfer data with the smartpen whenever you connect (dock) the smartpen
to the computer. You access the appropriate setting in Livescribe Desktop.

1. Start Livescribe Desktop.

2. Click Tools -> Livescribe Desktop Settings.

The User Settings dialog displays.

3. Under Settings -> Livescribe Desktop, click General.

The General settings pane displays.

4. Select the Autolaunch Livescribe Connect when the smartpen is connected check box.
DescriptionCheck Box

Livescribe Connect will begin transferring data with the smartpen when you connect the smartpen to
your computer. If not already running, Livescribe Connect will be automatically started.

Selected

When you connect your smartpen to the computer and Livescribe Connect is not running, no data
transfers occur. You must manually start Livescribe Connect for data transfer to begin.

Deselected

Preventing Data Transfers at Smartpen Dock

Important:  If you do not want data transfers to start when you connect your smartpen to the computer,
you must do the following:

1. Deselect the check box, as described above.

2. Exit Livescribe Connect. See Exiting Livescribe Connect Computer App (Windows) on page 182

3. Connect your smartpen to the computer.
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System Tray on Different Versions of Windows

The Windows system tray displays differently on different versions of Windows.

Windows XP and Windows Vista

The Livescribe Connect icon displays in the system tray when the app is running:

Some of the system tray icons may be hidden. In that case, you will see a left arrow at the end of the task bar:

Click it to display the full system tray.

Windows 7

In Windows 7: the Livescribe Connect icon may display in the Hidden Icons window instead of in the system
tray. If you do not see the Livescribe Connect icon in the system tray, click the up arrow to display the Hidden
Icons menu.

In the Hidden Icons menu, click the Livescribe Connect icon to display the main window of the app.

If you wish to ensure that the Livescribe Connect icon always appears in the system tray, click Customize, find
Connect Tray in the list, and make sure Show icon and notifications is selected.

Starting and Stopping Livescribe Connect (Mac)
You can start and quit Livescribe Connect and open the Livescribe Connect window.
Manually Starting Livescribe Connect On Your Mac
You can start Livescribe Connect in the normal manner.

Click the Livescribe Connect icon in the Dock.

Checking If Livescribe Connect Is Running (Mac)
You can check if Livescribe Connect is currently running.

Note:  Clicking either the yellow Minimize or the red Close button on the Livescribe Connect window
closes the window, but leaves the app running.

Right-click the Livescribe Connect icon in the Dock.

183



The popup menu displays the next action you can take.

Current StatusMenu Item

Livescribe Connect is running. You can stop it by choosing Quit.Quit

Livescribe Connect is not running. You can start it by choosing Open.Open

Opening the Livescribe Connect Window

The Livescribe Connect window may be closed because you clicked the Yellow minimize button or the Red
close button. However, the app is still running. You can open the window from the Dock.

Click the Livescribe Connect icon in the Dock.

Quitting Livescribe Connect (Mac)
You can quit Livescribe Connect from the Dock, using the popup menu.

This is the primary way to quit Livescribe Connect. Closing the Livescribe Connect window does not quit the
app.

Right-click the Livescribe Connect icon on the Dock, and choose Quit.

Livescribe Connect Status Icons
The Livescribe Connect icons indicate the app’s current status. They appear in the corner of the Livescribe
Connect window.

DescriptionIcon

Livescribe Connect is running normally.

Livescribe Connect is transferring data with the Livescribe smartpen.

Livescribe Connect has experienced an error.

If you see the error icon, exit the Livescribe Connect computer app, and start it again.

Livescribe Connect Quick Start
The Quick Start guides you through using your first Connector—the Computer Connector. Then it provides an
overview called Connectors at a Glance.

Using Your First Livescribe Connect Shortcut
Use a Livescribe Connect shortcut on your smartpen to access a Connector. For instance, you can access the
Computer Connector by using its shortcut Computer.

1. Capture notes and audio on a notebook page.

2. Draw Launch Line: Write a horizontal line and—without lifting your smartpen—retrace your line in the
opposite direction. A Launch Line is a line drawn there and back again, about the length of the display on
your smartpen.
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3. With 8 seconds, write the word Computer directly above the line. For more information see Drawing a
Launch Line on page 191.
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4. When the smartpen display prompts you to select pages, tap on a notebook page that you want to send to
your computer. Tap on each additional page to select it. When you reach the final page you want to send,
double-tap on it.

5. Connect (dock) your smartpen to your computer. Livescribe Connect transfers the notes and audio to your
computer.

6. When the transfer finishes, look on your computer’s desktop for a Pencast PDF of the pages you selected.

This example assumes the default settings for Livescribe Connect and the Computer Connector. For example,
it uses the default folder location for the Computer Connector and the default Pencast PDF format. If you
changed the folder location, look for your uploaded files in the new folder.

7. Open the Pencast PDF using Acrobat Reader, and play the audio in the file by clicking on the green ink or
using the audio control bar.

Congratulations! You just created your first Pencast PDF using Livescribe Connect!

Connectors at a Glance
This is a brief overview of Livescribe Connect for those who are very experienced with computer software and
want to get started quickly.

Read this section first, followed by Comparing Connectors on page 188. If you get stuck at any step or if you
simply prefer fuller descriptions and instructions, click a link below.

Start Here

Livescribe Connect consists of a computer app and a smartpen app. Start by launching the Livescribe Connector
computer app. You will use the Connectors tab and the Shortcuts tab.

Note:  If you are currently displaying Livescribe Desktop, you can access Livescribe Connect on your
computer by clicking an icon in the Connectors pane of Livescribe Desktop. The Livescribe Connect
computer app will display with the Connectors tab open to the configuration page for the Connector you
clicked.

Connectors Tab

Each type of destination is handled by a plugin called a Connector. You must configure Connectors before using
them, including:

• account settings (username and password, outgoing email server settings).

• default destination settings (folders, collections, post descriptors, address book, etc.).

See Configuring Connectors on page 178.

Sending Notes and Audio with a Connector

Sending notes and audio with a Connector requires you to use one of the following:

• a Livescribe Connect shortcut (on the smartpen)

OR

• the Connectors pane in Livescribe Desktop.

See Sending Notes and Audio with Your Smartpen on page 202 and Sending Notes and Audio from Livescribe
Desktop on page 225.
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Shortcuts Tab

A Livescribe Connect shortcut is a word that you write with your smartpen to use a Connector. When you dock
your smartpen to your computer, Livescribe Connect sends selected notebook pages and audio to the Connector's
destination.

Each row in the Shortcuts table defines one shortcut, which includes values for the following:

• the Connector to use. (Connectors must first be configured on the Connectors tab.)

• (optional) refinements of the default destination settings of the Connector. These are usually overrides of default
settings.

• the format in which to send the notes and audio:

PDF or PNG Image for pages only; M4A Audio for audio only; .pencast or Pencast PDF for pages and audio.
Formats available depend on which Connector is selected.

Note: When using the default Email shortcut, you must also select email recipients from the Address
Book you created during Email Connector configuration.

Default and Custom Shortcuts

Livescribe Connect comes with several default shortcuts. To create custom shortcuts:

1. Click on Add Shortcut.

Your shortcut name must be unique. It cannot be used by other Livescribe Connect shortcuts on your smartpen.

2. Select the Connector you wish to use.

3. (optional) Enter values for the destination settings below the Connector. These values will override any that
are set in the configuration page of the Connectors tab.

4. (optional) Select the Format.

5. Connect (dock) your smartpen to your computer to transfer new and updated shortcuts to the smartpen.

Each Connector has at least one default shortcut: Computer, MyLivescribe, Evernote, Facebook, Email, Google
Docs, Google Sites, and Microsoft OneNote .

See Modifying Shortcuts on page 179 and Creating Custom Shortcuts on page 180.

Using a Livescribe Connect Shortcut on Your Smartpen

1. Draw a Launch Line: Write a horizontal line and—without lifting your smartpen—retrace your line in the
opposite direction. Then write the shortcut name directly above the line.
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For more information on Launch Line, see Drawing a Launch Line on page 191.

2. Tap on one or more pages in your notebook. Double-tap on the final page.

3. Follow instructions on your smartpen display.

4. Dock the smartpen to your computer.

See the following for step-by-step instructions on configuring Connectors, modifying and creating shortcuts,
and using shortcuts to send notes and audio from your smartpen.

• Sending to Computer on page 203
• Sending to MyLivescribe on page 205
• Sending to Mobile on page 207
• Sending to Evernote on page 207
• Sending to Facebook on page 209
• Sending to Email Recipients on page 211
• Sending to Google Docs on page 215
• Sending to Google Sites on page 217
• Sending to Microsoft OneNote on page 219

The Email Connector and File Size

When using the Email Connector, keep in mind that some files, particularly those with audio, are too large for
many people's email systems. For information and alternatives, see Sending Large Files with Livescribe Connect
on page 202.

Sending Entire Recordings

When you select a page or a part of page to send, any audio recording associated with the notes will be sent in
its entirety. For details, see Sending Entire Audio Recording(s) with Note Selection on page 200.

Comparing Connectors
While the general pattern for Connector use is the same, each Connector requires specific information to
accomplish its job.
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You specify most of this information during configuration of a Connector. Other information you specify in the
shortcut definition or from the Livescribe Connect smartpen app. If the same information type is specified in
multiple places, priority goes like this: Shortcut definition overrides Connector configuration, and smartpen
overrides them all.

Info Specific to the ConnectorConnector

Folder on your computer where notes and audio will be sent.FolderComputer

Email address for logging in to MyLivescribe in Livescribe Online. Livescribe Connect automatically

logs you in when you send notes and audio to MyLivescribe.

EmailMyLivescribe

Password for logging into MyLivescribe in Livescribe Online.Password

Name that will display beneath your Pencast when it is uploaded to MyLivescribe.Default Pencast

Name

same as MyLivescribeMobile

User name for logging in to your Evernote account. Livescribe Connect automatically logs you in

when you send notes and audio to Evernote.

User nameEvernote®

Password for logging in to your Evernote account.Password

Evernote notebook to which notes and audio will be sent. If you specify no notebook, they will be

sent to the default notebook you specified in Evernote online.

Notebook

Evernote tag(s) that will be attached to notes and audio when they are sent. If the tags do not exist

in your Evernote account, they will be created automatically.

Tags

Button you push to display the Facebook Login dialog, where you enter email account and password

for logging in to your Facebook account.

To send notes and audio to your Facebook account, you must be currently logged in: Click Sign

in to Facebook. Click Keep me logged in, if you do not want to manually log in to Facebook each

time you send content. Click Login.

Sign in to

Facebook

Facebook

If the button says Sign out of Facebook, you are currently logged in to Facebook and can send notes

and audio. Clicking Sign out of Facebook, logs you out of your Facebook account.

Your message. Will appear beneath your name and above the Pencast in your post.Wall Message

Title, in bold type, of the Pencast. Will appear to the right of the Pencast in your post.Wall Name

Quick summary of the Pencast. Will appear beneath the Wall Name in your post.Caption

One or two sentence description of the Pencast. Will appear beneath the Caption in your post.Description

Dropdown menu of Facebook walls to which notes and audio will be sent. Check one or more of

the following: My Wall, Livescribe's Wall or your friends' walls. To see your friends' names in

the dropdown menu, you must be signed in to Facebook.

Post To

Info you enter during Email Connector configuration. Info appears in the email that you send. Your

Name and Your Email Address apply to the From field of your email. Signature provides the

Outgoing

Message Info

Email

closing, usually your name, at the bottom of your email. Default Subject and Always BBC emails

to are defaults that you can override in the Subject and BCC fields of a custom Email shortcut.

Info that allows Livescribe Connect to log in to your mail server and send your email. Most server

types in Email Service require your email address and password only.

If your Email Service is Microsoft Exchange, you must provide:

Email Setup Info
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Info Specific to the ConnectorConnector

Your user name only. No domain (such as

@xyzcompany.com) required.

User Name

Your password for logging in to the mail server.Password

Mail server name and domain. Ask your administrator. An

example is: mail.xyzcompany.com
Outgoing mail server (SMTP)

Ask your administrator. Default is often 587Port

Ask your administrator. Answer if often yes: select the

check box.

Use a secure connection SSL

Email addresses you enter during Email Connector configuration. When you use the default Email

Connector, the smartpen will ask you to select addresses from this book. It is not used by custom

Email shortcuts.

Address Book

When defining custom Email shortcuts, enter email recipients in these fields. Each custom Email

shortcut becomes a kind of mailing list. You cannot override these fields from the smartpen.

When using the default Email shortcut, the smartpen asks you to select email reciepients from the

Address Book.

To, CC, BCC

When defining custom Email shortcuts, enter a subject. It overrides the Default Subject in the Email

Connector configuration. You cannot override this field from the smartpen.

Subject

User name for logging in to your Google Docs account. Livescribe Connect automatically logs you

in when you send notes and audio to Google Docs.

User nameGoogle™ Docs

Password for logging in to your Google Docs account.Password

Name of the Collection (folder) to which your notes and audio should be sent in your Google Docs

account. If you specify a Collection that does not exist in your Google Docs account, it is created

automatically.

Collection

Email addresses of people with whom you want to share. They will have access to these notes and

audio on Google Docs.

Share With

User name for logging in to your Google Sites account. Livescribe Connect automatically logs you

in when you send notes and audio to Google Sites.

User nameGoogle™ Sites

Password for logging in to your Google Sites account.Password

URL of the site to which notes and audio will be sent. The URL is generated for you by Google

Sites and has a format such as:

https://sites.google.com/site/yoursitenamehere/

Copy the URL from Goolge Sites and paste it into this field.

Site URL

Template for the page that Google Sites will create to display your notes and audio as an interactive

Pencast. By default, this field has the value Web Page, the template for a standard Google Sites

page. The Pencast will be inserted automatically in the main text box of the page.

To specify a different page template, you must first go to Google Sites and create a custom page

template that contains a [pencast] tag at the location where the Pencast should be inserted.

Page Template

Then in the Google Sites Connector configuration, select Custom Template from the dropdown

menu and enter the name of your custom page template.
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Info Specific to the ConnectorConnector

Name of the OneNote notebook to which your notes and audio will be sent. If you specify a notebook

that does not exist in your installation of OneNote, it is created automatically.

NotebookMicrosoft®

OneNote®

Launching the Livescribe Connect Smartpen App
You can launch the Livescribe Connect smartpen app by using shortcuts or the Nav Plus.

Shortcuts

There are two kinds of shortcuts you can use with the Livescribe Connect smartpen app:

• A general launch shortcut, such as Send or Connect, starts the smartpen app and displays a menu within the
app. You tap right or down to navigate the smartpen app menus, where you can select a Connector shortcut,
send an entire notebook, access application information, or other tasks.

• A Connector shortcut launches the smartpen app and automatically selects the appropriate Connector with
settings defined in the shortcut. The smartpen then instructs you to start selecting pages in a Livescribe notebook.

Nav Plus

You can also start the smartpen app by using Nav Plus to navigate the smartpen app menus, where you can select
a Connector shortcut, send an entire notebook, access application information, or other tasks.

Launching Livescribe Connect with Shortcuts
You can launch the Livescribe Connect smartpen app using Launch Line and a shortcut.

The Livescribe Connect smartpen app responds to a variety of shortcuts:

• the Connect shortcut.

• the Send shortcut.

• the default Livescribe Connect shortcuts.

• the custom Livescribe Connect shortcuts.

Drawing a Launch Line
You can launch Livescribe Connect on your smartpen by drawing a Launch Line and writing a Connect shortcut.
Draw a Launch Line without lifting your smartpen tip from the paper.

1. Write a horizontal line, but don't lift your smartpen tip from the paper yet.
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2. Retrace your line in the opposite direction.

3. Within 8 seconds, write the shortcut word—such as Send.
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The Connect smartpen app will launch and the appropriate menu will show on the smartpen display.

4. Look at the smartpen display to determine the current menu.

If you wrote Send, you will see the Share via menu. If you wrote Connect, you will see the Send menu.
If you wrote a Connector shortcut, you will see a message asking you to tap a notebook page to select it.

Navigating Submenus with Tap Around

You can access submenus in a smartpen app, including Livescribe Connect. For instance, the default Email
Connector asks you to select email recipients from the Address Book. Or you might wish to change the sending
format of your notes and audio right from the smartpen. In addition, you can access Connect menu items such
as Send Entire Notebook or About.

Tapping left, right, up, or down changes the menu item in the smartpen display. There are two ways to navigate
submenus:

• tapping on the directional arrows of a Nav Plus. See Launching Livescribe Connect from the Nav Plus on page
197.

• using Launch Line Tap Around.

Tap Around

After you write a Launch Line and shortcut word, you can tap up, down , left, or right around the Launch Line
word to access menus of the Connect smartpen app. The active areas for up, down, left, and right are invisible
rectangles extending 1/4" outward from the shortcut word in the four directions. In the illustration, the shortcut
word is Settings, which launches the smartpen's Settings app. With Livescribe Connect, your shortcut word
will be Send, Connect, Email, Computer, MyLivescribe, etc.
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Note: You can use Tap Around with a Launch Line and shortcut word that you wrote in the past. Just
tap on the word to activate the app, and then tap up, down, right, or left.

The illustration below shows a smartpen tapping right on a previously written Send shortcut.

The next illustration shows a smartpen tapping down.
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Launching Livescribe Connect with the Connect Shortcut
You can launch Livescribe Connect on the smartpen by drawing a special line and then writing the word Connect.

1. Draw a Launch Line: Write a horizontal line and—without lifting your smartpen—retrace your line in the
opposite direction.

2. Immediately write the first few letters of the Connect shortcut directly above the Launch Line.

For example, writing Con displays the Connect shortcut.

Using its predictive text feature, your smartpen displays the first shortcut that matches your written input.
As soon as you see the shortcut you want, you can stop writing.

3. Wait until the smartpen displays shows: Send.
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The Livescribe Connect smartpen app has started and is displaying the Send menu.

4. Tap right to display the Share via menu, which lists all Livescribe Connect shortcuts. Or tap down to access
other app options.

Once you have written a Launch Line, you can tap where you wrote it to repeat the action. You can re-launch
the Livescribe Connect app at any time by tapping your Connect shortcut.

The Connect shortcut is best for accessing items on the app's root menu, such as Send Entire Notebook or
About. If you just want to select a Connector, use the Send shortcut.

Launching Livescribe Connect with the Send Shortcut
The Send shortcut is best when you want to select a Connector from the list.

Follow the same steps as for the Connect shortcut, but write Send instead of Connect. The Livescribe Connect
smartpen app launches, and the Share via menu displays on the smartpen.

Launching Livescribe Connect with Default Shortcuts
You can launch Livescribe Connect on the smartpen by drawing a Launch Line and then writing the name of
the default shortcut you want to use.

Livescribe Connect shortcuts launch the smartpen app, select the appropriate shortcut, and instruct you to start
selecting pages by tapping on them. Each Connector has a default shortcut that is the same as the Connector
name. Livescribe Connect comes with other default shortcuts as well. Default shortcuts include: Computer,
MyLivescribe, Mobile, Evernote, Facebook, Email and Google Docs.

1. Draw a Launch Line and write the first few letters of the shortcut you want to use. For example, writing Com
shows Computer on the smartpen display.

Using its predictive text feature, your smartpen displays the first shortcut that matches your written input.
As soon as you see the shortcut you want, you can stop writing.

2. Wait until the smartpen displays shows: Tap each page to include, then double tap.

3. Tap on a notebook page. Tap on each additional page. Then double-tap on the last page you wish to send.

The next time you dock your smartpen to your computer, the notebook pages are sent in the format specified
by the shortcut.

Livescribe User Guides196



Once you have written a shortcut with Launch Line, you can tap where you wrote it to repeat the action. You
can re-launch the app at any time by tapping your Launch Line shortcut word.

Launching Livescribe Connect with Custom Shortcuts
You can launch the Livescribe Connect smartpen app, using custom shortcuts that you create.

Launch Livescribe Connect smartpen app by using custom shortcuts in the same way you use default shortcuts.

Launching Livescribe Connect from the Nav Plus
You can launch Connect with the Nav Plus printed in the corner of Livescribe notebooks and notepads. You can
also navigate the submenus of the Connect smartpen app by tapping on the up, down, right, and left directional
arrows of the Nav Plus.

1. Double-tap on the center of a Nav Plus to go to the Main Menu.

2. Tap down until you locate the Connect app.

3. Tap right to launch Connect.

Note:  Nav Plus is an alternative to drawing a Launch Line and using Tap Around.

Selecting Notes And Audio with the Smartpen
You can select notes and audio you want to send by tapping on pages in a Livescribe notebook. You can send
whole pages or portions of pages. You can send an entire notebook to your computer and keep the sent file
synchronized with new notes and audio you add to the notebook.

Selecting Pages on the Livescribe Smartpen
You can select notes and associated audio by tapping on pages in your notebook.

1. Launch the Connect app on the smartpen with the Send shortcut.

2. When the smartpen displays Share via, tap down to find a Connector, and then tap right.

3. Tap on one or more pages in your notebook to select them for sending.

4. Double-tap on the final page you want to send.

The default Email shortcut has an additional step: it asks you to select email recipients from the Address
Book.
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5. Connect (dock) your smartpen to your computer to send the notes and audio.

Note: All pages you select must be in the same notebook. If you want to send content from multiple
notebooks, send pages from the first notebook, and then send pages from the next notebook.

Selecting Part of a Notebook Page
You can send parts of a notebook page, if you prefer not to send the whole page.

To send part of a notebook page:

1. Launch the Livescribe Connect smartpen app, using the Send shortcut.

2. When the smartpen displays Share via, tap down until you see the Connector you want to use. Tap right.

The smartpen display shows: Tap each page to include, then double-tap.

3. Instead of tapping on a page, draw a box around the area of the page you wish to send.

Draw the entire box without lifting your smartpen from the page.

The smartpen display shows: 1 Area selected.

4. Draw another box to select a different part of that page or another page.

The smartpen display shows: 2 Areas selected.

5. Continue drawing boxes to select parts of pages.

6. When you are done selecting areas, double-tap.

If you are using the default Email Connector, select email addresses from the Address Book.

Each page you touched is sent, but only the parts you selected are visible.

When making selections, you can mix entire pages with portions of a page. For instance, you can select all of
page 10, draw a box to select a portion of page 13, and select two boxes on page 21. All selections, however,
must be in the same notebook.
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Note: When sending a page or a part of a page, any audio recording associated with your selection will
be sent in its entirety. For details, see Sending Entire Audio Recording(s) with Note Selection on page 200.

Important: You cannot select part of a page when using the MyLivescribe Connector. You can select
only a whole page. Livescribe Connect shortcuts that use the MyLivescribe Connector include:
MyLivescribe, Mobile, iPad, and iPhone.

Selecting Part of a Page with Vertical Lines

As an alternative to selecting part of a page by drawing a box, you can draw a vertical line to the left of the notes
to be sent.

Note: When sending a page or a part of a page, any audio recording associated with your selection will
be sent in its entirety. For details, see Sending Entire Audio Recording(s) with Note Selection on page 200.

Important: You cannot select part of a page when using the MyLivescribe Connector. You can select
only a whole page. Livescribe Connect shortcuts that use the MyLivescribe Connector include:
MyLivescribe, Mobile, iPad, and iPhone.

Selecting Audio to Send
On the smartpen, you send audio from a notebook page by selecting the format of the files sent.

If you specify the following formats, audio is sent:

• Pencast (notes and audio)

• Pencast PDF (notes and audio)

• M4A Audio (audio only)

Shortcuts specify the default send format in the Shortcuts tab of the Livescribe Connect computer app. You can
override the default format when selecting pages on the smartpen.
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Sending Entire Audio Recording(s) with Note Selection
When you select notes, any recording associated with the notes is sent in its entirety.

Important:  Even if you select a single page or part of page, each recording associated with any of the
selected notes is sent without being clipped. Consequently, a few brief notes that you send as Pencast PDF
may include a long audio recording or even multiple recordings.

Stop and Start Recording at Key Points

An audio recording is bounded by your tapping the Record button and later the Stop button. For instance, consider
a lengthy meeting. If you stop and re-start recording on your smartpen, you will end up with two separate
recordings.

Tip:  One strategy to break a longer meeting, class, or interview into separate chunks is to stop the recording
and then start a new one at key points, notating the fact in your notebook. Be careful to enter your notes
in order and not go back to earlier notes while audio recording is on. If you observe that rule, each section
of your notes will contain only one recording. However, if you go back to an earlier section while recording
(or while listening to a recording after the meeting), that section will contain both the old and newer
recordings.

Preview Recordings in Livescribe Desktop

You can preview your audio recordings in Livescribe Desktop. Connect (dock) your smartpen to your computer.
Then try sending from Livescribe Desktop. In the More Options section of the Sending Notes... dialog, you
can play a recording and use the timeline controls to verify what you are about to send.

Sending an Entire Notebook from Your Smartpen
You can send an entire notebook to your computer from your smartpen.

Livescribe Connect sends the notebook as a Pencast PDF file, using the Computer Connector. As with all Pencast
PDFs sent to your computer, the Pencast PDF file will be updated each time you dock your smartpen. Such
updating is similar to the way that Livescribe Desktop updates your electronic notebooks when you dock your
smartpen.

1. Launch the Livescribe Connect smartpen app using the Connect shortcut or a Nav Plus.

2. On the Send menu, tap down until you see Send Entire Notebook. See Navigating Submenus with Tap
Around on page 193.

3. Tap right.
Share Notebook via shows on the smartpen display.

4. Tap down until you see the Livescribe Connect shortcut you want. Choices are:

• Computer
• Me
• PDF

Note: The Me shortcut must use the Computer Connector. You cannot send an entire notebook from
the smartpen using other Connectors.

5. Tap on any page in the notebook you want to send.

6. Connect (dock) your smartpen to your computer.
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Livescribe Connect sends your entire notebook as a Pencast PDF to your computer. Every time you dock
your smartpen, the notebook’s new content is sent to the same file in the folder. The file on your computer
contains notes and audio from the paper notebook, as of the last time you docked your smartpen.

For automatic updating to occur, the Pencast PDF file on your computer must remain unchanged. Renaming,
moving, or in any way modifying the file on your computer breaks the updating link.

Tip:  If you decide that you do not want the Pencast PDF file to update, rename it.

Pencast PDF Files and Notebook Archiving

If you send a notebook using the Send Entire Notebook feature and later archive the notebook in Livescribe
Desktop, rename the Pencast PDF in your computer folder. Otherwise, you may lose information. If you start
writing in a new notebook of the same type, Livescribe Connect will overwrite the old Pencast PDF file with
notes and audio from the new notebook—unless you change the name of the old file.

Selecting Format from the Smartpen
When selecting notes and audio with your smartpen, you can also select the format in which they are sent.

Generally, you accept the format specified in a shortcut. If you want a different format, you can modify an
existing shortcut or create a new one. It can be convenient, however, to select the Format on the smartpen when
you select pages from a notebook. For instance, you may decide at the last minute to send notes only or audio
only, regardless of the format setting in the shortcut.

The format you select on the smartpen overrides the format specified in the shortcut.

Not all Connectors have a format that can be overridden. You are able to select a format from the smartpen for
the following Connectors:

• Computer

• Evernote

• Email Connector

• Google Docs

Note: You can access the optional Format submenu after selecting a pages (or portions of a page) and
before double-tapping to end selection.

1. After you have tapped the final page you wish to send and the smartpen is displaying the number of pages
you selected (such as “1 page selected” or “2 pages selected”), tap right.

The smartpen display shows Send As and then the default format specified by the shortcut you are using.

2. Tap down to display the next available send format. Continue tapping down until you see the send format
you wish. See Navigating Submenus with Tap Around on page 193.

3. Tap right to select it.

4. Double tap to finish using the current shortcut (or to proceed with selecting email addresses, if you are using
the default Email shortcut.

Next time you dock your smartpen to your computer, the notes and audio you selected are sent in the format
you selected.
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Sending Notes and Audio with Your Smartpen
You can write notes and audio in Livescribe notebooks and notepads and send them by connecting (docking)
with your computer.

This section discusses several general issues. Then it provides a mini-tutorial for using each Connector with the
smartpen, walking you step-by-step through:

• configuring the Connector.
• creating Livescribe Connect shortcuts.
• sending notes and audio with a shortcut.

Detailed configuration information is provide for each Connector.

You Can Send with the Smartpen or from Livescribe Desktop
You can send notes and audio by using your smartpen and Livescribe paper notebooks. You can also send notes
and audio from Livescribe Desktop.

Sending vs. Sharing
Sending notes and audio is not necessarily the same as Sharing them.

If you are sending to a destination that lets you share with others, then sending may result in sharing if you
configure it to do so.

• With some Connectors, you can indicate a share setting when you configure the Connector. An example is
sending to Google Docs. You specify with whom you wish to share your sent notes and audio when you create
shortcuts for the Google Docs Connector or when you send from Livescribe Desktop.

• With other Connectors, sharing is pre-set on the destination side. The Pencasts you post to Facebook have the
privacy settings you choose in Facebook for posts to your wall. The notes and audio you send to Evernote have
the privacy setting you choose in Evernote for the destination notebook. The notes and audio you send to
Computer have the access rights of the destination folder on your computer.

• With still other Connectors, the notes and audio have a private setting. You can decide to share them later at
the destination side. For example, sending to MyLivescribe results in a Pencast with a private setting.

• Finally, with some Connectors, the sharing is implicit. When you send email to individuals, you are sharing it
at the same time.

Sending Large Files with Livescribe Connect
When you send notebook pages that contain lengthy audio, the resulting file can be quite large. Not all Connectors
are appropriate for sending large files.

Forty minutes of recorded audio creates a file about 10 MB in size.

In general, the Computer and Google Docs Connectors are the best choice for large files. Some destinations,
such as Facebook, have a maximum recommended upload size.

Note: The Email Connector is best for files of small to medium size, since many mail servers limit
attachments to a maximum size of 10 MB. Keep in mind that although your mail server may have a larger
limit, you cannot be sure what limits apply to the mail servers that deliver email to your recipients.

Sending Entire Audio Recordings
When you select notes, any recording associated with the notes is sent in its entirety.
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For example, when selecting a page or a part of page to send, any audio recording associated with the notes will
be sent in its entirety. For details, see Sending Entire Audio Recording(s) with Note Selection on page 200.

Canceling Send Operations from the Smartpen
You can cancel send operations by selecting the Reset menu item before docking your smartpen.

1. Launch the Livescribe Connect smartpen app, using the Connect shortcut or Nav Plus.

2. Tap down until you see About on the smartpen display.

3. Tap right.
The current version of the Livescribe Connect smartpen app shows on the display.

4. Tap down until you see Help.

5. Tap right.
The address for the Livescribe support web page shows on the display.

6. Tap down until you see Reset.

7. Tap right.

8. Tap right again to confirm.

All send operations you have queued up on the smartpen since your last dock will be canceled. Notes and
audio you selected will not be sent.

Sending From Your Smartpen: Mini-Tutorials for Each Connector
Livescribe Connect has plugins—called Connectors—each of which targets a different destination for sending
your notes and, optionally, audio.

In the Livescribe Connect computer app, you can configure Connectors, modify a Connector’s default shortcut,
and create custom shortcuts for a Connector. On the Livescribe smartpen, you launch the Livescribe Connect
smartpen app with a shortcut and then provide other input the Connector needs to complete its job.

The following sections contain mini-tutorials on configuring a Connector, creating a shortcut for it, and using
the shortcut on the smartpen. Each Connector section is self-contained and provides the information you need
to complete it. Click one of the links below.

• Sending to Computer on page 203
• Sending to MyLivescribe on page 205
• Sending to Mobile on page 207
• Sending to Evernote on page 207
• Sending to Facebook on page 209
• Sending to Email Recipients on page 211
• Sending to Google Docs on page 215
• Sending to Google Sites on page 217
• Sending to Microsoft OneNote on page 219

Sending to Computer
Using the Computer Connector, you can send notes and audio to a folder on your computer. The following
mini-tutorials configure the Computer Connector, create a custom shortcut, and send content from your smartpen
using the new shortcut.

Configuring the Computer Connector
In this mini-tutorial, you configure the Computer Connector.

1. Click the Computer icon on the Connectors tab of the Livescribe Connect computer app.
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The path shown under Default Folder Location is the default location to which your notes and audio are
sent. You can override this default value by creating custom shortcuts for the Computer Connector.

2. If you wish a different default location, click Choose a different folder and specify a path on your computer.

The initial value for the Default Folder Location is your computer’s Desktop folder.

3. Pencast PDFs sent to your computer using the Computer Connector are updated automatically with new ink
and audio that you add to your paper product.

This automatic updating occurs every time you dock your smartpen. It is similar to how Livescribe Desktop
updates your notebooks when you dock your smartpen.

Defining Shortcuts for Computer
The Computer Connector has default shortcuts that you can modify. You can also create your own custom
shortcuts.

The Computer Connector has the following default shortcuts:

• Computer

• PDF

Default and custom Computer shortcuts specify the following:

• the Computer Connector. This cannot be changed in default shortcuts.

• the Folder on your computer to which the notes and audio will be sent. If a value is specified in the shortcut,
it overrides the default value from the configuration page of the Connector. See Formats For Sending Notes
and Audio on page 221.

• the Format in which the notes and audio should be sent.

You can modify an existing shortcut by clicking its row in the table of the Shortcuts tab, selecting different
values in the columns, and clicking Save.

Creating a Custom Shortcut for Computer
In this mini-tutorial, you will create a custom shortcut named Image that targets the
C:\Users\Desktop\Planning folder on your computer and sends notes only (without audio) as a graphic
image.

1. Click Add Shortcut.

2. Enter a name for the shortcut. In this example, enter: Image.

3. Click the down-arrow in the Connector column and select the Computer Connector.

The Folder link appears.

4. Click Folder.

5. Click Choose Folder, browse to an existing folder (or create a new one) on your computer file system, and
click OK.
In this example, click Choose Folder and create a new folder. For the folder’s name, enter: Planning.
Then click OK (Windows) or Create (Mac).

6. Click the down-arrow in the Format column.

7. Select PNG Image from the menu.

8. Click Save.

Sending to Computer Using a Shortcut
You can send notes and audio to your computer, using default or custom shortcuts. In this mini-tutorial, you
send content using the Image shortcut you just created.
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1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, writing Com displays the Computer shortcut. In this case, write Im to display your Image
shortcut. For more information, see Drawing a Launch Line on page 191.

2. Wait until the smartpen displays: Tap each page to include it, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook Page
on page 198.

4. (optional) You can select a send format for your notes and audio that is different from the default value. The
default format for a shortcut is specified on the Shortcuts tab of the Livescribe Connect computer app.

a) Using Tap Around and the shortcut word you wrote, tap right to select a different send format for your
notes and audio. For more information, see Navigating Submenus with Tap Around on page 193.

b) Tap down to display other available send formats. Tap right to select a send format.

5. Double-tap on the final page you wish to send. Connect (dock) your smartpen to your computer.

If you used the Image shortcut, notes only are sent to the Planning subfolder of your Desktop folder on your
computer.

Sending to MyLivescribe
Using the MyLivescribe Connector, you can send notes and audio to your MyLivescribe space. The following
mini-tutorials configure the MyLivescribe Connector, create a custom shortcut, and send content from your
smartpen using the new shortcut.

Configuring the MyLivescribe Connector
In this mini-tutorial, you configure the MyLivescribe Connector.

By default, your uploaded notes and audio on your MyLivescribe space have the Private property: it can be seen
only by you. If you wish more people to see your content, make it public by changing the privacy options in
Livescribe Online.

1. Click the MyLivescribe icon on the Connectors tab of the Livescribe Connect computer app.

2. Under Login Information, enter your MyLivescribe account information in Email and Password.

These are the email address and password that you use to log on to http://www.livescribe.com/community.
It is the same account used by Livescribe Desktop—for example, when you click the Livescribe Online tab
in Livescribe Desktop.

3. Click the Test Connection button to make sure that the MyLivescribe Connector can connect to Livescribe
Online.

A green light on the button indicates that the connection is successful.

4. If you remember your MyLivescribe email address, but you have forgotten your password, click the Forgot
Password button.

An email describing how to reset your password is sent to your email address.

a) Connect to your email account and find the email message from Customer Service Livescribe.
b) Follow the instructions in the email to reset your password. If you ignore this email, your password

remains unchanged.

5. If you do not yet have a MyLivescribe account, click Create New Account.

a) In the Create Account dialog, enter your email address in the Email text box, and enter your password
twice: in the Password and Confirm Password text boxes.
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b) Select a country from the Language drop-down list. Then click the Create button.

6. Enter a name in the Default Pencast Name text box. All notes and audio sent to your MyLivescribe space
will have this name.

If you leave this field blank, the name will default to the notebook name and page number. For Example:
1-Subject Notebook 8 p. 113

Defining Shortcuts for MyLivescribe
The MyLivescribe Connector has default shortcuts. You can also create your own custom shortcuts.

The MyLivescribe Connector has the following default shortcuts:

• MyLivescribe

• Mobile

• iPhone

• iPad

Default and custom MyLivescribe shortcuts specify the following:

• the MyLivescribe Connector. This cannot be changed in default shortcuts.

• the Format in which the notes will be sent. This cannot be changed in any MyLivescribe shortcut. The format
for sending content is .pencast, since MyLivescribe requires a Pencast file to provide an interactive version of
the notes and audio over the web. See Formats For Sending Notes and Audio on page 221.

Creating a Custom Shortcut for MyLivescribe
You can create custom shortcuts for the MyLivescribe Connector, perhaps to provide shorter, easier-to-write
names. In this mini-tutorial, you create a custom MyLivescribe shortcut with the name LS.

1. Click the Add Shortcut button.

2. Enter a name for the shortcut. In this example, enter: LS.

3. Click the down-arrow in the Connector column and select the MyLivescribe Connector.

4. Click Save.

Sending to MyLivescribe Using Shortcuts
You can send notes and audio to your MyLivescribe page using default or custom shortcuts. In this mini-tutorial,
you send content using the LS shortcut you just created.

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, writing MyL displays the MyLivescribe shortcut. In this case, write L to display your LS
shortcut. For more information, see Drawing a Launch Line on page 191.

2. Wait until the smartpen displays: Tap each page to include, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Important: You cannot select part of a page when using the MyLivescribe Connector. You can select
only a whole page. Livescribe Connect shortcuts that use the MyLivescribe Connector include:
MyLivescribe, Mobile, iPad, and iPhone.

4. When you are finished selecting pages, double-tap on the final page you wish to send. Connect (dock) your
smartpen to your computer.
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If you used the LS shortcut, notes and audio are sent to your MyLivescribe space.

Sending to Mobile
Using Mobile, you can send notes and audio to MyLivescribe, your personal page in Livescribe Online. No
configuration should be necessary. The mini-tutorial sends notes and audio, using the default Mobile shortcut.

Notes and audio that you send to MyLivescribe are sent as Pencast files, which you can view in your web browser
or on the Livescribe Mobile iPhone app.

Configuring Mobile
The Mobile shortcut uses the MyLivescribe Connector.

If you configured the MyLivescribe Connector already, you need do nothing further.

Sending Using Mobile
You can send notes and audio to MyLivescribe, using the Mobile shortcut. In this mini-tutorial, you send content
using Mobile.

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, write Mo to display the Mobile shortcut. For more information, see Drawing a Launch Line on
page 191.

2. Wait until the smartpen displays: Tap each page to include, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Important: You cannot select part of a page when using Mobile.

4. When you are finished selecting pages, double-tap on the final page you wish to send. Connect (dock) your
smartpen to your computer.

Notes and audio are sent to MyLivescribe.

Sending to Evernote
Using the Evernote Connector, you can send notes and audio to your Evernote account. The following
mini-tutorials configure the Evernote Connector, create a custom shortcut, and send content from your smartpen
using the new shortcut.

Configuring the Evernote Connector
In this mini-tutorial, you configure the Evernote Connector.

1. Click the Evernote icon on the Connectors tab of the Livescribe Connect computer app.

2. Enter your Evernote account information in the User name and Password text boxes.

3. Click the Test Connection button to make sure the Evernote Connector can connect to the Evernote server.
A green light on the button indicates the connection is successful.

4. If you do not have an Evernote account or wish to upgrade your existing account, click the link or image to
learn more.

Your notes and audio are sent to the default notebook of your Evernote account. If you wish to specify a
different notebook, create a custom shortcut for the Evernote Connector.
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Defining Shortcuts for Evernote
The Evernote Connector has a default shortcut that you can modify. You can also create your own custom
shortcuts.

The Evernote Connector has the following default shortcut:

• Evernote

Default and custom Evernote shortcuts specify the following:

• the Evernote Connector. This cannot be changed in default shortcuts.

• the Evernote Notebook to which notes and audio will be sent. If no value is specified, notes and audio will be
sent to the default notebook specified in your Evernote account.

• the Evernote Tag which will be applied to the notes and audio when they are sent to Evernote. You can specify
multiple tags, separated by commas.

• the Format in which notes and audio should be sent. See Formats For Sending Notes and Audio on page 221.

You can modify an existing shortcut by clicking its row in the table of the Shortcuts tab, selecting different
values in the columns, and clicking the Save button.

Creating a Custom Shortcut for Evernote
In this mini-tutorial, you create a custom shortcut named Staff that targets the Staff Meetings notebook in your
Evernote account and applies the Offsite tag, and sends a simple PDF only (without attached audio).

1. Click Add Shortcut.

2. Enter a name for the shortcut. In this example, enter: Staff.

3. Click the down-arrow in the Connector column and select the Evernote Connector.

The Notebook link appears.

4. Click Notebook and enter the name of the Evernote notebook to which content should be sent. In this example,
enter Staff Meetings.

If you do not specify a valid Evernote notebook in this text box, the Evernote Connector uses the default
notebook you specified on the Evernote web site or Evernote desktop app.

5. Click the Tags link and enter one or more Evernote tags that should be applied to your content when it reaches
your Evernote notebook.

In this example, enter: OffSite.

If you do not enter anything in this text box, the Evernote Connector applies no tags to the content.

If you enter text that does not match existing tags in your Evernote account, the Evernote Connector creates
new tags based on this text.

6. Click the down-arrow in the Format column.

The menu contains available formats for the Connector.

7. Select the desired format from the menu. In this example, select PDF.

8. Click Save.

9. (optional) Log in to Evernote and create a notebook called Staff Meetings.

Sending to Evernote Using Shortcuts
You can send notes and audio to your Evernote account, using default or custom shortcuts. In this mini-tutorial,
you send content using the Staff shortcut you just created.

Livescribe User Guides208



1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, writing Ev displays the Evernote shortcut on the smartpen. In this example, write Sta to display
your Staff shortcut. For more information, see Drawing a Launch Line on page 191.

2. Wait until the smartpen displays: Tap each page to include, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook Page
on page 198.

4. (optional) You can select a send format for your notes and audio that is different from the default value. The
default format for a shortcut is specified on the Shortcuts tab of the Livescribe Connect computer app.

a) Using Tap Around and the shortcut word you wrote, tap right to select a different send format for your
notes and audio. For more information, see Navigating Submenus with Tap Around on page 193.

b) Tap down to display other available send formats. Tap right to select a send format.

5. Double-tap on the final page you wish to send. Connect (dock) your smartpen to your computer.

A simple PDF is sent to the Staff Meetings notebook in your Evernote account.

If you did not create a Staff Meetings notebook in your Evernote account, the Staff shortcut sent content to
your default Evernote notebook. If that happened to you, you may wish to take a moment now to create a
Staff Meetings notebook in your Evernote account, and then re-try the Staff shortcut with your Livescribe
smartpen.

Sending to Facebook
Using the Facebook Connector, you can send notes and audio as a Pencast to your wall or friends' walls on
Facebook. The following mini-tutorials configure the Facebook Connector, create a custom shortcut, and send
content from your smartpen using the new shortcut.

The uploaded Pencast is an interactive Flash movie that initially displays in your post as a thumbnail of the first
page with a start button. When a viewer clicks on the start button, the Pencast plays in place. Information about
the upload displays to the side of the thumbnail.

Configuring the Facebook Connector
In this mini-tutorial, you configure the Facebook Connector.

1. Click the Facebook icon on the Connectors tab of the Livescribe Connect computer app.

2. Click the Sign Into Facebook button and enter your Facebook login information.

3. Enter appropriate default values in the following fields. You can override these default values by creating
custom shortcuts for the Facebook Connector.

a) Wall Message: Message that appears directly beneath your name on the post. Corresponds to the “Say
something about this video” text box in the Facebook video uploader.

b) Wall Name: Title of your post that displays to the side of your uploaded Pencast. In bold type.
c) Caption: Subtitle below the Wall Name. Summarizes the nature of the uploaded Pencast in a brief,

eye-catching way.
d) Description: A sentence or two describing the nature of the uploaded Pencast a little more.
e) Post To: The wall(s) to which notes and audio should be sent. Select one or more of the following check

boxes from the dropdown menu: My Wall, Livescribe's Wall, your friends' walls.

Note: To see your friends' names listed in the Post To dropdown menu, you must be signed in to
Facebook, as described in the step above.
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Defining Shortcuts for Facebook
The Facebook Connector has a default shortcut that you can modify. You can also create your own custom
shortcuts.

The Facebook Connector has the following default shortcut:

• Facebook

Default and custom Facebook shortcuts specify the following:

• the Facebook Connector. This cannot be changed in default shortcuts.

• Wall Message

• Wall Name

• Caption

• Description

• Post To

• the Format in which notes and audio should be sent. This cannot be changed in any Facebook shortcut. The
format for sending content is always Pencast. It is a special version of Pencast that can be played from a
Facebook wall. See Formats For Sending Notes and Audio on page 221.

If the shortcut specifies a value for Wall Message, Wall Name, Caption, Description or Post To, it overrides the
corresponding default from the Connector's configuration page.

All notes and audio sent with the same Facebook shortcut will have the same values. If you want different
message descriptors but the same Post To and Format choices, you can modify an existing Facebook shortcut:
Simply click its row in the table on the Shortcuts tab, enter different values, and click Save. Then dock you
smartpen and use the updated shortcut.

Important:  Remember to dock your smartpen after you update shortcuts. The updated versions will not
appear on your smartpen until you dock it.

Creating a Custom Shortcut for Facebook
In this mini-tutorial, you create a custom shortcut named Sound.

You provide values for the descriptive fields of the Facebook post as follows:

• Wall Message:Just keeping the college community connected.

• Wall Name: Valley Community College

• Caption: Sounding Off

• Description: Heard on campus this week! Authentic audio from fellow students.
Plus a wry written commentary.

The format for sending pages is always Pencast.

1. Click Add Shortcut.

2. Enter a name for the shortcut. In this example, enter: News.

3. Click the down-arrow in the Connector column and select the Facebook Connector.

The Name text box appears, followed by Message, Caption, Description links.

4. Enter a Wall Name. Then add text for Message, Caption, and Description as specified above.

5. Select My Wall from the Post To dropdown menu. If you have a friend who won't mind getting a test message
from you, select that friend's name from the dropdown menu as well.
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6. Click Save.

Sending to Facebook Using Shortcuts
You can send notes and audio to your Facebook wall, using default or custom shortcuts. In this mini-tutorial,
you send content using the Sound shortcut you just created.

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, writing Fa displays the Facebook shortcut. In this example, write Ne to display your News
shortcut. For more information, see Drawing a Launch Line on page 191.

2. Wait until the smartpen displays: Tap each page to include, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook Page
on page 198.

4. When you are finished selecting pages, double-tap on the final page you wish to send. Connect (dock) your
smartpen to your computer.

When you dock your smartpen to your computer, a Pencast is posted to your Facebook Wall, with the
following values:"Just keeping the college community connected," "Valley Community College," "Sounding
Off," and Actually heard on campus...."

Sending to Email Recipients
Using the Email Connector, you can send notes and notes as attachments to email. The following mini-tutorials
configure the Email Connector, create a custom shortcut, and send content from your smartpen using the default
shortcut and your new custom shortcut.

An email can be sent to multiple recipients simultaneously.

Note:  Some files, particularly those with audio, are too large for many people's email systems. For
information and alternatives, see Sending Large Files with Livescribe Connect on page 202.

Configuring the Email Connector
In this mini-tutorial, you configure the Email Connector.

Configuring the Email Connector consists of three steps:

• Specify Outgoing Message Info that should appear on your email.

• Provide the Email Setup Info for the outgoing email server.

• Set up an Address Book that the Livescribe Connect smartpen app can use.

1. Click the Email icon on the Connectors tab of the Livescribe Connect computer app.

2. In the Outgoing Message Info section, do the following:

a) In Your Name, enter the user-friendly name you wish to display in the From line of your emails. This
setting is required.

b) In Your Email Address, enter the email address from which you are sending emails. This setting is
required.

c) In Default Subject, enter a default subject that for Subject line of your emails.

This setting is required; the default value is Note. You can override this value when you create a custom
shortcut.
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d) In Always BCC emails to, enter an email address to which the Email Connector should send a copy of
all your emails. For example, you might wish to send copies to yourself at another email address. Your
recipients do not see the BCC line. This is optional.

e) In the Signature, enter text you wish to display at the end of your email, as a closing. This setting is
optional.

3. In the Email Setup Info section, provide the setup information for the outgoing email server.

The following table indicates the information required for common mail servers:

ExampleRequired InformationMail Server

johndoe@gmail.comEmail Addressaol, gmail, hotmail

shribleTy471Password

This is the email program that starts up when you click a

mailto: link (such as Contact Us) on a web page. Not all
users have a default email program.

No additional information required. If you
have set up a default email program on your
computer, Email Connector will use it.

Email Desktop Client

johndoeUsernameMicrosoft Exchange
Server

re73bQnTPassword

mail.mycompanydomain.comOutgoing Mail Server (SMTP)

587Port

Check the box for yesUse a secure connection (SSL)

johndoe@xyzcompany.comEmail AddressOther (SMTP)

iu8e30oPassword

mail.xyzcompany.comOutgoing Mail Server (SMTP)

ask your administratorPort

ask your administratorUse a secure connection (SSL)

For Microsoft Exchange Server and other SMTP servers, please ask your domain administrator for details.

4. Click Test Connection to make sure that the Email Connector can connect to the email server. A green light
on the button indicates that the connection is successful.

5. Click the triangle next to Address Book to expand the section in which you can add and modify contacts.

a) In Name, enter the user-friendly name of the contact.
b) In Email Address, enter the email address of the contact.
c) Click the Add button. The new name and email address disappear from the text boxes and appear in a

list directly below.

6. If you wish to correct or remove entries in the list: Click the check box in front of the contacts, and then click
Delete.

7. If you wish to retrieve contacts from an external, non-Livescribe address book, click the Import Contacts
button.

a) In the Import Contacts dialog, browse to a text file containing a list of contacts in CSV
(comma-separated-value) format. Many address books can output a CSV list of contacts.

Note: You can import a maximum of 200 email addresses from an external address book.

8. Dock your smartpen to transfer your email address book to your smartpen. On the smartpen, you will select
contacts from the Address Book when you are using the default Email shortcut.
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Defining Shortcuts for Email
The Email Connector has a default shortcut that you can modify. You can also create your own custom shortcuts.

The Email Connector has the following default shortcut:

• Email

Default and custom Email shortcuts specify the following:

• the Email Connector. This cannot be changed in the default shortcut.

• the To, CC, and BCC lists of email recipients that make a custom shortcut into a kind of mail list. These fields
are not available for the default Email shortcut.

• the Subject line. If a value is specified in the shortcut, it overrides the Default Subject from the configuration
page of the Email Connector. This field is not available for the default Email shortcut.

• the Format in which notes and audio will be sent. See Formats For Sending Notes and Audio on page 221.

The default Email shortcut does not permit you to define a mail list of To, CC, and BCC email recipients. Instead,
the default Email shortcut assumes that you will select email recipients on the smartpen, using the Address Book
defined in Email Connector's configuration page.

You can modify an existing custom shortcut by clicking its row in the table on the Shortcuts tab, entering
different values in the To, CC, BCC, and Subject fields, changing the Format selection, and clicking Save. You
can modify the default Email shortcut as well, but you can change only Format.

Creating a Custom Shortcut for Email
In this mini-tutorial, you create a custom Email shortcut named Team that targets three people who are “on your
team” at work or a recreational activity and sends an image of your notes in PNG format.

1. Click Add Shortcut.

2. Enter a name for the shortcut. In this example, enter: Team.

3. Click the down-arrow in the Connector column and select the Email Connector.

The To text box appears, followed by Add CC and Add BCC links.

4. Enter email addresses in the To text box, separating them with commas.

In this example, enter the email address of three people you know. If you wish, you can enter them now, and
remove them by redefining the Team shortcut later.

5. (optional) Click the CC link and enter the email address of anyone who is not a main recipient, but should
receive a copy of the email.

6. (optional) Click the BCC link and enter the email address of someone who should receive a copy of the
email, but not appear in the To list of recipients.

7. (optional) Click the Subject link and enter a subject. All emails sent with this shortcut will have this subject.

If you specify no subject here, the default value from the Connectors tab of the Livescribe Connect computer
app is used.

The To text box is required. The other text boxes are optional.

8. Click the down-arrow in the Format column.

The menu contains available formats for the Connector.

9. Select the desired format from the menu.

In this example, select PNG Image.

10. Click Save.
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Note: You can create a maximum of 100 custom Email shortcuts.

Sending to Email Recipients Using the Default Email Shortcut
You can send notes and audio to Email recipients, using default or custom shortcuts. In this mini-tutorial, you
send content using the default Email shortcut. After you select notebook page(s) to send, the smartpen display
prompts you for email addresses, which you select from your Address Book.

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, write Em to display the Email shortcut. For more information, see Drawing a Launch Line on
page 191.

2. Wait until the smartpen displays: Tap each page to include, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook Page
on page 198.

4. When you are finished selecting pages, double-tap on the final page you wish to send.

5. When the smartpen display shows To, tap down to see a list of email addresses from which you can select.
This list comes from the Address Book that you defined when you configured the Email Connector.

Note: You can scroll to an email address by writing the first few letters of the user-friendly name in
an unwritten area of a notebook page. For example, if you want to scroll to John Doe
(jdoe@xyzcompany.com), write Jo.

6. Tap right to select the current recipient. Each selected email recipient has a check mark before the name.

Note:  If you want to skip to the end, double-tap on an unwritten area of a notebook page.

7. If you want to select email addresses for CC and BCC or to select a format, continue as follows:

a) Tap right to see show CC on the smartpen display.
b) Tap down to select email recipients for CC one at a time. Tap right to select the current recipient.

Each selected email recipient has a check mark before the name.

c) When done selecting recipients for CC, tap right to show BCC on the smartpen display.
d) Tap down to see email recipients for BCC one at a time. Tap right to select the current recipient.

Each selected email recipient has a check mark before the name.

e) When done selecting recipients for BCC, tap right to show Send As on the smartpen display.

f) Do one of the following:

• Tap right to accept the default send format for your notes and audio. That default format for a shortcut
is specified on the Shortcuts tab of the Livescribe Connect computer app.

• Tap down to display other available send formats. Tap right to select a format.

8. Connect (dock) your smartpen to your computer.

Note:  In To, CC, and BCC, you can remove the check mark from an email recipient as follows: Tap up
or tap down to show the name on the smartpen display, and then tap right. A message displays, confirming
that the recipient has been deselected. You can continue selecting and deselecting other recipients for the
email message you are creating.
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Sending to Email Recipients Using a Custom Email Shortcut
You can send notes and audio to Email recipients, using default or custom shortcuts. In this mini-tutorial, you
send content using the Team shortcut you created. A custom shortcut already has the list of email recipients
defined, so the smartpen does not ask you to select from the Address Book.

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, write Te to display your Team shortcut. For more information, see Drawing a Launch Line on
page 191.

2. Wait until the smartpen displays: Tap each page to include, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook Page
on page 198.

4. When you are finished selecting pages, double-tap on the final page you wish to send.
When you dock your smartpen with your computer, an email with a PNG image of your notes is sent to the
people specified on your Team shortcut.

Sending to Google Docs
Using the Google Docs Connector, you can send notes and audio to your Google Docs. The following
mini-tutorials configure the Google Docs Connector, create a custom shortcut, and send content from your
smartpen using the new shortcut.

Configuring the Google Docs Connector
In this mini-tutorial, you configure the Google Docs Connector.

Livescribe Connect can send notes and audio to a Google Docs account. To use this feature, provide your account
information.

1. Click the Google Docs icon on the Connectors tab of the Livescribe Connect computer app.

2. Enter your Google Docs account information in Email and Password.

3. Click Test Connection to confirm the settings.

4. In Default Collection Name, enter the default Google Docs collection to which you wish your pages sent.
If you leave the text box blank, it will go to your default Collection. If you specify the name of a folder that
does not exist, Livescribe Connect has Google Docs create it for you.

5. In Share with, enter the default set of email addresses belonging to people you wish to have access to access
your content in Google Docs. If you leave the text box blank, only you are able to access the content you
send to Google Docs.

Defining Shortcuts for Google Docs
The Google Docs Connector has a default shortcut that you can modify. You can also create your own custom
shortcuts.

The Google Docs Connector has the following default shortcut:

• Google Docs

Default and custom Google Docs shortcuts specify the following:

• the Google Docs Connector. This cannot be changed in the default shortcut.
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• the Collection to which your notes and audio will be sent. If a value is specified in the shortcut, it overrides
the default value from the configuration page of the Google Docs Connector.

• the Share With field, which lists the email addresses of people who you wish to access your notes and audio
in your Google Docs account. If a value is specified in the shortcut, it overrides the default value from the
configuration page of the Google Docs Connector.

• the Format in which notes and audio will be sent. See Formats For Sending Notes and Audio on page 221.

You can modify existing shortcuts by clicking its row in the table on the Shortcuts tab, entering different values,
selecting a different Format, and clicking Save.

Creating a Custom Shortcut for Google Docs
In this mini-tutorial, you create a custom shortcut named Specs for the Google Docs Connector that targets the
Design Specifications collection in your Google Docs account and sends a simple PDF (without attached audio)
only.

1. Click Add Shortcut.

2. Enter a name for the shortcut. In this example, enter: Specs.

3. Click the down-arrow in the Connector column and select the Evernote Connector.

The Add Collection and Share With links appear.

4. Click the Add Collection link and enter the name of a Google Docs collection to which content should be
sent.

Enter Design Specifications.

5. Click the Share With link and enter one or more email addresses of people you wish to have access to your
content.

6. Click the down-arrow in the Format column.

The menu contains available formats for the Connector.

7. Select the desired format from the menu.

In this example, select PDF.

8. Click Save.

9. For the sake of the mini-tutorial, create a Design Specifications Collection in your Google Docs account.
You may skip this step, if you wish. Your smartpen content will be sent to your default collection.

Sending Content to Google Docs Using Shortcuts
You can send notes and audio to your Google Docs account, using default or custom shortcuts. In this mini-tutorial,
you send content using the Specs shortcut you just created.

You can send notes and audio to Google Docs, using default or custom shortcuts.

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, writing Go displays the Google Docs shortcut. In this example, write Spe to display your
Specs shortcut. For more information, see Drawing a Launch Line on page 191.

2. Wait until the smartpen displays: Tap each page to include, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook Page
on page 198.
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4. (optional) You can select a send format for your notes and audio that is different from the default value. The
default format for a shortcut is specified on the Shortcuts tab of the Livescribe Connect computer app.

a) Using Tap Around and the shortcut word you wrote, tap right to select a different send format for your
notes and audio. For more information, see Navigating Submenus with Tap Around on page 193.

b) Tap down to display other available send formats. Tap right to select a send format.

5. Double-tap on the final page you wish to send.

A simple PDF is sent to the Design Specifications collection in your Google Docs.

If you did not create a Design Specifications collection in your Google Docs account, then the Specs shortcut
causes Google Docs to create a Design Specifications collection for you.

Sending to Google Sites
Using the Google Sites Connector, you can send notes and audio as an interactive Pencast to your Google Sites
account. The Pencast provides audio controls for users to start, pause, stop and jump within the audio playback.
The following mini-tutorials configure the Google Sites Connector, create a custom shortcut, and send content
from your smartpen using the new shortcut.

Configuring the Google Sites Connector
In this mini-tutorial, you configure the Google Sites Connector.

Livescribe Connect can send notes and audio to a Google Sites account as an interactive Pencast. To use this
feature, provide the following:

• your account login information.
• the URL of a specific site within your Google Sites account.
• a page template that Google sites will use to create a page for displaying the Pencast.

1. Click the Google Sites icon on the Connectors tab of the Livescribe Connect computer app.

2. Enter your Google Sites login account information in Email and Password.

3. In Site URL, enter the site to which you wish your notes and audio sent. You must first create the site in
Google Sites.

The site URL is generated for you by Google Sites. Note that the site URL and the site name are not the
same. Your site URL will have a format such as:
https://sites.google.com/site/yoursitenamehere/ . You should copy the site URL from
Google Sites and paste it into this field. You can do this in one of two ways:

• View the site in Google Sites and copy the URL from the address box of your web browser.
• View the site in Google Sites, click the More Actions button, and select Site permissions. Then copy

the URL from the Link to Share field.

4. In Page template, accept the default value, Web Page—the template for a standard page on Google Sites.
The Google Sites Connector will insert the pencast in the main text box of the page, above the Attachments
and Comments gadgets.

Alternatively, select Custom Template from the dropdown menu. A text box appears in which you enter
the name of a custom page template.

Note:  Before using the Google Sites Connector with a custom page template, you must first create
the template in Google Sites. The template must contain the [pencast] tag in the location where
you wish the pencast to be inserted. See Creating a Custom Page Template in Google Sites on page
218.
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5. Click Test Connection to confirm the settings.

Creating a Custom Page Template in Google Sites
You can skip this topic if you are using the default value, Web Page, for the Page template option. If you wish
to use a custom page template with the Google Sites Connector, you must first create the template in Google
Sites.

There are several ways to create a custom page template in Google Sites. Whichever way you use, you must
enter the [pencast] tag in the template at the location where you want the Pencast to be inserted. During
configuration of the Google Sites Connector, enter that template name in the text box that appears when you
select Custom Template for the Page template option. When you use the Google Sites Connector to send notes
and audio, it will create a page using the template you specify, replacing the [pencast] tag with a Pencast of
those notes and audio. Additionally, the Connector uploads a Pencast player to your site to seamlessly display
the Pencast for your users.

1. Using your web browser, go to Google Sites and view the site where you wish your notes and audio to be
sent.

2. Click the More action button and then select Manage site.

3. Click Page Templates in the left-hand sidebar.

4. Click the Create page template button.

5. Under Start with, select the template that is closest to the layout you desire. Enter a name for the new template
in the Name field, and click the Create template button. Google Sites creates a new template and displays
it in edit mode.

6. Modify the layout of the new page, if desired. Text, images, objects, apps, and gadgets in the template will
appear in pages that are created from the template.

7. Find a location in the template where you want your notes and audio to be inserted, and type: [pencast]

You can enter the [pencast] tag multiple times in the template. The Google Sites Connector will replace
each occurrence of [pencast] with the Pencast of the notes and audio you are sending.

Note: The [pencast] tag has several optional attributes that control display characteristics of the
Pencast on the page. See Pencast Tag Attributes on page 218.

8. Click the Save button to exit template edit mode. Google Sites displays the template in view mode.

9. Verify that your template has been created: Click View template listing in the upper left-hand corner. Under
User Created Templates, find your new template.

Make a note of the template name, since you will need it during Google Sites Connector configuration. See
Configuring the Google Sites Connector on page 217.

10. Click Return to site.

Pencast Tag Attributes
You can skip this topic if you are using the default value, Web Page, for the Page template option. If you are
creating a custom page template for Google Sites, the template must contain at least one [pencast] tag, which
has the following optional attributes.

Syntax example: [pencast h=300 v=200 a=center]

DescriptionAttribute ValuesAttribute Name

horizontal alignmentdefault: centera

aligned with the left marginleft
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DescriptionAttribute ValuesAttribute Name

aligned with the right marginright

centered between the marginscenter

vertical size of pencast player in pixelsdefault: 300h

horizontal size of pencast player in pixelsdefault: 200w

These attributes are optional. They can occur in any order. You can specify all, some, or none of them. If an
attribute is not specified, the Google Sites Connector uses the default value indicated in the table above.

Defining Shortcuts for Google Sites
The Google Sites Connector has a default shortcut that cannot be modified. You can create custom Google Sites
shortcuts, but can only change the name of the new shortcuts; no other values can be changed in the Google
Sites shortcuts.

All notes and audio are sent to Google Sites as Pencasts.

Creating a Custom Shortcut for Google Sites
In this mini-tutorial, you create a custom shortcut named NewProducts that sends a Pencast of your notes and
audio to the specified site in your Google Sites account. Note that you specify the site URL and the page template
when you configure the Google Sites Connector. All Google Sites shortcuts share the same destination values
and differ only by name.

1. Click Add Shortcut.

2. Enter a name for the shortcut. In this example, enter: NewProducts.

3. Click the down-arrow in the Connector column and select the Google Sites Connector.

4. Click Save.

Sending to Google Sites Using Shortcuts
You can send notes and audio to your Google Sites account, using default or custom shortcuts. In this mini-tutorial,
you send content using the NewProducts shortcut you just created.

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, writing Go displays the Google Docs shortcut. Then you can tap down on a Nav Plus to display
Google Sites. In this example, however, write New to display your NewProducts shortcut. For more
information, see Drawing a Launch Line on page 191.

2. Wait until the smartpen displays: Tap each page to include, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook Page
on page 198.

4. Double-tap on the final page you wish to send.

A Pencast is sent to your Google Sites account, using the site URL and page template that you specified
when configuring the Google Sites Connector.

Sending to Microsoft OneNote
Using the Microsoft OneNote Connector, you can send notes and audio to your installation of OneNote. The
following mini-tutorials configure the OneNote Connector, create a custom shortcut, and send content from your
smartpen using the new shortcut.
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Configuring the Microsoft OneNote Connector
In this mini-tutorial, you configure the Microsoft OneNote Connector.

Livescribe Connect can send notes and audio to your OneNote installation. To use this feature, provide the name
of a notebook in OneNotebook where notes and audio should be sent.

1. Click the Microsoft OneNote icon on the Connectors tab of the Livescribe Connect computer app.

The path shown under Notebook is the default location to which your notes and audio are sent. You can
override this default value by creating custom shortcuts for the Microsoft OneNote Connector.

2. If you wish a different default location, enter the name of a OneNote notebook in Notebook.

If the name in the Notebook field does not refer to an existing notebook in OneNote, Livescribe Connect
creates the notebook for you.

Defining Shortcuts for Microsoft OneNote
The Microsoft OneNote Connector has a default shortcut that you can modify. You can also create your own
custom shortcuts.

The Microsoft OneNote Connector has the following default shortcut:

• Microsoft OneNote

Default and custom OneNote shortcuts specify the following:

• the OneNote Connector. This cannot be changed in default shortcuts.

• the OneNote Notebook to which notes and audio will be sent. If no value is specified, notes and audio will be
sent to the default notebook specified in the configuration for the OneNote Connector.

• the Format in which notes and audio should be sent. See Formats For Sending Notes and Audio on page 221.

You can modify an existing shortcut by clicking its row in the table of the Shortcuts tab, selecting different
values in the columns, and clicking the Save button.

Creating a Custom Shortcut for Microsoft OneNote
In this mini-tutorial, you create a custom shortcut named Travel that targets the Travel Expenses notebook in
OneNote and specifies that notes and audio will be sent as a Pencast PDF.

1. Click Add Shortcut.

2. Enter a name for the shortcut. In this example, enter: Travel.

3. Click the down-arrow in the Connector column and select the Microsoft OneNote Connector.

The Notebook link appears.

4. Click Notebook and enter the name of the OneNote notebook to which content should be sent. In this example,
enter Travel Expenses.

If you do not specify a value in this text box, Livescribe Connect uses the default name you specified in the
configuration for the OneNote Connector. If you specify a notebook name that does not exist in your OneNote
application, Livescribe Connect creates a new OneNote notebook with that name.

5. Click the down-arrow in the Format column.

The menu contains available formats for the Connector.

6. Select the desired format from the menu. In this example, select Pencast PDF.

7. Click Save.
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Sending to Microsoft OneNote Using Shortcuts
You can send notes and audio to Microsoft OneNote, using default or custom shortcuts. In this mini-tutorial,
you send content using the Travel shortcut you just created.

1. Draw a Launch Line and write the first few letters of the shortcut word directly above it.

For example, writing One displays the OneNote shortcut on the smartpen. In this example, write Tra to
display your Travel shortcut. For more information, see Drawing a Launch Line on page 191.

2. Wait until the smartpen displays: Tap each page to include, then double tap.

3. Select a page by tapping on it. Select another page in the same notebook by tapping on it. Continue tapping
on pages in the same notebook to select them.

Alternatively, you can select part of a page. For more information, see Selecting Part of a Notebook Page
on page 198.

4. (optional) You can select a send format for your notes and audio that is different from the default value. The
default format for a shortcut is specified on the Shortcuts tab of the Livescribe Connect computer app.

a) Using Tap Around and the shortcut word you wrote, tap right to select a different send format for your
notes and audio. For more information, see Navigating Submenus with Tap Around on page 193.

b) Tap down to display other available send formats. Tap right to select a send format.

5. Double-tap on the final page you wish to send. Connect (dock) your smartpen to your computer.

A Pencast PDF is sent to the Travel Expenses notebook in your OneNote installation.

If you did not create a Travel Expenses notebook in OneNote, the Microsoft OneNote Connector created a
new notebook with the name Travel Expenses.

Formats for Sending
You can send notes and audio in various file formats. With the smartpen, you can specify the format in the
shortcut definition or at the time you select your content. With Livescribe Desktop, you specify the format at
the time you select content.

In addition to well-known formats, Livescribe uses two proprietary formats that allow notes and audio to be
played in synchronization:

• Pencast is the format used by Livescribe Desktop, MyLivescribe (Livescribe Online), Mobile, iPad, iPod,
Facebook, and Google Sites.

• Pencast PDF is a new format that Livescribe is introducing with Livescribe Connect. When opened in Adobe
Reader X or above, a Pencast PDF can play the audio and display notes in synchronization.

Formats For Sending Notes and Audio
Notes and audio can be sent in various formats. Some formats support both notes and audio whereas others
support notes only or audio only.

Proprietary format available for Livescribe Desktop, MyLivescribe (Livescribe Online), Mobile, iPad,
iPod, Facebook, and Google Sites. Notes that display in synch with the recorded audio.

.pencast (or Pencast)

A PDF format playable in Adobe Reader X or above. Notes that display in synch with the recorded audio.
See Viewing and Playing a Pencast PDF on page 223

Pencast PDF
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Standard PDF format viewable in Adobe Reader X or above. Notes, with no audio.PDF

The PNG format. An image of your notes, with no audio.PNG Image

The M4A format (AAC). Audio associated with your notes, with no pages. M4A files can be imported
into common audio players like iTunes.

M4A Audio

Connectors and Their Formats

Not all formats are available for each Connector. The table below lists each Connector and the formats in which
it can send your notes and audio. It also describes how the file is displayed at the destination and any tips on
how to interact with the file.

Appearance of Content At DestinationSending Formats

Supported

Connector

A file on your computer.
Pencast PDF

Computer

A file on your computer.PDF

A file on your computer..pencast

A file on your computer.PNG Image

A file on your computer.M4A Audio

In your MyLivescribe space, the first page of each uploaded pencast appears in a

vertical list. In the center of your MyLivescribe space, the currently selected Pencast

displays in a frame with playback controls.

PencastMyLivescribe

As an attachment to a note. In the Evernote web app, click the attachment icon. In

the Evernote computer app, hover over the note window and click the small Adobe

Pencast PDFEvernote

Reader icon. Adobe Reader X starts. You can view all pages in the Pencast PDF and

use the Pencast PDF control bar to play the recorded audio.

As an attachment to a note. In the Evernote web app, click the attachment icon. In

the Evernote computer app, hover over the note window and click the small Adobe

Reader icon. Adobe Reader X starts. You can view all pages in the PDF.

PDF

Image displays in the note window.PNG Image

The post displays a thumbnail of the first page with a triangular start button. A viewer

clicks the start button to play the Pencast in place. Descriptive info displays to the

right of the post.

PencastFacebook

A file in the specified Collection of your Google Docs account. To play the Pencast

PDF, download the file to your computer and double-click it. Adobe Reader X will

launch and you can view the notes and play the audio.

Pencast PDFGoogle Docs

Note:  If you view the file online in Google Docs, you will see the notes but

will not be able to play the audio.
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Appearance of Content At DestinationSending Formats

Supported

Connector

A file in the specified Collection of your Google Docs account. You can view the

PDF online in Google Docs or download it to your computer.

PDF

A single file is attached to the email.Pencast PDFEmail

A single file is attached to the email.PDF

A single file is attached to the email..pencast

Each notebook page becomes an image file. All files are attached to the email.PNG Image

Each audio recording is a separate audio file. All files are attached to the email.M4A Audio

The Pencast player with the first page of the Pencast displayed. At the bottom, the

Pencast player has an audio control bar. To start audio playback, users click the start

button on the audio control bar or click on active ink in the displayed Pencast page.

Pencast
Google Sites

An icon in the specified notebook in OneNote. Clicking the icon displays the file in

Adobe Acrobat, which is saved with the data in your OneNote installation.

Pencast PDF
Microsoft OneNote

An icon in the specified notebook in OneNote. Clicking th icon accesses the file in

Adobe Acrobat, which is saved with the data in your OneNote installation.

PDF

Image in a notebook in OneNote.PNG Image

An icon in the specified notebook in OneNote. Clicking the icon plays the audio file,

which is saved with the data in your OneNote installation.

M4A Audio

Overriding Formats From the Smartpen
Send formats are generally specified in a shortcut definition. However, you can override the specified format
from your smartpen at the time you select notes and audio.

For more information, see Selecting Format from the Smartpen on page 201.

Viewing and Playing a Pencast PDF
Pencast PDF is a new format of notes and audio that can play in Adobe Reader X or above.

With earlier versions of the Livescribe Platform, you can send your notes and audio as Pencast files and your
recipients can use them in Livescribe Desktop, which is available as a free download. In Livescribe Desktop,
users can read your notes, play your audio, and make custom notebooks.

Now you can also send your notes and audio in a universal format—Pencast PDFs. In Adobe Reader X, your
recipients can read your notes and play your audio.

Note:  Pencast PDFs sent to your computer using the Computer Connector are updated automatically with
new ink and audio that you add to your notebooks. This is similar to how Livescribe Desktop updates
your notebooks when you dock your smartpen.
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You can open a Pencast PDF as you would other PDF files in Adobe Reader X. The main difference is that a
Pencast PDF can contain ink that has associated audio—called "active ink". Click active ink to play its audio.
This is just like playing a Pencast from Livescribe Online or in Livescribe Desktop.

When you first view a notebook page, active ink appears in green type. When you click active ink, it turns gray
and the audio starts playing. As audio playback continues, the gray ink turns green in synchronization with the
audio. Non-active ink (ink without audio) is black and does not change appearance.

Audio Control Bar

Pencast PDFs have an audio control bar for playing, pausing, and stopping audio playback. The control bar also
has jump controls, bookmarks (stars), and an audio timeline control.

Active Ink View Button

There is also an active ink view button . Click this button to toggle the "unwritten" color of active ink from
gray to invisible. In the default (gray) setting, the gray words turn green as the audio plays. In the invisible
setting, green words seem to write themselves on blank paper as the audio plays.

Sharing a Pencast PDF Without Connectors
Like other PDF files, you can share a Pencast PDF with just about anyone. Once you send the Pencast PDF to
your computer, you can share the entire file (page and audio) without using Connectors. For instance, you can
copy it to a network drive, post it to your blog, or copy it to a flash drive. Anyone with Adobe Reader X or higher
can view and play the audio with the audio control bar.

Sharing Audio Only

1.
In Adobe Reader X, click the Attachments button . This opens the Attachments panel.
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2. In the Attachments panel, select the audio file(s) and click the Save button to save them to your desktop or
other folder. Once they are saved separately, you can share the audio without Connectors. You can copy it
to a network drive, post it to your blog, or copy it to a flash drive.

Getting More Info About the Livescribe Connect Smartpen App
You can get more information about the Livescribe Connect smartpen app, including the version number and
the address for the customer support web page.

Getting Livescribe Connect Version Information

1. Launch the Livescribe Connect smartpen app, using the Connect shortcut or Nav Plus.

2. Tap down until you see About on the smartpen display.

3. Tap right.

The current version of the Livescribe Connect smartpen app shows on the display.

Getting the Web Help Information

1. Launch the Livescribe Connect smartpen app, using the Connect shortcut or Nav Plus.

2. Tap down until you see About on the smartpen display.

3. Tap right.
The current version shows on the smartpen display.

4. Tap down until you see Help.

5. Tap right to see the web address for the Livescribe support web page.

Sending Notes and Audio from Livescribe Desktop
Using Livescribe Desktop and the Livescribe Connect computer app, you can send smartpen notes and audio to
many popular destinations.

Configuring Connectors in Livescribe Desktop
Connectors are plugins to Livescribe Connect that target a particular destination: a folder on your computer, one
of your Evernote notebooks, your MyLivescribe space, your Facebook wall, email recipients, or one of your
Google Docs collections.

In the Livescribe Connect computer app, you configure Connectors. In Livescribe Desktop, you send notes and
audio from your electronic notebooks, and then provide other input required by a Connector.

Although a Connector must be configured before use, the same configuration works for the smartpen and
Livescribe Desktop. If you configured Connectors for use on the smartpen, you need not configure them again
for Livescribe Desktop.

Accessing Connector Configuration from Livescribe Desktop
You can access the configuration page for a Connector from Livescribe Desktop.

In Livescribe Desktop, double-click a Connector icon in the Connectors pane of the Library tab.

The Livescribe Connect computer app displays, with the configuration page for the Connector showing.
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Selecting and Sending in Livescribe Desktop
When sending notes and audio from Livescribe Desktop, select notebook pages and drag them to a Connector
icon.

Make format and other selections in dialogs, and then send the notes, audio, or both. In Livescribe Desktop, you
do not use smartpen shortcuts.

Important: All selections must be from the same notebook.

Note: When using the Email Connector, keep in mind that some files, particularly those with audio, are
too large for many people's email systems. For information and alternatives, see Sending Large Files with
Livescribe Connect on page 202.

Sending Notes and Audio from the Thumbnail View
You can select content from the Thumbnail View of the Pages View.

1. Click the Pages View.

2. Make sure that Thumbnail View is active. If you see a single, full-size page, you are currently in Single-Page

View. Click the Thumbnail View icon  on the control bar:

3. Select one or more pages you want to send.

4. Drag the pages to one of the Connectors in the left navigation pane.
The Sending Notes to... dialog displays for you to select notes and audio from your pages.

5. Under Select what to send, specify whether to send the notes, audio, or both from your pages.

Send notes and the audio linked to them.Pages With Audio

Send just the notes.Pages Only

Send just the audio.Audio Only
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6. Under Select your file type, select the file format in which to send your notes or audio.

Available file formats depend on the Connector you are using and whether you are sending notes, audio, or
both. See Formats For Sending Notes and Audio on page 221.

7. (optional) Click the More Options button.
The Select your content section of the dialog drops down.

8. Select individual pages or audio.

• Select one or more of the pages you dragged to the Connector icon. If a page has a check mark, its notes
will be sent.

• Select one or more audio recordings from the pages you dragged to the Connector icon. If an audio
recording has a check mark, it will be sent.

Note: The pages pane or the audio recordings pane may be grayed out and unusable, depending on
whether you decided to send notes, audio, or both in the Select your content box above.

The Select All /Deselect All check box at the top of a pane toggles between selecting all and selecting none
of the items in the pane.

9. If you wish to preview an audio recording before sending it, select the audio and click the play button on the
Audio Controls. Drag the slider of the Audio timeline control to reposition audio playback forwards and
backwards. Click the Pause control to stop playback.

10. Click Continue.

Livescribe Connect sends your notes and audio to the destination. If the Connector requires further information,
an options dialog displays.

11. In the options dialog, provide further information relevant to the Connector you are using. Then click Continue
or Send.

Right-Clicking in the Thumbnail View
As an alternative to dragging pages, you can right-click on pages in Livescribe Desktop to send them using
Connectors.

1. In the Thumbnail View, select one or more pages from the same notebook, and then right-click.

2. Choose Send Page X to..., where X is the page number in the notebook.

If you selected more than one page, the menu item says Send Y Pages, where Y is the number of notebook
pages.

3. Choose a Connector.

4. Continue as you would if you had dragged the pages to an icon in the Connectors pane. Make selections in
the Sending Notes to... dialog and the options dialog (if the Connector you chose has an options dialog).

For details, see Sending Notes and Audio from the Thumbnail View on page 226.

Sending Notes and Audio from the Audio View
You can select notes and audio from the Audio View.

1. Click the Audio View.

2. Select one or more audio recordings. Use Control + click to select multiple audio recordings.

3. Right click and select Send 'X' to, where X is the date and time of the recording you are sending.

If you are sending more than one recording, the menu item says Send Y Selected Sessions, where Y is the
number of recordings you are sending.
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4. Select a Connector from the submenu.

The rest of the steps are the same as on the Pages View.

In the Sending Notes To dialog, the More Options section has thumbnails of the pages with notes linked
to the audio. You can select one or more of those pages to send with the audio recordings. Alternatively, you
could deselect all pages to send just the audio recordings. If the audio recordings are a paperless session, you
will see no pages in the pages

Specifying Send Options
Some Connectors send notes and audio when you click Continue. Others display a further dialog where you
specify additional information. These Connectors are:

Send OptionConnector

The File Save As dialog displays. You can accept the default name for your file or give it a different name.Computer

If you are not logged in to Facebook, the Facebook Login dialog displays. Enter your login information.

The Facebook Wall Post Options dialog also displays. You can specify values for Wall Message, Wall Name,
Caption, Description, and Post To. Info you specify here overrides defaults you set during Facebook Connector
configuration. Click Post when you are done.

Facebook

Note: To see your friends' names in the Post To dropdown menu, you must be signed in to Facebook.

The Email Send Options dialog displays. You must enter at least one email address in the To text box. You may
also add email addresses for CC and BCC and enter a Subject. The BCC and Subject you enter in this dialog
override defaults you set during Email Connector configuration. Click Send when you are done.

Email

Exporting and Importing Pencast Files With Livescribe Desktop
The Pencast file format (.pencast) lets you and others exchange and send your smartpen content, including audio,
pages, or both.

Anyone with Livescribe Desktop installed on their computer can import Pencast files. Because Pencast files are
a native Livescribe format, you can work with imported Pencast files just like other pages and audio, including
viewing and searching pages, playing back audio, and even sending.

Exporting to Pencast Files
You can export Pencasts from Livescribe Desktop. You might want to back up Pencast files or an entire notebook
on an external device (such as a portable hard drive or USB flash key) or your network server.
Sending an Entire Notebook from Livescribe Desktop
In Livescribe Desktop, send an entire notebook to your computer, external device, or network.

1. Right click on a notebook in the Library tab of Livescribe Desktop.

2. Select Send Notebook...

3. Select a Connector.

Tip: The Computer and Google Docs Connectors are the best choice for large files. The Email
Connector may not be appropriate, since many mail servers limit attachments to a maximum of 10
MB.

4. Make selections in the Sending Notes to Computer dialog. You can accept the default format (which is
Pencast) or select a different format. When you are done, click Continue.
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5. In the Save File As dialog, navigate to a file system location on your computer, external device, or network.
Enter a name for the file that will contain your notes and audio. Then click Save.
Notes and audio are sent in a file to the location you selected, and the file has the name you specified.

Importing Pencast Files
Pencast files that you receive from other people must be imported into Livescribe Desktop before you can use
them.

You may also wish to access Pencast files that you created as backups, which can be useful if you lose your
computer or smartpen. To use such Pencast files, download Livescribe Desktop from the Livescribe web site
and import them into your new Livescribe Desktop.

You may also wish to access Pencast files that other people have saved to a shared location, such as a network
server at work. You can import these files into your Livescribe Desktop as well.

1. Select File > Import Pencast.

2. In the dialog, navigate to the appropriate folder and select the Pencast you wish to import.

3. Click Import.
Livescribe Desktop puts the file under Imports in the Library tab.
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